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ONSOz

Kalite Politikamiz; Cografi Bilgi Sistemleri ve Uzaktan Algilama konusunda
Turkiye’de; Kamu Kurumlari, Askeri Kurumlar, Ozel Sektér ve Universite
hizmet alanlarina kurumsallasmis bir anlayis ile en ileri teknolojileri
kullanarak, zamaninda, glvenilir, ekonomik ve sorunsuz bir hizmet sunmak
ve bu hizmetlerin gelisimini ve strekliligini saglamaktir.

Bu anlayis ile hizmetlerimizi yerine getirirken, Cografi Bilgi Sistemleri ve
Uzaktan Algilama teknolojileri ile projelerin gercgeklestirilebismesi igin,
Cografi Bilgi Sistemi ve Uzaktan Algilama vyazilimlarinin imkan ve
kabiliyetleri, bir organizasyon igerisinde yoneticiden kullaniciya kadar tiim
personele egitilerek gosterilmesi gereklidir.

Sistemin basarisi bu teknolojileri kullanacak personel ve yoéneticilerin
egitimine baghdir. En 6nemli faktor bu konuda yetismis ‘insan’dir.
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COGRAFi BiLGi SISTEMi VE TEMEL KAVRAMLAR

1.1 Cografi Bilgi Sistemi Nedir?

Cografi Bilgi Sistemleri (CBS), ¢ok farkli disiplinler tarafindan
kullanilmasi nedeniyle degisik sekillerde tanimlanabilmektedir. Ornegin; bir
maden mihendisi icin Cografi Bilgi Sistemleri rezerv hesabi iken, bir peyzaj
mimari goziinde peyzaj planlamasi seklinde karsimiza cikabilir ya da bir
ziraat miihendisi icin Grlnlerin rekolte degerlerinin hesaplanmasinda bir
arag iken, bir biyolog icin ise akla gelen ilk sey biyogesitlilik olabilir. Yine
Cografi Bilgi Sistemleri bazi meslek gruplarinda cografi bilgiyi islenebilir
bicimde sisteme aktarmak, bazi meslek gruplarinda ise bu islenilebilir veriyi
analizlerden gecirmek suretiyle (riinler elde etmek olarak adlandirilabilir.
Oyle ki; Cografi Bilgi Sistemlerinin (CBS), son yillarda kayda deger bir sekilde
kullanim alaninin genislemesi, bircok sektor tarafindan yapilan ¢alismalarda
temel vyazilim olarak kullaniimasi, 6zellikle konumsal bazli yapilan
¢alismalarla ilgilenen kisi, kurum ve kuruluslar arasinda oldukg¢a fazla ilgi
duyulmasi ve farkli meslek dallarinda genisleyen bir yelpazeye sahip olmasi
standart bir tanim kalibi icerisine sokulmasini deyim vyerindeyse
engellemistir. Ancak bu farkh ilgi ve bakis acilarina ragmen Cografi Bilgi
Sistemlerini tanimlamak gerekirse; “ karmasik planlama ve yodnetim
sorunlarinin  ¢ozillebilmesi icin tasarlanan; mekandaki konumu
belirlenmis verilerin kapsanmasi, yénetimi, islenmesi, analiz edilmesi,
modellenmesi ve gériintiilenebilmesini kapsayan donanim, yazilim ve
yoéntemler sistemidir.”

Cografi Bilgi Sistemleri yukarida da gorildiga gibi her meslek
grubuna gore farkh sekillerde yorumlanmaktadir. Bu farkli yorumlamalara
ragmen Cografi Bilgi Sistemleri bir bakima “diinya lizerindeki bélgeleri tarif
eden, verileri saklayan ve kullanan bilgisayar sistemi” olarak da
tanimlanabilir. Yine Cografi Bilgi Sistemleri “mekansal verilere (akarsu,
parsel, bina, yol vb.) ait sézel bilgileri biinyesinde entegre bir sekilde
saklayan bir sistemdir.”



Sekil 1: Cografi Bilgi Sistemleri problemlerin ¢éziimiinde etkin bir
koordinatordur.

1.2 Cografi Bilgi Sistemlerinin Yararlari

Cografi Bilgi Sistemleri mekansal verilere ait sozel bilgileri
veritabaninda entegre bir sekilde saklama yeteneginin yani sira, kendine
has teknolojisiyle sorgulama ve istatistiksel analiz gibi klasik veri tabani
islemlerini gorsellestirme ve haritalar tarafindan saglanan cografi analizler
ile birlestirmektedir. Bu yetenegi sayesinde Cografi Bilgi Sistemleri diger
bilgi sistemlerinden ayrilmakta, kamu ve 0&zel girisimlerde olaylarin
aciklanabilmesi, sonuglarin tahmini ve strateji gelistirebilmesi bakiminda
Onem kazanmaktadir.

Dinya’nin cesitli tlkelerinde Cografi Bilgi Sistemlerinin kullanimi
beraberinde ham olan, sadece ofislerdeki klasérler igerisinde kagit
ortaminda bulunan verilerin bilgisayar ortaminda islenmesine ©6nayak
olmustur. Cografi Bilgi Sistemlerinin glin gectikce artan potansiyeline bagh
olarak kullaniminin yayginlagsmasinin yani sira sayisal bilgilerin artmasiyla
da bilgileri kontrol etmek ve yorumlamakda dogal olarak zorlasmaktadir.
iste Cografi Bilgi Sistemleri (CBS) kisi, kurum ve kuruluslarin mekansal
tabanli veriler (izerinde yapacaklari calismalarda karar vermelerine yardimci
olmaktadir. Yani CBS, hem veritabani yénetimi hem analiz hem modelleme
yetenegi hem de calismalar esnasinda karar destek mekanizmasi gibi
bircok ve dnemli 6zellikleri blinyesinde barindirmaktadir. Bu gibi yetenekler
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de Cografi Bilgi Sistemlerini diger sistemlere gore her zaman 6n siralara
tasimaktadir.

Cografi Bilgi Sistemlerinin yararlarini sinirlandirmak neredeyse
imkansizdir. Ancak CBS’nin yararlari bakiminda birkag 6rnek verilebilir;

e Bilgi akisini hizlandirir.

e Daha verimli (iretim ve envanter yonetimi saglar.

e s verimliligini arttirir.

e  Etkili ve dogru analizler (acil durum mudahale, kritik bilgi analizleri
vb.) saglar.

e Veri glincelleme kolayligi saglar.

e s gliciinii arttirir ve zaman kaybini énler.

1.3 Cografi Bilgi Sistemlerinin Kullanim Alanlan

Cografi Bilgi Sistemleri, cografi verilerin s6z konusu oldugu her
alanda uygulanabilir bir yapi sunmaktadir. Cografyanin ve dolayisiyla
cografi verinin kapsaminin ne kadar genis oldugu duslintlecek olursa, CBS
uygulama alanlarinin da o denli uzun bir liste olarak karsimiza cikacagi
sonucuna varilir.

Teknolojik gelismelerle beraber farkli bircok uygulamayi icine alan
Cografi Bilgi Sistemleri sorunlar karsisinda is ve hizmetlerin tikanma
noktasina geldigi, mevcut vyerlesim vyerlerinde ya da planlanan
yerlesimlerde, yerel yoneticiler igin bir ¢6ziim yolu olarak en ¢ok 6nerilen
yontemdir. Belediye ve yerel yonetimlerde; cevre yonetimi, havza yénetimi,
ulasim planlama, uygun yer secimi, ¢ok kriterli karar verme, kazi-dolgu
calismalari, akilli harita Gretimi, alan planlamasi, envanter calismalari,
senaryo ve trend analizleri, kirlilik modellemesi, i¢ boyutlu arazi
modelleme, arag¢ takibi, deprem hasar analizleri, vergi takibi vb. gibi bircok
kullanim alani bulunmaktadir. Cografi Bilgi Sistemlerinin kullanim alanlari
sadece bunlarla sinirli degildir.Bu alanlari belli basliklar altinda toplamak
gerekirse;



Cevre Yonetimi: Cevre diizeni planlari, cevre koruma alanlari, CED raporu
hazirlama, goller, gbletler, sulak alanlarin tespiti, cevresel izleme, hava ve
glrulta kirliligi, kiyr yonetimi, meteoroloji, hidroloji...

Dogal Kaynak Yonetimi: Arazi yapisi, su kaynaklari, akarsular, havza
analizleri, yabani hayat, yer alti ve yer Usti dogal kaynak yonetimi,
madenler, petrol kaynaklari...

Miilkiyet-idari Yonetim: Tapu-Kadastro, vergilendirme, secmen tespiti,
nlfus, kentler, beldeler, kiyi sinirlari, idari sinirlar, tapu bilgileri, micavir
alan disinda kalan alanlar, uygulama imar planlari...

Bayindirlik Hizmetleri: imar faaliyetleri, otoyollar, devlet yollari, demir
yollari 6n etitleri, deprem zonlari, afet yonetimi, bina hasar tespitleri,
binalarin cinslerine gore dagilimlari, bolgesel kalkinma dagilimi...

Egitim: Arastirma-inceleme, egitim kurumlarinin kapasiteleri ve bolgesel
dagihmlari, okuma-yazma oranlari, 6grenci ve egitmen sayilari, planlama...
Saghk Yonetimi: Sagilik-cografya iliskisi, saglk birimlerinin dagilimi,
personel yonetimi, hastane vb. birimlerin kapasiteleri, bdlgesel hastalik
analizleri, saghk tarama faaliyetleri, ambulans hizmetleri...

Belediye Faaliyetleri: Kentsel faaliyetler, imar, emlak vergisi toplama, imar
diizenlemeleri, ¢cevre, park bahgeler, fen isleri, su-kanalizasyon- dogal gaz
tesis isleri, TV kablolama, uygulama imar planlari, nazim imar planlari,
halihazir haritalar, altyapi, ulastirma plani toplu tasimacilik, belediye yollari
ve tesisleri...

Ulasim Planlamasi: Kara, hava, deniz ulasim aglari, dogal gaz boru hatlari,
iletisim istasyonlari, yer secimi, enerji nakil hatlari, ulasim haritalari...
Turizm: Turizm bélgeleri alanlari ve merkezleri, turizm amagli uygulama
imar planlari, turizm tesisleri, kapasiteleri, arkeoloji calismalari...

Orman ve Tarim: Egim-baki hesaplari, orman amenajman haritalari, orman
sinirlari, peyzaj planlamasi, milli parklar, orman kadastrosu, arazi ortisd,
toprak haritalari...

Ticaret ve Sanayi: Sanayi alanlari, organize sanayi bolgeleri, serbest
bolgeler, bankacilik, pazarlama, sigorta, risk yonetimi, abone, adres
yonetimi...

Savunma ve Giivenlik: Askeri tesisler, tatbikat ve atis alanlari, yasak
bolgeler, sivil savunma, emniyet, sug¢ analizleri, su¢ haritalari, arag takibi,
trafik sistemleri, acil durum...



1.4 Cografi Bilgi Sistemlerinde Veri Yapisi

Cografi Bilgi Sistemlerinde veri yapisini kavrayabilmek icin her seyden 6nce
cografi bilginin aciklanmasi gerekmektedir. Clnki cografi bilgi dinya
lzerindeki herhangi bir varlik icin bilgiler vermektedir. Cografi Bilgi,
birbirleriyle baglantili t¢ ayri bilgiden olusur:

Cografi Konum (Koordinat) Bilgisi: Konumsal bilgi tirtidir. Cografi varligin
yer yuvarina iliskin belli bir datum (referans sistemi) ve projeksiyon
diizenindeki konum (koordinat) bilgisidir.

Oznitelik Bilgisi: Cografi varliga iliskin dznitelik degeri bilgisidir.

Topolojik Bilgi: Matematik biliminin bir alt dali olan Topoloji bilimi esaslari
cevresinde; bir cografi varligin, diger cografi varliklara gore komsuluk
iliskileri (saginda, solunda, basinda, sonunda, vb.) hakkindaki bilgilerdir.

Cografi bilgi icerisinde yer alan bu oOzellikler Cografi Bilgi
Sistemlerinde kullanilan ya da kullanilacak olan cografi veriler icin 6nem arz
eder. Clnkl cografi verileri hem belli bir konum ile iliskilendirmek hem de
cografi verilerin detay bilgilerinden farkli Grinler elde etmek yapilan
calismalara ait 6nemli unsurlardandir. Bu itibarla cografi veri yapisini iki
grupta incelemek gerekir:

Mekansal Bilgi: Ozelliklerin ya da cografi varliklarin yerini, seklini ve diger
mekansal veriler ile iligkilerini belirler. Cografi konum ve topolojik bilgi bu
grup icerisinde yer almaktadir.

Tanimlayiai Bilgi: Ozelliklere ya da cografi varliklara ait bilgilerin veri
tabaninda tutulmasi ile olusan bilgilerdir. Bir baska deyisle Cografi Bilgi
Sistemlerinde kullanilan haritalara ait verilerin 6zellikleri ile ilgili detaylari
iceren bilgilerdir.



Cografi Veriler

KANAL AKSLARI

TOPRAK GRP.

PARSEL

Sekil 2: Mekansal ve Tanimlayici Veriler

Cografi bilgi ve cografi veri kavramlarina agiklik getirdikten sonra ele
alinmasi ve CBS kullanicilarinin bilmesi gereken bir diger 6nemli unsur da
Cografi Bilgi Sistemlerindeki veri yapist mantigidir. Cografi Bilgi
Sistemlerinde veri yapisi iki sekilde ele alinmaktadir:

Vektor Veri: Belirli koordinat (x,y) degerleri ile depolanan verilerdir. Belirli
bir koordinata sahip olan vektér veriler “nokta, ¢izgi, alan” veriler olmak
lzere 3’e ayrilir.

Noktasal (Point) Veri: Tek bir (x,y) koordinat cifti ile temsil edilen verilerdir.
Bu tir vektor veriler sekli ve sinirlari ¢ok kiglik olan birimlerin
tanimlanmasinda kullanilirlar. Ornegin; tepe noktalari (zirve), elektrik
direkleri, kuyular, agaclar, vb.

Cizgisel (Line) Veri: Birbirini izleyen bir dizi (x,y) koordinat serisi seklinde
sistemde depolanan verilerdir. Bir dizi halinde birbirini izleyen ve alan
olarak gosterilemeyen birimler icin kullanilirlar. Ornegin; yol, akarsu,
elektrik hatti, vb.

Alansal (Polygon) Veri: Baslangi¢ ve bitis noktalarinda ayni koordinata (x,y)
sahip olan ve bir dizi koordinatlar ile sistemde depolanan verilerdir.
Ornegin; parseller, binalar, géller, yerlesim sinirlari, orman alani, arazi
kullanimi, vb.



Tepe Noktalari, Kuyular,
—l . X
Agaclar, Direkler, vb.
ﬁ =P Yol, Akarsu, Elektrik Hatti, vb.
A m—p- Goller, Binalar, Parseller, vb.

Sekil 3: Vektor Veri Tipleri ve Birkag Ornek.

Vektorel veriler cografi varliklarin kesin konumlarini tanimlamada
son derece yararh verilerdir. Ancak, sireklilik ozelligi gosteren cografi
varliklarin, ornegin; toprak yapisi, bitki ortisl, jeolojik yapi ve ylizey
ozelliklerindeki degisimlerin ifadesinde daha az kullanish bir model olarak
bilinir. Vektorel verilerde grafik objeleri tanimlayan 6znitelik bilgilerine
ulasma, bu bilgileri giincelleme ve diizeltme miimkiin ve daha kolaydir.
Raster Veri: Hiicrelere (pixel) bagl olarak temsil edilen verilerdir. Raster
veri, birbirine komsu grid yapidaki hiicrelerin bir araya gelmesi ile olusurlar.
Cekilen fotograflarin, taranan haritalarin ya da paftalarin sisteme
aktarilmasi ve vektér verilerden donisim (convert) islemleri sonucu ile
elde edilirler. Raster veriler vektor verilere oranla daha fazla veri depolama
kapasitesine sahiptirler. Bazi konumsal analizler (En uygun yer analizi,
maliyet analizi,vb.) raster verilerde daha kolaydir. Ancak verilerin
hassasiyeti raster verilerde hiicre boyutuyla (pixel size) orantili oldugu igin
hassas ¢alismalarda veri kayiplarina neden olabilir.

3 bl 0 e |

Sekil 4. Cografi Verilerin Raster Veri Uzerinde Gériiniisi



Vektor ve raster veri modellerinden biri genelde CBS uygulama
bicimine gore tercih edilerek kullanilir. Ancak giiniimizde her iki model
ayni anda da kullanilabilmektedir. Vektor ve raster verilerin yukarida da
aciklandigi gibi birbirlerine gore Gistlin ve zayif yonleri vardir.

Raster Veri

< Noktalara bagh olarak temsil edilen veri

O Raster format e
O Hilcrelere bagh olarak temsil edilen veri [

Vektor Veri

4
i
@

Arazi Yiizeyvi

Sekil 5: Cografi Verilerin Vektor ve
Raster Veriler Uzerinde Gériiniisii

1.5 Cografi Bilgi Sistemlerinin Elemanlari

Bir sistemin, bir uygulamanin ya da herhangi bir calismanin ayakta
kalabilmesi ve isleyebilmesi icin bazi gereksinimlere ihtiyag vardir. Cografi
Bilgi Sistemlerinin de isleyebilmesi ve sagladigi avantajlardan en Ust
diizeyde vyararlanilabilmesi icin bazi gereksinimlere, bilesenlere ya da
elemanlara ihtiyag duyulmaktadir:

Veri (Data): Cografi Bilgi Sistemlerinde veri olmadan islem yapmak
imkansizdir. Clinkd veri bir bakima bu sistemin o6zidir ve Cografi Bilgi
Sistemlerinin de vazgecilmez bilesenlerindendir.

Yazilim (Software): Cografi Bilgi Sistemlerinin vazgecilmez bilesenlerinden
olan veri bu sistemin isleyebilmesi icin vyeterli degildir.Verilerin
islenebilecegi ve analiz edilebilecegi bir yazilima ihtiyag vardir.Bu ihtiyagtan
otlrl Cografi Bilgi Sistemlerinde vazgecilemeyen bir eleman ya da bilesen
de yazilimdir.

Yontem (Method): Cografi Bilgi Sistemlerinde yapilacak ve birbirinden farkh
olan calismalarda basarili islemler gerceklestirilmesi saglkli yontemlerin
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tespiti ile gerceklesir. Belirlenecek olan bu yontem ya da yontemlerin de
cok iyi tasarlanmasi ve planlamasi gerekir ki, gerek kisisel gerek kurumsal
bazda istenilen Uriinler ortaya ¢ikarilabilsin.

Donanim (Hardware): Cografi Bilgi Sistemleri bugiin ¢ok farkli donanima
sahip bilgisayarlarda calisabilmektedir. Ancak Cografi Bilgi Sistemlerinin
ilgili yazihmindan maksimum performans elde etmek icin bilgisayar
donaniminin da yiiksek kalitede olmasi gerekmektedir.

Asagida ArcGIS Desktop 10 igin gerekli sistem gereksinimleri verilmistir.

ArcView,Arceditor ve Arcinfo igin...

CPU Hizi 2.2 Ghz Dual Core ya da daha fazlasi

islemci Intel Core Duo,Pentium or Xeon islemciler
Memory/Ram | 2GB ya da daha fazlasi

Gorinti 24 Bit renk derinligi

Ozellikleri

Ekran 1024*78 ya da daha fazlasi normal boyutta ( 96 dpi)

Coziiniirlugii

Onbellek isletim sistemi tarafindan belirlenir,minimum 500 Mb
Kapladigi alan | 2.4 GB

Video/Grafik | En az 128 MB,tavsiye edilen 512 MB

Ekran karti
Network TCP/IP

insanlar (People): Cografi Bilgi Sistemlerinde yukarida adi gegen bilesenler
her ne kadar bu sistem icerisinde vazgecilemeyen elemanlar olsalar da
insan olmadan bir biitlin olusturamazlar. Ciinkli CBS karar-destek sistemi
olmasi itibariyle insan odaklidir. insanlar problemlerin ¢éziimiinde karar
verici ve sistem gelistirici olarak yapilan ¢alismalara yonelik plan hazirlarlar.
Bu nedenle, Cografi Bilgi Sistemlerinin isleyebilmesi i¢in bu konuda yetismis
yonetici ve personellere ihtiyag vardir.
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Sekil 6: Cografi Bilgi Sistemlerinin Bilesenleri

Veriler

1.6 Cografi Bilgi Sistemlerinin Genel Fonksiyonlari

Cografi Bilgi Sistemlerinde amag¢ cografi bilginin; Gretimini,
yonetimini, analiz ve network lzerindeki dagitik veri tabanlarindan cografi
verileri tim insanlarin paylasabilecegi profesyonel bir bilgi sistemi
teknolojisi sunmaktir. Bu temel Uzerinden yolan c¢ikan ESRI, kullanicilarin
ihtiyacini karsilayacak, kullanimi kolay, modern, fonksiyonel ve profesyonel
¢ozimleri o6lgeklendirilebilir platformlarda sunabilen ArcGIS teknolojisini
Uretmigtir.

Cografi Bilgi Sistemlerinde veri toplamadan veri lretmeye, veri
depolamadan goriintlilemeye kadar bircok fonksiyon vardir. Ancak Cografi
Bilgi Sistemleri fonksiyonlarini genel bashklar altinda toplamak gerekirse; “
veri toplama teknikleri, veri depolama, veri goriintiileme, sorgulama,

analiz ve cikti” seklinde basliklar karsimiza cikar.
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\  Depolama

Sekil 7: Cografi Bilgi Sistemlerinin Genel islevleri

Veri Toplama ve Uretim Teknikleri

Cografi Bilgi Sistemlerinde (x,y) koordinatlarina bagh verilerin
sisteme aktarilmasinda farkh yontemler uygulamak mimkindir. Bu
yontemler uygulanirken verilerin toplanmasinda ve vektor verilerin
Uretiminde kullanilan bazi althk haritalar ve farkh kaynaklar mevcuttur.
Ornegin; farkli 6lgeklerdeki haritalar (topografya, imar plan, fiziki, siyasi,
vb.), uydu gorintileri, hava fotograflari ve yersel 6lglim ile elde edilen
koordinat bilgileri veri kaynaklari olarak tanimlanabilir. Hatta cep telefonu
ya da fotograf makinesi ile ¢ekilen bir fotograf dahi CBS teknolojisinde veri
kaynag teskil eder.

Cografi Bilgi Sistemlerinde ilgili veri kaynaklari temin edildikten
sonra ArcGIS teknolojisinde gerek ekran lizerinden otomatik olarak gerek
elle (manual) veri tGretmek mimkindir. Ayrica ArcGIS teknolojisinde text
dosyalarindan da veri Gretmek mimkindir. Yine text, excel, vb.
dosyalarindan veri Gretmeninin yani sira, farkh yazilimlarda Gretilmis ve
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bilgisayar ortaminda bulunan verilerin gerekli donlisimleri yapilarak da veri
Uretimi gercgeklestirilebilir.

Sekil 8: Cografi Bilgi Sistemlerinde Veri Uretiminde Kullanilan Veri
Kaynaklari

Veri Depolama Formatlari
Cografi Bilgi sisteminde yeryiziine ait bilgiler, vektor ve raster
formatlarda birbirlerinden soyutlanmis farkh  tabakalar seklinde
depolanirlar. Cografi Bilgi Sisteminde bu iki format, cografi analizlerde ve
sorgulamalarda etkin bir bicimde kullanilir. Bu sorgulama ve analizlerde,
vektor ve raster verilerin yukarida da aciklandigi gibi birbirlerine gore Ustiin
ve zayif yonleri vardir.

Vektorel Veri, formatinda konuma ait veriler; nokta, ¢izgi ve alan 6zellikleri
x,y koordinat degerleriyle depolanirlar. Nokta o6zelligi tekbir x,y koordinat
cifti ile temsil edilen verilerdir (Elektrik Direkleri, Yangin Musluklari, Kuyular
gibi). Cizgi 6zelligi, bir baslangi¢ ve bir bitis noktasi olan x,y koordinatlar
dizisi ile temsil edilirler (Dereler, Yollar, Elektrik Hatlari gibi). Alan 6zelligi
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ise, baslangi¢c ve bitis noktasi ayni olan x,y koordinatlar dizisi ile temsil
edilirler. (Parseller, Binalar, Arazi Kullanimi gibi)

Raster Veri, formatinda konuma ait veriler ise; hiicrelere bagli olarak temsil
edilir. Ayni boyuttaki hiicrelerin bir araya gelmesi ile olusurlar. En kiiglik
birim pixel olarak tanimlanir. Raster verilerde verinin hassasiyeti pixel
boyutuna goére degisen ¢ozinlrlik (resolution) 6zelligi ile tanimlanir. Raster
veride her pixel bir degere sahiptir. Bu deger bazen cografi bir 6zellige ait
kod degeri olarak tanimlanabilir ve ESRI Grid formatinda bu kod degeri
Value Attribute Table (Vat) yapisinda depolanir.Ya da o pixel 0-255 renk
araliginda bir degeri tasir.

Aralarindaki Farkliliklar

Raster verilerin veri depolama hacmi vektor verilere gore oldukga biiyiktir.
Bazi konumsal analizler (Bindirme analizleri, Alan hesaplamalari ve yakinlik
analizleri gibi) raster veri formatinda daha kolaydir.Verilerin hassasiyeti
raster verilerde pixel size ile orantili oldugu icin hassas calismalarda veri
kayiplarina neden olabilir. Vektérel veri formatinda grafik objeleri
tanimlayan oOznitelik bilgilerine ulasma ve glincelleme daha kolaydir.

sekil 9

GOl detayinin vektorel Ayni golun raster olarak
olarak temsili.Gol ile dis  temsil edilmis

cevre kiyi gizgisi ile hali.Rasterlarda
ayrilmaktadir hucreler,cografi bilgiyi

vermek Uzere kodlanmistir
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Sorgulama

Cografi Bilgi Sistemi grafik ve grafik olmayan verilerin birbirleri ile
bltlnlesik olarak sorgulanmasina olanak tanir. Buna gore grafik veriden
sozel verilere, sozel verilerden de grafik (konumsal veriye) verilere hizli bir
erisim saglanmis olur.

Select Feature & Select By Attribute & Select By Location

Cografi Bilgi Sisteminde depolanmis bir yol objesinin tanimlanmasi ile, o
yolun uzunluk, ad, tipi, vb bilgilere hizli bir erisim saglanmis olur. Bir parsel
tanimlandiginda o parselin alan, cevre, ada ve parsel numarasi gibi
bilgilerine erisim saglanmis olur. Veri tabanindan mantiksal ifadeler
kullanilarak grafik verilere ulasilmis olur. Sehir adi tanimlanarak ilgili
katmandaki istenilen sehirler ekranda gorintilenebilir.Sorgulama
yapilirken program icerisinde SQL (Structured Query Language) ifadeleri
kullanlmaktadir.

& Lavers

5 B Mprosde E, ——— N Fo wpats.
o g [ Oy show seleciable layers in fhis st

i 8 o st

= H Wvers
= @ water
[ |
= Frovinces
W cotryor

B werda

G Liwm Vi | G T
SELECT * FROM Metes WHERE
“MAME™ » Fdescton’

o v o

Select by Location

Farkli katmanlardaki verilerin (Yol,Mahalle Sinirlari, Parseller, Okullar,ilge
Sinirlari gibi) birbirleri ile iligkilendirilmesidir.Ornegin bir mahalle icine giren
parsellerin, okullarin secilmesi, demiryolunun gectigi illlerin segilmesi, bir
sanayi alanina belli bir mesafede olan yerlesim yerlerinin belirlenmesi gibi
mekansal sorgulamalar yapilabilmektedir.
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| Select features from one or more target layers based on their lacation in
S| relation to the festures in the source layer,

w| Selection method:

| [setect features from

Target layer(s):

[Jonky show selectable layers in this list

Source layer:

{0 features selected)

Spatial selection method:

[Targetlayer(e) features intarsect the Source layer feature

[l Apply a search distance

J [ aoay

Analiz

Cografi Bilgi Sistemi’nde depolanan veriler lizerinde konuma dayali kararlar
verebilme cografi verinin sorgulanmasi, goriintiilenmesi ve analizler ile
mimkin olmaktadir. Konumsal analiz islemlerinde, mevcut girdilerden
yararlanilarak, yeni bilgi kimeleri Gretilir.

e Tampon Bolgeleme (Buffer),

e Bindirme Analizleri (Overlay),

e Yakinlhk Analizleri (Proximity),

e  GOrlnUrlak Analizleri(Viewshed Analysis),

e Taskin Analizleri,
Yersecin Analizleri,

e Yogunluk analizleri (Density Analysis)

e Kisayol ve Altyapi Yonetim Analizleri (Network Analysis),

e Yizey Analizleri (3D, Aspect, Slope, Elevation, Visibility, Line of Site,
Cut&Fill),
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Sekil 10. Cografi Bilgi Sistemlerinde yapilabilecek bazi analizlere 6rnek
gorintiler

Cikti

Sistemde depolanan vektor veriler, veri tabani bilgilerine gore
siniflandirilarak farkh ozelliklerde goérintilenebilirler. Sistemde yer alan
semboloji kitlphanesi ile, vektor verilere ¢izgi tipleri, tarama, renk ve
grafik semboller atayarak ilgili yonetmeliklere gore harita goriintileme
islemleri hizli bir sekilde gergeklestirilir. ArcGIS sisteminde vektor verilerin
goriintlilenmesinde, Single Symbol, Unique Values, Graduated Colors,
Graduated Symbols, Dot Density, Pie Chart, Bar/Cloumn, Stacked gibi
ozellikler kullantlir. Bu fonksiyonlar ile yonetmeliklere dayal tematik
haritalama, standart topografik kadastral ve 6zel amagl harita tretimleri
ArcGIS teknolojisi ile esnek ve hizli bir yapiya kavusmustur.
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Sekil 11.Veri Gorintileme ve cikti islemlerinde kullanilan semboloji

kiitiphaneleri

ArcGIS’de Vektor ve Raster veri gorintileme 6zelliklerinin yanisira veri

tabani bilgilerinin etiketlenmesi,raporlanmasi ve grafikler ile gbsterimleri

de mumkindir
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Temel Harita Bilgisi

Harita, Ol¢ek ve Projeksiyonlar
“Haritalar Dinyanin Grafik sunumlaridir.”

Harita

Diinya ylzeyine ait herhangi bir kismin veya bir parganin, kusbakisi
gorintisliniin matematik

yontemlerle belli bir 6lgege gore kugultlilerek 6zel isaretleriyle bir diizlem
Uzerine gizilmis bir 6rnegidir.

Haritanin Tarihgesi

ilk harita, insanlarin kendi arazilerini belirleme ihtiyacindan ortaya gikmistir.
Baslangicta haritalarin yerine basit krokiler kullanilmistir. Bilinen ilk kroki
MO 4000 yillarinda tugla lizerine yapilan Babil sehrinin planlaridir. Nirengi
esasina dayali harita ise 1615 yilinda “Sinellius” tarafindan yapilmistir. Uydu
kesfi ve bilgisayar teknolojisindeki gelismeler, son 30 yil igerisinde harita ve
gorintd istihbaratinda devrim niteliginde degisiklikler meydana getirmistir.
Sayisal veri teknolojisi diye isimlendirilen bu devrim ile, klasik haritacilik
donemi geride kalmis ve yerine sayisal haritacilik dénemi baslamistir.
Ulkemizde haritacilik Piri Reis dénemine kadar dayanmaktadir. Tiirkiye'yi
icerecek tarzda vyapilan ilk harita serisi; 1:200.000 ol¢eginde, Bonne
projeksiyon sistemine gore yapilmistir. 123 paftadan olusan bu seri harita,
Ayasofya Camisi’nin kubbesini baslangic meridyeni olarak kabul ederek,
1911-1929 yillari arasinda retilmistir. ilk 1:25.000 6lgekli haritalar, 1909-
1932 yillarinda Bonne projeksiyon sistemine gore olusturulmustur. Takiben
1946-1956 yillari arasinda, Mese dagi mebde (orijin) noktasi alinarak, Gauss
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Kruger projeksiyon sistemi ile, 6 derecelik paftalar meydana getirilmistir.
1956 yilinda ise, ED50 datum’una gegilmistir.

Haritalarda Yonler, Sapma Agilari ve Agi Birimleri

Haritalarda; Kuzey, Gliney, Dogu ve Bati olarak isimlendirilen 4 ana yon
bulunmaktadir. Harita Uzerindeki herhangi bir yer, baslangic yoniine ve
istikamet agisina gore tanimlanmaktadir.

a. Yonler:

Kuzey ana yoniine dayali olarak herhangi bir yerin tanimlanmasi; “Gergek

nou

Kuzey”, “Manyetik Kuzey” ve “Grid Kuzeyi” olarak adlandirilan {i¢ ana yone
gore yapilmaktadir.

Gergek Kuzey: Cografi kuzey veya harita kuzeyi olarak da ifade edilen
gercek kuzey, yerylziindeki herhangi bir noktadan kuzey kutbuna yonelen
dogrultudur. Tim meridyen (boylam) dairelerinin yoni gercek kuzey
dogrultusunda olup, bu da genelde bir yildiza oryante edilmistir.

Manyetik Kuzey: Yerylziindeki herhangi bir noktadan manyetik kutba
yonelen veya pusula ibresinin gdsterdigi dogrultudur.

Grid Kuzeyi: Harita Gzerinde dikey grid cizgilerinin gosterdigi istikamettir.

Grid Kuzeyi Gergek Kuzey

Manyetik Kuzey

Sekil 12. Gergek kuzey, Manyetik kuzey ve Grid kuzeyi

Diinyanin sekli bir kireye benzediginden, meridyen daireleri kutuplarda
birlesecek tarzdadir, yani birbirlerine paralel degildir. Bu nedenle, degisik
meridyen daireleri lGzerinde bulunan noktalari birlestiren dogrularin her iki
ucundaki gercek kuzey istikametleri de birbirine paralel degildir. Harita
Gzerindeki grid cizgileri ise birbirine paraleldir.
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Diinyanin manyetik kuzeyi ile gergek kuzey ayni mevkide degildir. Manyetik
kuzey, diinyanin donls ekseninden takriben 11 derece farklidir. Diger bir
deyisle manyetik kutup 710° Kuzey 960° Batidadir.

b. Sapma Agllari:

“Grid-Manyetik Sapma Acisi” ve “Manyetik Sapma Acisi” olarak
tanimlanmis 2 tip Sapma Agisi

bulunmaktadir.

Grid-Manyetik Sapma Agcisi: Manyetik kuzey ile grid kuzeyi arasindaki
acidir.

Manyetik Sapma Agisi: Gergek kuzey ile manyetik kuzey arasindaki agidir.

Grid Kuzeyi Gergek Kuzey

Manyetik Kuzey

Sekil 13.Grid-manyetik sapma Agisi (a) ve manyetik sapma Agisi (b)

Manyetik sapma agisi, gercek kuzeyin dogusuna veya batisina gore belirtilir.
Haritalar Gzerinde ise

kesik hatlar halinde 6rnegin 3°E veya 15°W tarzinda gésterilirler. Bu agilar,
bazi tlkelerde hem dogu

hem de batiyi icermektedir. Tirkiye’de ise daima dogusaldir. Harita
Uzerinde olgllen istikametler hakiki basin, ucak ile uculan istikametler ise
manyetik basin olarak ifade edilir. Eger hakiki basin

olarak ol¢lilen dogu sapma degerini iceriyorsa, bu deger hakiki basin
degerinden ¢ikarilir. Hakiki basin

Olglildigl yer bati sapma degerini iceriyorsa, bu deger hakiki basin
degerine eklenir.
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WET

Waryetik Kuzey = Hakiki Kizey Manyetik Kuzey < Hakiki kuzey

4 ]

Sekil 14.Kuzey Amerika’ya iliskin manyetik sapma agcilari

c. Harita Agi Birimleri:
Ulkemizde Uretilen haritalarda “Derece”, “Grad” ve “Milyem” aci degerleri
kullanilmaktadir.

(1) Derece:

En cok kullanilan agi birimidir. Bir daire c¢evresinin 360 esit parcaya
boélinmesiyle meydana

gelen yayi, dairenin merkezinden goren aglya, bir derece denir. 1
derece=60 dakika, 1 dakika=60

saniye, keza 1 derece=3600 saniyedir.

(2) Grad:

Bir daire cevresinin 400 esit parcaya bolinmesiyle meydana gelen yayi,
dairenin merkezinden

goren aclya, bir grad denir. Bir dik agi (900) 100 grad’dir. 1 grad / 100= grad
dakikasi, 1grad dakikasi /

100=grad saniyesidir.

(3) Milyem:

Bir daire cevresinin 64 esit parcaya bolinmesiyle meydana gelen vyayi,
dairenin merkezinden

goren aglya bir TAM, bu tamin ylzde birine ise bir milyem denir. Bir daire
6400 milyemdir.
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Olgek

Olgek, harita tizerinde belli iki ayrinti arasinda oélgiilen uzunlugun, bu iki
noktanin arazi uzunluguna

oranidir. Genel olarak bir kesirle ifade edilir. Ornegin 1/25000 6lgekli bir
harita dendiginde “1” rakami

birim degeri ifade eder ve haritadaki iki nokta arasindaki uzunluktur.
Arazide bu iki noktanin uzunlugu

bu birim degerin “25000” kati demektir.Diger bir ifade ile; Olgek = Harita
Uzunlugu/Arazi Uzunlugu

demektir.

23 it [y —

Harita Projeksiyonlari

Kiresel sekildeki diinyanin, bozulmaksizin diiz bir satih (zerinde
gosterilmesi olanaksizdir. ideal bir

harita; dogru SEKILLERI, SAHALARI, MESAFELERI ve iSTIKAMETLERI iceren
ozelliklere sahip

olmalidir. Bu 6zelliklerin bazilarini kapsayan haritalar muhtelif projeksiyon
uygulamalari ile Gretilmistir.

Genel olarak 3 tip harita projeksiyonu bulunmaktadir.
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Silindirik

w3Raps
" hres
sDistancs

sDirsetion ‘

0O Harita projeksiyonlan 3 boyuthu dinya yiizeyind diz i_"_._‘_‘_
i yimey e chinGybiindr,

Projeksiyon Tipleri:
Silindirik,Diizlemsel,Konik

Silindirik Projeksiyonlar
(1) Merkator Projeksiyonu:

Merkezinde bir 151k kaynagi bulunan kiiresel diinyanin, ekvatoruna teget
olarak gegcirilen

bir silindir vasitasiyla harita elde edilmesini saglayan bir projeksiyondur.
Merkator

projeksiyonuna sahip olan haritalarda sadece ekvatora yakin olan
bolgelerde dogru

sonuglar alinir. Kutuplara dogru gittikce sekiller bozulur. Ornegin 7.700.000
mil karelik bir sahaya sahip Gliney Amerika ile 800.000 mil karelik Gronland
adasi ayni biyiklikte gorinir. Kiglk bir sahada (1 derecelik kare)
herhangi bir sekil bozulmasi meydana gelmez.
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Merkator projeksiyonu ile yapilan haritalar asagida belirtilen 6zelliklere
sahiptir:

- Meridyenler, birbirine paralel, esit aralikli ve diiz gizgiler seklindedir.
Paraleller, birbirine parelel olmasina ragmen kutuplara dogru gittikce
aralari
acihr. 60 derece paralelindeki, paralel dairelerinin birbirinden olan
uzakliklari
ekvatordakilerin iki mislidir. Ekvatorda 1: 1.000.000 olgekli olan harita, 60
Incl
paralel dairesinde 1: 500.000 6lgeklidir. 80 inci paralel dairesinde ise
Olgek, 6 katina c¢ikar. Bu nedenden, 80 inci paralel dairesinden kutuplara
kadar
olan kismin haritalari yapiimaz.
- Meridyenler ve paraleller birbirine diktir.
Meridyenleri ayni aci ile kesen hatlara Kerte hatti denir. Meridyenler
birbirine
paralel oldugu icin kerte hatti dogrudur.
- Blyuk daire ekvator harig egridir.
- Mesafeler ve sahalar dolayisiyla sekiller, kutuplar civarinda asiri derecede
bozuktur.

(2) Transversal Merkator Projeksiyonu:

Herhangi bir meridyen dairesine teget olarak gecirilen silindir ile elde edilen
projeksiyondur. Buna Gauss-Kruger projeksiyonu da denir. Ulkemizde de
kullanilan ve

ozellikle topografik haritalarin liretiminde tercih edilen bir projeksiyondur.
Teget

meridyeninden uzaklastikca hata orani artmaktadir. Ornegin bir
meridyenden 1.5 derece

(130 Km.) uzaklikta bulunan yer sathi Uzerindeki 1000 metrelik bir
uzunlugun silindir

Gzerindeki iz disimi biraz buylyerek 1000.22 metre olur. 3 derece
uzaklikta ise bu deger,
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1000.83 metreye cikar. Diger bir deyisle 83 santimlik bir hata meydana
gelir. Daha fazla

hatayr onlemek icin haritalar, arazi parcalari 3 ve 6 derecelik dilimler
halinde izdistmleri

cikarilarak vyapilir. 1:25.000 ve daha kiicik olcekli haritalarda dilim
genislikleri 6

derecedir. Buylk olgekli (mikyash) haritalarda ise 3 derecedir. Bu
projeksiyon tipi UTM GRID

referans sisteminin esasidir.

Transversal merkator projeksiyonu ile yapilan haritalar asagida belirtilen
ozelliklere sahiptir:

- Silindirin teget oldugu meridyen, silindir ve diinyada ortak oldugundan,

uzunlukta bir degisme meydana gelmez yani 6lcek her yerde aynidir.
Merkez meridyenin yani silindire teget olan meridyenin saginda ve

solundaki

saha kapsamindaki (3 veya 6 derecelik dilim) sekiller normaldir.

- Acilar dogru olup, kerte hatti kavislidir.

- Yonler dogrudur.

SILINDIRIK PROJEKSTYONLAR

OZELLIKLER MERKATOR TRANSFER MERKATOR
Esit olmayan arzlikli birbirine diiz | Merkezi meridyen disindakiler esit
hatfar olmayan aralikli kavisli hatlar

MERIDVENLER Birbirine paralel esit aralikh diz Mer_ke_zi meridyen diz hat digereri
hatlar kavisli

GRID HATLARI GORUNTUSU

MERIDVYEN VE PARALELLER

ARASINDAKI ACI 90 Derece Degisebilir

MERIDYENLERIN DUZ BIR HATLA

KESISMESI Sabit bir aci Degisen bir aci

BUYUK DAIRE Ekvator ve meridyenler harig Merkezi meridyen ve ekvator harig
Kavisli hat digerleri kavisli

KERTE HATTI Diiz hat Egri hat

PROJEKSIVONUN GRAFIK
OLARAK GORUNTUSU

1)

SAHA VE SEKTLLERIN BOZULMAST | Ekvatordan uzaklastikea fazladir fh;;arkfz meridyenden uzaklastikca
ir
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Konik Projeksiyonlar:

(1) Polikonik Projeksiyon:

Ekseni, koninin tepe noktasina gelecek sekilde diinya kiresi Uzerine
gecirilen muhtelif

koniler vasitasiyla yapilan projeksiyondur.

Polikonik projeksiyonu ile yapilan haritalar, asagida belirtilen 6zelliklere
sahiptir:
- Ekvator ve merkezi meridyen birbirine dik ve diliz hatlar halindedir.
- Merkezi meridyenin her iki tarafindaki meridyenler, ice biikey kavisli olup,
ekvatordan kutuplara dogru birbirlerine birlesecek sekildedir.

Merkezi meridyen Uzerinde, paralellerin araliklari birbirine esit fakat
kavislidir.
- Merkezi meridyenin her iki tarafinda 560 millik bir saha iginde, dlcekte ve
saha
Gzerindeki hatalar %1’i asmaz.
- Yonler dogrudur.
- Kerte hatti egridir.

(2) Lambert Konformal Konik Projeksiyon:
Diinya kiiresinin iki standart paraleli arasinda bir koni vasitasi ile yapilan
projeksiyonudur.
Olgek hata limitini en asgariye indirmek ve hakiki dogrulugu saglamak igin,
standart
paraleller arasi 20 dereceyi ge¢memelidir. Standart paraleller {izerinde
Olcek tamamen
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dogru olup aralarindaki 6lcek ise, muayyen bir derecede kiictliir. Standart
paraleller
disinda 6lcek gittikce blyr.
Lambert Komformal Konik projeksiyonun baslica 6zellikleri sunlardir:
- Meridyenler kutuplarda kesisen diiz dogrulardir.
- Paraleller merkezi ayni olan yay parcalaridir.
- Standart paraleller boyunca 6lcek sabittir. Bu paraleller arasinda bitin
istikametler takriben dogrudur.
Blylk daireler olduk¢a diiz hatlar halindedir. (uzun mesafelerde
kavislidirler)
- Kerte hatti hafifce egridir.

KONIK PROJEKSIVONLAR

OZELLIKLER POLIKONIK LAMBERT KOMFORMAL
Merkezi bir olmayan dairelerin Esit aralikli merkezi ayni olan dairenin
esit aralikli kavis parcalaridir kavisleri
MERIDVENLER Merkezi meridyen duz hat Kutuplarda birlesen duz hatlar
digerleri kavisli
GRID HATLARI GORUNTUSD 1
/ T\
T (11
T 7
I i
| | =
MERIDYEN VE PARALELLER S g
ARASINDAKI ACL Degisebilir 90 Derece
MERIDYENLERIN DUZ BIR HATLA : = - I
KESISMESIT Degisen bir aci Degisen bir aci
BUVYIK DAIRE Merkez meridyeni yakininda Takriben diiz hat
takriben diiz hat
KERTE HATTI Kavisli hat Kavisli hat

PROJEKSIVONUN GRAFIK OLARAK
GORUNTUSU

SAHA VE SEKILLERIN BOZULMASI fh;;eslakg‘_z meridyenden uzaklastikca | Cok az
i
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Konik Projeksiyon

Diiz Projeksiyonlar

Diz projeksiyonlardan en poplileri Ghomonik projeksiyonlardir. Yeryilzi
Uzerinde se¢ilmis olan

herhangi bir noktaya teget olarak diiz bir satih konularak elde edilirler. Bu
projeksiyon ile elde

edilen haritada teget noktasindan uzaklastikca, blyik bozulmalar meydana
gelir.

Projeksiyonun en o6nemli 6zelligi buyilk dairenin diz bir hat seklinde
olmasidir. Bu 6zellik,

dinya Uzerindeki 2 nokta arasinda, en kisa mesafeyi verir. Bu nedenle
kutuplara yakin olan

ucuslarda, bu tip projeksiyonla yapilmis haritalar kullanilir.

Sathin diinya Uzerine teget olarak kondugu noktaya gére Gnomonik
projeksiyonlar; Kutbi

Gnomonik (satth kutuplara teget), Ekvator Gnomonik (satih ekvatora
teget) ve Egik

Gnomonik (satth diinya kiresine egik durumda ve herhangi bir noktaya
teget) olarak

adlandirilirlar.

Gnomonik projeksiyonlarin baslica 6zellikleri sunlardir:

- Meridyenler diiz bir hat halindeki dogrulardir.

- Paraleller esit aralikta olmayip; kutbi gnomonikte daire, ekvator ve egik
gnomonikte ise

kavisli sekildedir.
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- Bliylk daireler diiz hat halindedir. Kerte hatti egridir.
- Teget noktasindan uzaklastik¢a sekil ve sahalar fazlaca bozulur.

s == e
fEEC T |: = e —
l | - \ £ /
* "'\._F'}
Gaemenls Hereogrophls Orihegraphls
DUZ (GNOMONIK) PROJEKSIYONLAR
OZELLIKLER KUTBI GNOMONIK EKVATOR GNOMONIK EGIK GNOMONIK
Esit olmayan aralikli Esit olmayan aralikli kavisli | ESit olmayan arafikli kavisli
miisterek merkezi daireler | hatlar hatlar
MERIDYENLER Kutupta birlesen diiz hatlar I'ﬁ__it olmayan aralikli parallel | Kutupta biresen diiz hatlar

diiz hatlar

GRID HATLART

phgpioct s 4 | [ f
GORUNTUSU ‘—\-"‘—1—_.-_— —T—le' /
T [T =]
i 2B I
! . J:
| ]
MERIDVYEN VE
PARALELLER 90 Derece Degisebilir Degisebilir
ARASINDAKI ACI
MERIDYENLERIN DUZ - Py A
BIR HATLA KESISMESI 3:“9_59” biraci (Biydk | sabit bir aci Degisen bir aci
BUYUK DAIRE Dz hat Diiz hat Diiz hat
KERTE HATTI Kavisli hat Kavisli hat Kavisli hat
PROJEKSIYONUN
GRAFIK OLARAK
GORUNTUSU

SAHA VE SEKILLERIN
BOZULMASI

Kutuptan uzaklastikca
fazlalasir

Ekvatordan uzaklastikca
fazalasir

Teget noktasindan
uzaklastikca fazlalasir
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Harita Referans Sistemleri

Harita U(zerindeki noktalarin ve sahalarin vyerlerinin belirtilmesi igin
kullanilan metodlara referans

sistemleri denir. Bir referans sistemi, genel olarak bir seri harf ve rakami
icerir. 3 tip harita referans

sistemi bulunmaktadir.

Cografi Koordinat Sistemi:

Cografi Koordinat Sistemnde bir mevkinin belirtilmesi icin meridyen ve
paraleller

kullanilir. Meridyen, bir paralel boyunca ana meridyenin (Greenwich sifir
meridyeni)

dogusuna veya batisina, paralel ise bir meridyen boyunca ekvatordan
itibaren kuzey

veya glineye dogru Olgllir. Meridyen ve paralellerin degeri kutbi ve
ekvatora gore

meydana gelen agi degeridir.

Sekil 15.Cografi Koordinat Sistemi
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Paralials Maridians
{Lings of |atifwde) (Lines of longiude)

Sekil 16.Diinya lizerindeki Meridyen ve Paraleller

Haritada bir noktanin tarifi; ekvatorun kuzeyindeki paralel (K veya G, N
veya S) ve ana meridyenin dogusundaki veya batisindaki meridyen (D veya
B, E veya W) belirtilerek yapilir. Bu paralel ve meridyenler harita lizerinde
genel olarak 1’er derecelik kareler halindedir. Her bir derece hatti lizerinde
1’er dakikalar isaretlenmistir. (1 derece 60 dakika, 1 dakika 60 saniye) Her 5
dakikada bir uzun ¢izgi konulmustur.

Bir yerin bildirilmesinde, paralel ve meridyenin kesisme noktasi alinarak
once paralel

degeri sonra meridyen degeri yazilir. Paralel degerinden sonra “K” veya “G”
harfleri,

meridyen degerini takiben ise “D” veya “B” harfleri konur. Karisikliga neden
olmamak igin

harfler arasina nokta ve virgil gibi isaretler konmaz. Paraleller 2 haneli,
meridyenler ise 3

haneli rakamla gosterilir. Dakika ve saniye degerleri 2 haneli rakamla
belirtilir.

Georef Sistemi:

Rapor etme ve tesbit icin, paralel ve meridyenleri uygun bir form icinde
gosteren bir

sistemdir. Dlinya cografi grid’i diye de anilan bu sistem, projeksiyon tipi
dislintlmeksizin

paralel ve meridyenleri iceren herhangi bir haritaya uygulanabilir. Bu sistem
hava
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savunmasl ve genis alanlardaki hava harekatlari igin kullanilmak {izere
meydana

getirilmistir. Keza Kara ve Deniz Kuvvetleri icin de yardimci ilave bilgileri
kapsamaktadir.

Bu sistemde diinya yiizeyi sistematik olarak bazi bélgeler hari¢ 15 derecelik
dortgenlere

bolinmistir.

15 derecelik bu dilimler; 180 derece meridyeninden baslayarak doguya
dogru

"A” - “2” harfleri ile (I, 1, O, ©, U harfleri harig), 80 derece giiney
paralelinden

baslayarak 80 derece kuzey paraleline dogru ”A” - “M” harfleri ile (I ve i
harfleri harig)

tanimlanmustir. Arazinin buzul ile kapli olmasi nedeniyle, bu bdlgelerde
arazi 5

derecelik dilime (80 derece guney - 75 derece giiney, 80 derece kuzey - 75
derece

kuzey) ayrilmistir. Boylece diinya doguya dogru 24, kuzeye dogru 12 dilim
olmak Uzere

288 dortgene boliinmustir. Bu dortgenlerden her biri 6nce doguya, takiben
kuzeye dogru

okunan 2 harf ile temsil edilmistir.

Sekil 15’de taranmis olan dortgen, doguya dogru (saga) “M” diliminde,
kuzeye dogru

(yukar) “G” dilimindedir. Boylece dikdortgen bolge, “MG” harfleri ile
belirtilir.

Her 15 derecelik dortgen, ayrica 1’er derecelik 15 dortgene bolinmiustir.
Bu dértgenlerde,

doguya ve kuzeye dogru “A” — “Q” harfleri (I, 1, O, O harfleri harig) ile
belirtilmistir.

Boylece 1xlderecelik dértgenlerde, 2 harf grubu ile tanimlanmistir. 1x1
derecelik

doértgenin tanimi, 15 dereceyi temsil eden harf grubunun da ilavesi ile 4
harf grubu

tarafindan yapilmaktadir.
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Diinya Uzerindeki 1 dakikalik herhangi bir mevkinin tesbiti 4 harf ve 4
rakam ile mimkiin

olmaktadir. Harflerden sonra gelen ilk iki rakam mevkiin bir derecelik
doértgen icinde

doguya dogru kaginci meridyen dakikasinda, son iki rakam ise bir derecelik
doértgenin

gliney paralelinden itibaren kuzeye dogru kacinci paralel dakikasinda
olduguna isaret

eder.

Eger daha fazla bir dogruluk istenirse, her 1 dakikalik dortgen doguya ve
kuzeye dogru

ondalikli tali kisimlara ayrilir. Béylece 4 harf ve 6 rakam gurubu ortaya cikar
ki, bu bir

mevkiin 1/10 dakikasini belirtir. Cok daha hassas mevkii tayininde dakikanin
1/100’Gne

kadar inilebilir. Bu hassasiyet 4 harf ve 8 rakam ile ifade edilir.

Grid Koordinat Sistemi

1947 yilindan 6nce diinyada, standart bir grid sistemi yoktu. Yapilan
calismalar

sonucunda 80 derece kuzey ve 80 derece gliney paralelleri arasinda kalan
bdlge icin

UNIVERSAL TRANSVERSAL MERKATOR (UTM) grid sistemi meydana
getirilmistir. Grid

sistemi, harita Uzerine cizilmis dikdortgenlerden olusan bir koordinat
sistemidir.

Dikdortgenler birbirine dik ve esit mesafeli 2’ser paralel hattan olusmustur.
Hatlar

arasindaki mesafe umumiyetle harita 6lcegindeki metre veya yarda gibi kati
bir sayiyi

gosterir. Bir grid, arazi Gzerinde bulunan iki nokta arasindaki mesafe ve
azimuth’u siratle

tespit etmeye olanak saglar. Bazi haritalar birden fazla grid’i kapsarlar bu
durumda her

grid, farkli bir renk ile gosterilir.
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Bu sistemde diinya; 6x8 derecelik dilimlere, takiben 100.000 ve 10.000
metrelik karelere

bolinmustiir. Burada dikkat edilecek husus, 6nce saga takiben yukari
degerlerin

okunmasidir.

6 x 8 Derecelik Dilimler

Diinya kiresinin 80 derece giliney ve 80 derece kuzey paralelleri arasinda
kalan

saha; dogu-bati istikametinde 6 derecelik, gliney-kuzey istikametinde ise 8
derecelik

dilimlere (zone) bolinmustir. 6 derecelik dilimlerin baslangic meridyeni
180 derece

olup “1-60” rakamlariile, 8 derecelik dilimlerin baslangici 80 derece

gliney paraleli olup “C-X” (1, I, O, O harfleri haric) harfleri ile

tanimlanmistir. Boylece 6 x 8 derecelik bir dilim, 1 veya 2 rakam ve 1 harf
ile

belirtilmistir (Sekil-16). Ornegin; “5N” taniminda, “5” rakami 6 derecelik
dilimi, “N”

harfi ise 8 derecelik dilimi, “34S” taniminda ise, “34” rakami 6 derecelik
dilimi, “s”

harfi ise 8 derecelik dilimi belirtmektedir.

100.000 Metrelik Kareler:

Her 6 x 8 derecelik dilim, saga ve yukari dogru 100.000 metrelere
bolinmustr.

Meydana gelen her bir kare iki harf ile ifade edilir.

Alfabetik sira dahilinde baslangi¢c meridyeninden itibaren doguya dogru her
100.000

metre, “A” ve “2” (I, I, O, O harfleri hari¢) harfleri ile belirtilir. Bu “18
derecelik”

bir sahayi kapsar. Alfabetik sira her 18 derecede yeniden baslar.

Ayrica giineyden kuzeye dogru her 100.000 metre “A” ve “V” (I, I, O, O
harfleri
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harig) harfleri ile belirtilir. Alfabetik sira her 18 derecede yeniden baslar. Bu
harflendirmede tek numaral dilimlerin baslangici ekvator olup “A” — “V”
harfleri ile

tanimlanmislardir. Cift numaral dilimlerde ise, baslangic noktasi ekvatorun
500.000

metre glineyinde kabul edildiginden ekvatora “F” harfi isabet etmektedir.
Kisaca tek numarali dilimlerde harflendirme “A” dan, cift numaral
dilimlerde ise

ekvatordan kuzeye dogru olmak lizere “F” den baslar.

10.000 Metrelik Kareler:

Kenarlari 100.000 metre olan karelerde, 10 esit kisma bollnerek sifirdan
dokuza (O-

9) kadar numaralandiriimistir. Boylece meydana gelen 10.000 metrelik
kareler,

harita Uzerinde umumiyetle mavi cizgilerle gosterilmistir. Bu kareler
icindeki

herhangi bir noktanin mevkii, 10 kisma boéliinmis olan ve her biri 1000
metreyi

gosteren seffaf sablon (template) kullanimi ile belirlenir. 1000 metrelik
template kareleri

icine diisen bir noktanin tesbiti, haritanin 6lgegine bagli olarak goz karari ile
100,

10, 1 metreye kadar yapilabilir.
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ArcGIS 10 Mimarisi

ArcGlIS, Cografi Bilgi Sistemi konusunda, masadstu, server, web kullanicilar
ve arazi calisanlari icin Olgeklendirilebilir bir yapi sunmaktadir. ArcGIS
Grlnleri temelde 5 sinifa ayrilmaktadir;

ArcGIS Desktop : ileri diizey Cografi Bilgi Sistemi ¢alismalari i¢in 3 driin
sunmaktadir; ArcView, ArcEditor, Arcinfo

ArcGIS Server : Cografi Bilgi Sistemi ile olusturulmus haritalari web
servisleri olarak sunmayl ve web uygulamalari yaratmayi saglar. Ayrica
kurumsal veri tabani yonetimini saglar.

ArcGIS Mobile : Arazi ¢calismalari igin 6zel arag ve uygulamalara sahiptir.

ArcGIS Engine : C++, .NET, veya Java kullanan uygulama gelistiricilere
yazilim bilesenleri kiitliphanesi saglar.

ArcGIS Online : Kendi web uygulamalarinizda kullanabileceginiz, ESRI ve
ortaklari tarafinda yayinlanmis haritalarin bulundugu, web Uzerinden
ulasilabilen bir kitliphanedir.

| ArcPad . Yanhim Geligtirici CBS
M E5R) Dovaloper Network (EDN)
F. 30 GorOntdleyict
A Explons CBS Web Servisier|
KML (Google, Microsoft
Diger ArcGIS Ondnag
—C"’ Gorantiieyiciler
Wb Taraycilar
AJAX FLASH REST
Server CBS ArcGiS Server-—  ArcSDE  — Imape Server

Sekil 1: ArcGIS Mimarisi



ArcGIS Desktop

Cografi Bilgi Sistemi kullanicilarinin, cografi veriyi kullandiklari, yonettikleri
ve yayinladiklari birincil platformdur. Bu platformda kullanicilar, haritalama,
veri yayinlama, analiz, veri tabani yonetimi ve cografi bilginin paylasimi gibi
sinirsiz islemi bir arada gergeklestirebilmektedirler.

ArcGIS Desktop farkh kullanicilarin gereksinimlerini karsilamak Uzere
Olgeklendirilebilir bir yapiya sahiptir.

- . ArcView, c¢ok kapsamli veri
Arr;lnfu kullanimi, haritalama ve analizler
Gzerine odaklanmaktadir.

ArcEditor ArcEditor,  ArcView  vyazilim
ozelliklerine ek olarak gelismis

veri Uretimi ve veri glincelleme

ArcView yeteneklerine sahiptir.

Arcinfo, ¢ok kapsamli CBS
fonksiyonlari  ve ¢ok zengin

cografi islemler iceren
profesyonel bir yazilimdir.

ArcView, ArcEditor ve Arcinfo Urlnleri ayni mimariyi paylasmaktadirlar.
Dolayisiyla bunlardan herhangi bir tanesi ile ¢alisan kullanici uygulamalarini
diger kullanicilar ile paylasabilmektedir. Haritalar, veri semboloji, harita
katmanlari, 6zel araglar ve arayizler, raporlar ve digerleri bu g Uriin
icerisinde etkilesimli olarak kullanilabilmektedir.
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Hangi ArcGIS Desktop uUrlininin sizin igin uygun oldugunu asagidaki
matrise bakarak belirleyebilirsiniz.

L

Harita Uretimi ve Gérsellestirme

Cok Kullanicili Ortamda Giincelleme ve Veri Yonetimi

Gelismis Analizler, leri Diizey Haritalama ve Veri Tabani Yonetimi

Sekil 2: ArcGIS Fonksiyon Matrisi
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Ek olarak, Ucretsiz ArcReader Uirlinli, 6zel ArcGIS Engine uygulamalari ve
ArcGIS Server kullanilarak olusturulan ileri diizeyde CBS web servisleri ve
uygulamalari ArcGIS mimarisinin diger glicli elemanlaridir.

ArcGIS Desktop vyazilimlari ArcMap, ArcCatalog, ArcGlobe, ArcScene,
ArcToolbox ve Model Builder gibi uygulama ve arayiizlere sahiptir.

sRaARs ol e

= "3
: @9 Arcataing - drciots - C-URCGISHO_FGTIN e %
o hd |
& - i
Al s
3 2
Qv
Q.
Q.
g9
Qo
Q.
[ - JT
Sekil 3: ArcMap Arayiizi Sekil 4: ArcCatalog Arayiizl

ArcMap

ArcMap, mevcut grafik ve sézel verilerin gorintiilenmesi, giincellenmesi,
sorgulanmasi, analiz edilmesi, grafiklerinin olusturulmasi ve raporlanmasi
islevleri ile kullaniciya, yiksek kalitede kartografik sunumlar saglamaktadir.

BOTAS BORU HATLARI + ®
O SR .
+ 1 & +
+ 4+ 3 -
N S 5
+ % 3 Sekil 7: Representation
& B .
sekil 5: ArcMap’te olusturulmus s Sembolleri
Boru hatlari haritasi Sekil 6: Semboloji
Kituphanesi
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Sekil 8: ArcMap'te 3ol b o ’ ® i
olusturulmus rapor sekil 9: ArcMap’te
olusturulmus grafik
ArcCatalog

ArcCatalog kullaniclya, grafik ve sozel verileri tanimlama, gézden gegirme,
yonetme ve organize etme islevlerini sunmaktadir. ArcGIS 10’dan itibaren
ArcMap araylzu igerisinde bir pencere olarak da agilabilen ArcCatalog
asagidaki fonksiyonlara sahiptir.
e liskisel veri tabanlarina direk baglanti
e Windows Explorer’a benzer islevler
e Veritipleri, icerikleri ve ikon goriintileme
e Drag-drop ozelligi
e Projeksiyon sistmelerinin goriintiilenmesi ve yonetilmesi
e Veri tabaninda yer alacak olan alanlarin (field) belirlenmesi ve tim
ozelliklerinin yéentilemsi
e ESRI ArcGIS veri formatlarinin olusturulmasi (Shapefile, Coverage,
Feature Class)

e Verilgeriklerinin olusturulmasi (Item Description)
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e Verilerin Onizlemesinin yapilmasi (Preview)

e UML (Unified Modeling Language) ile olusturulmus nesne
modellerinden geodatabase yaratma

e Grafik ve Sozel verilerin arasindaki islevlerin tanimlanmasi (Subtypes,
Domains, Relationship Class)

e Veri Yonetimi (Copy, Rename, Delete)

e Yerel aglar ve web lizerinde CBS verilerinin sorgulanmasi

e ArcToolbox (Geoprocessing)

Sekil 10: ArcCatalog Arayiizii. .+~

Sekil 11: ArcCatalog
Arayiiziiniin Onizleme Ozelligi

ArcToolbox ve ModelBuilder

Geoprocessing, Cografi Bilgi Sistemi icerisindeki coklu islemlerin ve
metodlarin otomatik hale getirilmesi igin kullanilmaktadir. Kullanicilar, ylksek
kalitede veri olusturmak, veri kalitesi (zerinde kontrolleri yapmak,
modelleme ve analizleri kisa zamanda vyapabilmek icin geoprocessing
fonksiyonlarini kullanmaktadirlar.  ArcToolBox geoprocessing araglarinin
organize bir koleksiyonu, ModelBuilder ise geoprocessing is akislarinin
yapilandiriimasinda gorsel bir modelleme dilidir.
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ArcToolBox, ArcView, ArcEditor ve Arcinfo igerisinde kullanilabilir
durumdadir. Her seviye ek geoprocessing araglari icerir. ArcView, basit veri
ylkleme ve donisiim araglari ve temel analiz araglari igcermektedir. ArcEditor,
ArcView yaziliminin sagladigi araglara ek olarak geodatabase olusturmaya ve
yiklemeye yonelik ek aracglar saglar. Arcinfo ise, ileri dizey analizler, veri
donidsimi, veri ylkleme ve coverage islemleri icin c¢ok kapsamli
geoprocessing araglari saglar.

ArcToolBox araylzine ArcGIS 10'dan itibaren Search ve ArcCatalog
pencereleri ile ulasiimaktadir.

ModelBuilder araylizii ise, geoprocessing is akislarinin ve scriptlerinin
yapilandiriimasi icin grafiksel bir modelleme aracidir. Ayni zamanda karmasik
geoprocessing modellerinin olusturulmasina ve tasarlanmasina yardimci olur.

ModelBuilder, metodlari ve prosedirleri organizasyonunuz disindaki diger
kullanicilar ile paylasabilmeniz igin verimli bir mekanizmadir. Bunun tersi
olarak, ArcGIS 10’da gelen sifreleme islemi ile olusturulan modellerin
baskalari tarafindan erisilmesi de engellenebilmektedir.

Search £ X
& 2 | E3 [Local Search -

AL Maps  Datz Tools

@
o
o
3
I

t Tools

Find My Custom Toolboxes...

Sekil 12: ArcToolBox Arayliziine Sekil 13: ModelBuilder Arayiiziinde
Search penceresinden erisim olusturulmus yersecim analizi modeli
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ArcGlobe ve ArcScene

ArcGIS Desktop 3D Analyst Modiili ile birlikte gelen ArcGlobe ve ArcScene
arayuzleri, kullaniciya 3 boyutta modelleme, analiz ve ArcGIS 10’dan itibaren
glincelleme imkani sunmaktadir. . ArcGlobe ve ArcScene araylizlerinin cografi
bilgi icin interaktif goriintiileme ortami, CBS kullanicilarinin tamamen farkh
veri setlerini entegre etme kabiliyetlerini 6nemli 6l¢lide gelistirmistir.

R =]

Sekil 14: ArcGlobe Araylzi

Sekil 15: ArcScene Arayiiziinde
modellenmis arazi ve kent

ArcGIS Desktop igin istege bagh modiiller

ArcGIS Masaistli Moddlleri kullanilarak bitin yazilimlara yeni yetenekler
eklenebilmektedir.

ArcGIS 3D Analyst

Kullanicilara etkin ylizey modelleme, goriintiileme ve analiz imkani tanir. 3D
Analyst kullanilarak egim, baki, gorlintirlik analizleri yapilabilir, vektor raster
donidsimleri  gergeklestirilebilir ~ ve  mekan 3 boyutlu  olarak
modellenebilmektedir.

ArcGIS 3D Analyst Modili ile gelen ArcGlobe ve ArcScene arayizleri
kullaniciya (i¢ boyutta mekansal modelleme, giincelleme ve analiz imkani
sunmaktadir.
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ArcGIS 10’dan itibaren kullanicilar Phyton kullanarak bir ¢ok analizi hizl

olarak gerceklestirebileceklerdir.

Sekil 16: ArcGIS Desktop 3D Analyst Modiilii ile gergeklestirilmis 3 boyutlu modeller

ArcGIS Spatial Analyst

ArcGIS Spatial Analyst blyilk olciide glicli mekansal modelleme ve hiicre
bazl raster verileri olusturmaniza, haritalamaniza, sorgulmaniza izin veren
analizlere sahiptir. Spatial Analyst ile kullanici mesafe, yogunluk analizleri
gerceklestirebilir, interpolasyon vyapabilir ve c¢akistirma analizleri

gerceklestirebilmektedir.
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ArcGIS 10’dan itibaren 3D Analyst'te oldugu gibi Spatial Analystte’de
kullanicilar Phyton kullanarak analizleri hizh bir bicimde

gerceklestirebilmektedirler.

Sekil 17: ArcGIS Desktop Spatial Analyst Modiili ile gergeklestirilmis

mekansal analizler

ArcGIS Network Analyst

ArcGIS Network Analyst, yol aglarinin gercgekgi bir bicimde modellenmesini ve
bu modeller {izerinde glizergah analizleri gerceklestiriimesini saglamaktadir.
En kisa yol, en yakin hizmetin bulunmasi maliyet analizleri ve filo yonetimi
gibi tim ag analizleri bu moddl ile gergeklestirilebilmektedir.

ArcGIS 10’dan itibaren 3  boyutta da glzergah  analizleri

gerceklestirilebilmektedir.
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MNew Route

Mew Service Area
MNew Closest Fadlity
Mew 00 Cost Matrix
Mew Vehicle Routing Problem %
lew Location-Allocation e -

Options...

Sekil 18: ArcGIS Desktop Network Analyst Modiilii ile gerceklestirilmis rota analizleri

ArcGIS Geostatistical Analyst

ArcGIS Geostatistical Analyst modill, sirekli verilerin analiz edilmesi ve
haritalanmasina yonelik istatistiksel metodlar saglamaktadir. Belirli
noktalardan alinmis degerlerden yilizey olusturma araglar ile kullanici,
deterministik ve jeoistatistiksel yontemleri kullanarak en dogru yizeyi

kolaylikla elde edebilmektedir.
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Ganstaabesl Analvat =| Q|

Explore Data » '[E Histogram
1 =

@l Geostatsticl Wirard, .. Bl Morma Qoeiot
8 Subset Features... @ Trend aralysis
y

o - | B vororai Map

(7] Geostatsocal ansiyst e B} semvariogram Covanancs Cioud
Bl General Q0Fiot

| @ Cresscovariance Cioud

Sekil 19: ArcGIS Desktop Geostatistical Analyst Modiili ile gergeklestirilmis
ylzey analizleri

ArcGIS Tracking Analyst

ArcGIS Tracking Analyst, zaman icerisinde degisim goOsteren veya yer
degistiren objelerin haritalanmasinda kullanilmaktadir. Tracking Analyst ile
gecmis ve gelecege dair zamsansal analizler gercgeklestirilebilmekte ve bu

degisimler animasyon haline getirilebilmektedir.

Tracking Analyst =|| + G | o5

2l Animation Tool

‘ . Data-Ch;ck »

| Settings...

Sekil 19: ArcGIS Desktop Tracking Analyst Moddli ile gergeklestirilmis animasyonlar
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ArcGIS igin ArcScan

ArcScan, 1 bit veya 8 bitlik taranmis gorintileri vektor tabanli katmanlara
donistlrebilmeniz icin araglar saglarken ayni zamanda calistiginiz
gorintiinin raster hicrelerini se¢menize ve glincellemenize olanak

tanimaktadir.

| Raster | 77| wectorizazon = W |5 4 | & | Raster Ceanun = | CellSelecion = 08

i
I

| SE—— S

Sekil 20: ArcScan Modiilii ile haritanin otomatik olarak sayisallastiriimasi

ArcGIS Schematics

ArcGIS Schematics modiilli, ArcGIS yazilimi lGzerinde olusturulan ag yapilarini
kullanarak, genis alanlar lizerindeki sebekelerin tek hat ve prensip semalarini
olusturmak igin kullaniimaktadir. ArcGIS Schematics, ArcGIS drinleri ile
kurulmus olan elektrik,telekom, su, kanalizasyon ve dogalgaz gibi altyapi
uygulamalarinin yaninda lineer olan herhangi bir ag yapisi lizerinde de

kullanilabilmektedir.
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Sekil 21: ArcGIS Desktop Schematics Modiili ile olusturulmus otobiis hatlari
semalari

ArcGIS icin Maplex

Maplex modild, ileri diizey kartografik etiketlendirme igin hizli ve pratik
¢6zimler sunmaktadir. Maplex, yazi ve etiketler arasinda c¢ikabilecek
cakismalari ¢ozerken, oOteleme, yigma, otomatik vyazi tipi kigilltme,
egiklestirme ve kisaltma isimlerinin kullaniimasi ile etiketlerin en uygun
yerlerine yerlesmesini sagmaktadir. Yiksek kalitede kartografik sunumlar

elde etmek igin Maplex mutlaka kullaniimalidir.
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Use Maplex Label Engine

: Options...

]

3730
&

Sekil 22: Maplex Modiili ile otomatik harita etiketlendirmesi

ArcGIS Data Interoperability
Data Interoperability modiilii, yaygin olarak kullanilan 150’den fazla formatin
ArcGIS formatina dénisiimini saglamaktadir. Bu modiliin ana 6zelligi, her
bir CBS veri formatini direk erisilebilir veri kaynagi olarak ekleyebilmesidir.
Ayni zamanda, ArcGIS kullanicilari verilerini 80’den fazla desteklenen veri
formatina export edebilmektedirler.
ArcGIS Data Interoperability modili, ESRI ve Safe Software isbirligi ile
yapilandiriimistir.  Yazihm Safe Software’in popiler FME Urini Uzerine
kurulmustur.
ArcGIS Data Interoperability Modlu ile kullanicilar;

e Standart FME formatlarini dogrudan okuyabileceklerdir (TAB, MIF,

E0O, GML,..vs).
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e FME destekli veri tabanlarina baglanabilecek ve bu veri tabani
baglantilarindan okuyabileceklerdir (MySQL, PostGlIS gibi).

e FME birlesik veri kaynaklarini tanimlayabilir ve bu kaynaklardan
okuyabilirler.

e Veri tabani yonetim sistemlerinden shape dosyalarina 6znitelik
bilgilerini birlestirebilirler.

e Her feature class’t FME'nin destekledigi veri formatlarina export
edebilirler.

e ArcGlIS destekli verileri her FME formath veya destekli veri tabanina
yiklemek, islemek ve export etmek icin geoprocessing yapisi icindeki

FME ortamini kullanabilirler.

ArcGIS Server

ArcGIS Server yazihmi kullaniclya, web (izerinden masalisti ve mobil
uygulamalari desteklemek icin, CBS servislerini olusturma, yonetme ve
paylasma kabiliyeti kazandirmaktadir. ArcGIS Server, gerek CBS uzmanlari
icin, gerekse daha once hicbir CBS tecribesi olmamis ¢alisanlar igin, cografi
bilgiye erisimi kolaylastirmaktadir. ArcGIS Server, uydu gorintilerini de
iceren mekansal verinin merkezi olarak yonetiminde, cografi verilerin
kontrollini saglamaktadir.

ArcGIS Desktop gibi, ArcGIS Server da 6lgeklendirilebilir bir mimariye sahiptir.
ister kiigiik bir grubu yénetmek igin, ister biyiik bir kurumda, kurum ici ve disi
yonetimi saglamak ve cografi veri paylasimi yapmak icin ArcGIS Server farkli

Urtnler sunmaktadir.
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Hangi ArcGIS Server Urlninin sizin igin uygun oldugunu asagidaki matrise

bakarak belirleyebilirsiniz.

Geodatabase Yonetimi J/ J/ ¢,/

Replikasyon ¢/ J// J/
CBS Web Servisleri pi J/ ¢//
Geodata

Servisi
Web Mapping Uygulamalan J// ¢/
Web'den glincelleme yapma imkani J/ ¢//
Geoprocessing J/' J/
Ileri diizey Geoprocessing M““I'I‘:”” ¢
ArcGIS Mobile Uygulamalar / Yazilim Gelistime Kiti (SDK) ¢/’

Sekil 25: ArcGIS Server fonksiyon matrisi

Cok kullanicili bir ortamda cografi verinin yénetilmesi isi ArcGIS ve iliskisel
Veri Tabani Yonetim Sistemleri (IVTYS) arasinda paylasilmaktadir. IVTYS,
tablolarda bilgiyi tutmayi ve yonetmeyi saglamaktadir. ArcGIS’de cografi veri
tabanlari IVTYS'nin gliclint kullanmaktadir; bu da kullanicinin tercih ettigi bir
IVTYS'de verileri depolama, yonetme, sorgulama ve paylasma esnekligi

saglamaktadir. Asagida ArcGIS genel mimarisi gériinmektedir.
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ArcGIS Engine

ArcGiS Uygulamalar:

Masadsti

ArcGIS Server

Yoneticisi Server|Object Manager
(ArcCatalog)

SmartPhone
ArcGIS Mobile

Web Tarayici

J

\
PDA

Arcinfo
.

ArcEditor
ArcView
ArcGIS Engine
ArcGIS Explorer
Web Tarayici

J;sza

ArcSDE Sunucusu

vTYS

Java, .NET
Uygulamalari

Sekil 26: ArcGIS Mimarisi

ArcSDE Teknolojisi

ArcGIS 9.2 versiyonundan dnce, ArcSDE ayri bir Griin olarak satilirken, 9.2’den

itibaren ArcGIS Desktop ve ArcGIS Server platformlarina entegre edilmistir.

ArcSDE teknolojisi CBS kullanicilari  ve

IVTYS arasinda gegit gorevi

yapmaktadir. Bu sayede IVTYS icerisindeki veriye erisilmesini ve verinin

yonetilmesini kolaylastirmaktadir. ArcSDE asagidaki tim IVTYS paketlerini

desteklemektedir;

e DB2
e Informix
e Oracle

e Oracle with Spatial
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e Postgre SQL
e SQL Server ve SQL Server Express

ArcSDE Yetenekleri

e liskisel Veri Tabanlari Yonetim Sistemlerine acik bir arayiiz saglar.

e Cok kullanicili ortamda glincelleme yapilmasina ve geodatabase
onarimi yapilmasina olanak tanir.

e Mekansal sorgulamalar ve detay davranislarini optimize eden yiiksek
performansli bir uygulama sunucusu saglar.

e Veri lizerinde tarihsel olarak arsiv yapma imkani verir.

ArcGIS Engine

ArcGIS Engine,COM,.Net, Java, C++ ortamlarinda APl (Application
Programming Interface)’ler kullanilarak geleneksel (masaistii ve mobil)
uygulamalari gelistimek icin kullaniimaktadir.

ArcGIS Engine;

e  CBS tabanh uygulamalari hizh bir bicimde yapilandirmak igin

e Grafiksel detaylari gizmek ve olusturmak igin

e Cografi islemler gerceklestirmek icin (tampon bdlge, kesisim
noktalarinin bulunmasi gibi)

e 3 boyutlu verinin goriinttilenmesi ve analiz edilmesi i¢in

e Kod galerine erisim ve bu kodlari kullanmak icin gelistirilmistir.

ArcGIS Engine asagidaki platformlari desteklemektedir.;

o  Microsoft Windows Server 2003 and 2008
e  Microsoft Windows Vista, XP, and 2000

e Red Hat (Enterprise Linux) AS/ES

e SUSE Linux Enterprise Server

e Sun Solaris

ArcGIS Engine asagidaki Urlinleri icermektedir;

54



e ArcGIS Engine Developer Kit for the Microsoft .NET Framework

e ArcGlIS Engine Developer Kit for the Java Platform

e ArcGlIS Engine Developer Kit for Cross-Platform C++

e ArcGIS Engine Developer Kit for COM (Visual Basic 6 and Visual C++)

e ArcGIS Engine Runtime

ArcGIS Engine Developer’s Kit

ArcGIS Engine Developer’s Kit, kullanici uygulamalarinin yapilandiriimasina
yonelik, gelistirici bir kit olarak kullanilmaktadir. Bu kit, kullanici
uygulamalarinin igerisine CBS fonksiyonlarini iceren gelistirme ortamina,
kullanici  araylzii kontrollerini, aletleri ve vyazihm kitiphanelerini
eklemektedir. Ozetle Engine Developer’s Kit;

o Kontroller
e Arag cubuklari ve araglar
e Yazilim kitlphanelerinden olusmaktadir.

Kontroller: Kullanicinin ekledigi ve uygulamalarinda kullandig ArcGIS’in
kullanici araylzi unsurlaridir.

Ara¢ cubuklar : Kullanici uygulamalarinda haritalar ve cografi bilgi ile
etkilesimli “Pan”, “Zoom”, “Identify” ve “Selection” araglarini icermektedir.

EICRr-TH IR XY

Yazihm Kiitiiphaneleri : ArcObjects kitlphanesidir. Bu kitliphane ayni
zamanda ArcGIS Desktop ve ArcGIS Server ile de kullanilabilmektedir.

ArcGIS Engine Runtime

Uygulama gelistiricilerin ArcGIS Engien Developer’s Kit ile yazdiklari
uygulamalari calistirmak icin gereken kitiphaneler grubudur.
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Sekil 27: ArcGIS Engine uygulamasi 6rnegi

ArcGIS ve Endiistriyel Standartlar
Cografi bilginin web {izerinden hizla yayilabilmesi ve binlerce uygulama ve

servise entegre edilebilmesi lzerine CBS acgik bir kavram haline gelmistir.

ArcGIS kullanicilarinin farkli platformlarla uyumlu calisabilmeleri agisindan,

bircok standardi desteklemektedir.

ArcGIS IT ve GIS standartlari ile askeri standartlari da desteklemektedir.

Web : SOAP, XML, REST, JavaScript, KML, Virtual Earth
0GC : GML, WFS, WMS, WCS (Daha fazla bilgi icin;

www.opengeospatial.org )

Enterprise Integration : SOAP, XML, EJB, SQL

Application Content : CAD, Image, PDF
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ArcGIS 10 Uygulamalari

Uygulama 1 : ArcMap’e Giris
1. Baslat> Tim Programlar > ArcGIS 10 > ArcMap 10 (zerine gift

tiklayiniz.

%  ArcMap 10

ArcMap arayuizi acildiginda karsiniza ilk olarak asagidaki pencere

cikacaktir.
IQ ArcMap - Getting Started
Harita cikti CErT
islemlerine
hazir bir _ _ _ L Q Q e
sablonu sadece - | e
okunabilir :
olarak = |
goriintlilemek :
yadayenibir |l .. o |
sablon : : "
olusturmak igin | Doemtse iedgunue e, |
kullanilir. : '
I Bu bolimde kullanicinin daha
: once Uzerinde calismis oldugu
' harita dokimanlari
ArcGIS 10’dan itibaren program ile listelenmektedir. Kullanici
olusturulan tim objelerin belirlenen dilerse buradan &nceki harita
dizinde saklanmasi icin bir default dékiimanlarini agip, Gzerinde

geodatabase olusturulmustur.

calismaya baslayabilir.

2. Bu pencereyi Open butonuna basarak kapatiniz.

Getting Started penceresi

karsilasacaksiniz.

kapandiktan sonra ArcMap arayizi

ile
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O vaed ol i e

Main Menu = — :,Hu g A S e e

- are— an ]

StandardToolbar a - 5

n
Tools Toolbar = — =

“ |

Table of Contents Data View/Layout View
ekrani

3. File menislniln altindan Open’a veya Standard Toolbardaki Open

£ ikonuna tiklayiniz. ArcGIS10_Egitim/Uygulama_01 dosyasinda
yer alan Uygulama_01.mxd’yi aginiz.

Proje dosyasi (.mxd) icerisinde yer alan veriler; Dinya ulkeleri,
Tirkiye il sinirlari, Tlrkiye Demiryollari ve Yerlesimler katmanlaridir.

ArcMap’te Semboloji Degistirme ;

4. ArcMap ortaminda Table of Contents menisinde yer alan
katmanlarin renk ve semboloji degisikliklerini yapmak icin; Table of
Contents’de yer alan Ulkeler katmaninin poligon semboli (zerinde
mouse’in sag butonuna tiklayiniz.
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Table Of Contents rx
88|
= = Layers
= Yerlesim
@
= Demiryola

= Turkiye
]

Ulkeler
e

No Color

Mare Colors...

5. Renk paletinden dilediginiz rengi seginiz. Ulkeler katmanina ait olan
tim objelerin sectiginiz rengi aldigini goreceksiniz. Ayni islemi diger
katmanlar icin de uygulayabilirsiniz.

6. Semboloji degisikligi icin; Table of Contents menisiinde yer alan
Demiryolu katmaninin gizgi sembolii izerinde mouse’in sol butonuna

Symbol Selector @
Ty . [»] @ @ 882 [ CurentSymbal
Search: (® All Styles (O Referenced Styles
ESRI [
—_— e —
Hghnsy  Highuay Ramp  Expressnsy CE M
width: 170 [2]
Expressway  Major Road  Arterial Street Edit Symbal....
Ramp
_ _ —_
Collector Street  Residential Railroad
Street
River Boundary, Boundary,
— e e

7. Agilan Symbol Selector penceresindeki RailRoad sembolilinl secip
rengini kirmizi, kalinhgini da 6 olarak ayarlayiniz ve OK butonuna
tiklayiniz.
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Expressway Major Road  Arterial Street
Ramp
—_ —_ ——
Collector Street  Residential Railroad

Sireet

Symbol Selector E]]
T v Q g 28~ [ Curent Symbol
Se.a.r;h: @ all Styles (@] Ré‘f;;ncad Styles
ESRI [
—_— . - =
Highway Highwiay Ramp  Expressway

Edit Symbal...

8. Table of Contents mendisiinde yer alan Yerlesim katmaninin nokta
sembolii Gzerinde de mouse’in sol tusuna tiklayiniz.
9. Agilan Symbol Selector penceresindeki Search kutusuna

monument yazip enter’a basiniz.

location

Symbol Selector

Search: (®) all Styles

Survey

A

Location
Monument

v| @ @ 85 -

(O Referenced Styles

10. Location Monument semboliinii secip OK butonuna tiklayiniz.

60



Tools Toolbar Fonksiyonlar ile Calisma;

Full Extent Go to Next
|
|
: Fixed Select HTML Go to XY
Zoom [ 700m 1 Fleamentc I Find

R Y TN e
I

' |
I . | . [
Pan | Selection | . Find | viewer
. I I
Zoom Fixed | Identify, Measure :
ZoomiIn
Hyperlink Time Slider
Go Back to
Previous

Bu uygulamada Tools Toolbar’daki fonksiyonlar kullanilarak bir tlke
bulunacaktir.

11. Full Extent |"3 aracina tiklayiniz ve tiim verinin ekran sinirina
yerlesmesini saglayiniz.

12. Zoom In araclyla Asya kitasina yaklasiniz. Aradigimiz ilk Glke Asya
kitasinda bulunmaktadir.
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13. Bu Ulke 93°51' 14.4 " E ve 30° 17' 6" N koordinatlarina sahip olan
Ulkenin glineyindeki adalardan birisidir. Bu koordinatlara sahip olan

@
Ulkeyi bulmak icin Go to XY *Y aracina tiklayiniz.
14. Acgilan Go to XY penceresine yukarida belirtilen koordinatlari yazip
Enter’a basiniz.

GoToX¥ (Degrees Minutes Seconds) =
P8y e 80 =
Long: | 93°51'14.4°E Lat: | poc17emd

15. Daha sonra bu koordinatlarin glineyine Zoom In aracm| secerek
yeniden yaklasiniz.

16. Ulkenin adi ‘ezya’ harfleri ile son bulmaktadir. igerisinde ezya harfleri

bulunan (lkeleri goérintilemek igin Find B aracina tiklayiniz.
Asagidaki ayarlari yapiniz ve Find butonuna tiklayiniz.
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B Find %]
_Ea-tEI Locations | Linear -Reférencing | Find

Find: | gzya Iv]

In: I“@‘ Ulkeler _'_j New Search

Find features that are similar to or contain the search string

Search:
(O all fields
(33 In field:

|uike_apr_ v

Cancel

Find butonuna tikladiktan sonra asagida 2 adet (lke listelenecektir.
(Endonezya ve Malezya)

17. Aradigimiz Ulkenin nifusu 19.626.380, para tipi ise Ringgit'tir. Bu
ozellikleri gorintilemek igin o©ncelikle Endonezya (izerinde sag
tiklayiniz ve Zoom to secenegine tiklayiniz.

‘8- Flash
@l Zoom To
Right-click a row gﬂl Pan To
Walue |:|!| Create Bookmark
Endonezya :
Identify...
Malezva 0 z fy
bl select
[ 1 imcalart

18. Daha sonra identify aracini se¢iniz ve Endonezya tzerinde tekrar

tiklayiniz. Agilan Identify penceresindeki niiflis ve para tipi kayitlarini
kontrol ediniz.
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Bu kontrol

Identify

Identify from:

= Ulkeler
b

&}

Location:

115.028323 -2.186231 Dedir

=

Field

FID

Shape
OBIECTID
LILKE_KoDU
LULKE_ADI
MNUFUS
PARA_TIFI
SHAPE_AREA
SHAPE_LEM
LILKE_ADI_

Value

103
Palygon
104

jin]
Indonesia
189331200
Rupiah
154, 237587
54.566265
Endonezya

sonrasinda

karsilamadigini géreceksiniz.

Endonezyanin

aradigimiz  kriterleri

19. Identify penceresinin yerini degistirirken ekranda c¢ikan oklarin

Uzerine getirerek araylize yerlesmesini saglayabilirsiniz.

Bu sayede

T

identify penceresinin  kullanilmadigi durumlarda saklanmasini
saglamis olursunuz.
B |
'3 I" T\,H b -l‘ - =i
T @ b T =
£ adh R == 1 B
I,/‘&l:ﬁ: o N ‘J\‘ g
s : .
0
7o W '_____ " £ |
—ORacSisade 2N
g
o o e B
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20. Identify araciyla bu sefer Malezya (zerine tiklayiniz ve identify
penceresinden verilen kriterlere uygun olup olmadigini kontrol

ediniz.

Kontrol sonucunda aradigimiz Glkenin Malezya oldugu anlasilacaktir.
21. Bu asamada Malezya’'nin fotografi eklenecektir. Bunun i¢in Identify
penceresindeki MY adi Uzerinde sag tiklayiniz ve Add Hyperlink’i

seginiz.

Identify

= Ulkeler
MY

Location:

Field
FID

Identify from:

| X

<Top-most layer =

-o- Flash
'f{ Zoom To
& panTa

Pl Select

[ Unselect

Add Hyperlink...

|

BoeEn "-"—I

22. Agllan pencerede D butonuna tiklayiniz. Eklemek istedigimiz resim
ArcGIS10_EGITIM > Uygulama_01 > Hyperlink dizinin igerisindeki
Malezya.jpg dosyasidir. Dosyay! sec¢ip Open aracina daha sonra OK

butonuna tiklayiniz.

Add Hyperlink

(#) Link to a Documert

() Link to a URL

CHARCGIST0_EGITIM ygulama_01"Hyped E]

23. Bu islemden sonra Tools Toolbardaki Hyperlink araci # aktif hale
gelecektir. Hyperlink aracina tikladiktan sonra Malezya Uizerine tekrar

tiklayiniz. Resmin ekranda agildigini goreceksiniz.
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Endonezya

Q0 =20 | PP | au | XsHE

=

Resmi kapatiniz.

24. istenilen bir web sitesini ekran lzerinde tiklandiginda gériintilemek
icinse HTML Popup fonksiyonu kullanilmaktadir. Bunun igin Table of
Contents’de bulunan Ulkeler katmaninda sag tiklayiniz ve Properties

secenegine tiklayiniz.
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= ¢ Ulkel
|

)

50
Ll

Copy

Remave

Open Atiribute Table

Juins and Relates

Zoom To Layer

Visible Scale Range

Use Symbal Levels

Selection

Label Features

Edit Features

Convert Labels to Annotation...
Convert Features to Graphics...

Convert Symbology to Representation. ..

Data

Save Az Layer File,..

Create Layer Package...

Properties...

25. Acilan Layer Properties penceresinde HTML Popup sekmesine
tiklayiniz ve ayarlari asagidaki sekildeki gibi yapiniz ve OK butonuna

tiklayiniz.

].a'yer Properties

| Genem\_ ‘|-5uurce; ::"SE‘ECUDF; iE-D\splay | Symbulugy.i‘ Fields -!: Definition Query | Labels";: ;JDiI'IS & Re\des.i‘ Ti 7| HTML Fopup

Display HTML formatting

() As & table of the visible fields

@ asaUrL
Prefie | http:/jtr.wikipedia.org fwiki]

Show content for this layer using the HTML Popup tool

Field: | LULKE_ADL_

!vl Suffix;

() as 5 formatted page based on an X5L template

Display coded value descriptions in all HTML content
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26. Daha sonra Tools Toolbar'daki HTML Popup aracina tiklayip,
Malezya Uzerine tekrar tiklayiniz. Web sitesinin  acildigini
goreceksiniz.

Acllan pencereyi kapatiniz.

27. Malezya’ya bir sonraki uygulamada tekrar geri donmek igin, su anda
ekranda olan goérintiyl  Bookmark olarak kaydetmemiz
gerekmektedir. Bunun icin Main Menu’deki Bookmarks mendsinin
altindan Create secenegine tiklayiniz.

File Edit View | Bookmarks | Insert Selection (Geoprocessing Customize Windows Help

Fli Manage...

28. Agllan Bookmark penceresinde Bookmark 1 yazan yere Malezya yazip
OK butonuna tiklayiniz.

Spatial Bookmark

Bookmark Name: |Malezyz|

[ QK ]l Cancel ]

29. ArcMap’i kaydetmeden kapatiniz.
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Uygulama 2 : ArcMap’te Raster Verilerin Goriintiilenmesi ;

Raster Veri hicrelere bagh olarak temsil edilen verilerdir. En kiguk
birim piksel olarak tanimlanmaktadir. Raster verilerde verinin hassasiyeti
piksel boyutuna gore degisen c¢Ozlnlrlik (resolution) ozelligi ile
tanimlanmaktadir.

Bu uygulamada, Tirkiye ve komsularini iceren 1km hassasiyette
Uretilmis olan Sayisal Yukseklik Modelinin (DEM) siniflandiriimasi ve Tarkiye il
vektorel katmanina transparanhk o6zelligi katilarak verilerin birbirleri ile
etkilesimli olarak goriintiilenmesi saglanacaktir.

1. Baslat > Tium Programlar > ArcGIS > ArcMap10’u aginiz.

2. ArcGIS10_EGITIM/Uygulama_02 dosyasinin igerisinde vyer alan
Uygulama_02.mxd’yi aginiz.
Table of Contents’de Turkiye, Turkiye_dem ve Turkiye_hill katmanlari
bulunmaktadir. Ancak sadece Turkiye hill katmaninin c¢eki atili
oldugu icin bu katman Data View penceresinde goriintilenmektedir.
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Table Of Contents ﬂ x

= Vektorel Katman
38| g
=I = Layers P - -
= O Turkive =~ .. .
2 O turkiye dem — — — —|—= — = Raster Katman; DEM (Digital Elevation
o s Model- Sayisal Yiikseklik Modeli ) :
IL ; GRID formatindaki bu tir veriler VAT
aw oL
2 @ turkive_hil (Value Attribute Table) dosyasinda x,y
He 52\ koordinatlari ve yikseklik bilgilerini
IL ; \\ icermektedir.
oaw oL
\
\

Raster Katman; Hillshade (Kabartma Haritasi ) : Kabartma
haritalari DEM’den olusturulmakta ve sadece arazi
topografyasini temsil etmesi icin kullaniimaktadir. Yukseklik
bilgisi icermez

3. Table of Contents’de bulunan Turkiye_dem katmaninin cekini atarak
gorintilenmesini saglayiniz.

|Q thveilama 63 s - drestan - hreinin
P ——

4. Table of Contents’de bulunan Turkiye_dem katmani (zerinde
mouse’in sag tusuna tiklayiniz ve Properties secenegine tiklayiniz.
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Table Of Contents n X
E RSN A
= = Layers
® O Turidye
i G

@ Copy

Remove

Open Attribute Table

Joins and Relates [

G4 Zaom To Layer

Low : | &l Zoom To Raster Resolution

visble Scale Range »

Data 3
Edit Features b
4| Save As Layer File...
fp/| CreateLayer Package...
[ Properties... |

Acillan Layer Properties penceresinde Symbology sekmesini
tiklayiniz.

Color ramp menisinden dilediginiz bir renk araligini segip, Display
Background Value kutusunun cekini atiniz ve as menisinden
yikseklik degeri sifir olan yerler (denizler) icin mavi rengini seginiz.

Apply butonuna basiniz. Tirkiye_dem katmani yukseklik degerlerine
gore renklendirilmis oldu. Turkiye_hill katmaninin da yukseklik
haritasi altinda topografyayl gostermesi icin Turkiye_dem’e seffaflik
vermek gerekmektedir.
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Layer Properties

%]

Show:
Unique Values
Classified

|stretch values along a
|

| General | Source | Extent || Display | Symbology |_F\elj || Joins & HelaesI

Discrete Color

A

Color Value  Label Labeling
5552 [high: 5552 |
I |
0 |Low:o |
et [
Display Background Value: i 1} 7| L
[ Use hillshade effect Zi[1 Display NoData as [ Mo Caler |
Stretch [T JC TR AL AT T TATCED
Type: |Standard Deviations M Hi nOBEO0CODODEEEE
22 Dmert OEEEOCEER u
: nvert
— . IEREOEINEEEEN
[ apply Gamma Stretch: | 1] FEEEEEEEEEEN

FEEENEEEEEEN
EEEEOCODEEEEN

(x JC

EREOOCOCOCOEEE N

8. Katmana transparanlk vermek icin Display

More Colors...

sekmesine tiklayiniz.

Transparency kutusuna 50 rakamini giriniz. Bu islem, katmanin %50

seffaf olmasini saglayacaktir.

General | Source | Eent | Display llSymbology | Fields | Joins & Relates |

[[]shaw Map Tips (uses primary display field)
[ oisplay raster resalution in table of contents
[ allow interactive display for Effects toolbar
Resample during display using:

[Nearest Neighbor (for discrete data)

[«

Crthorectification

Contrast:

0%
[ LE - — D [
i IR

e el
Display Quality

Coarse Medium

Elevation adjustment
Z factor: "
Normal

Z offset: [

OK.

] [ Cancel

J [

Apply

9. OK butonuna basip yaptiginiz degisikleri inceleyiniz.
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Haritaya BaseMap Eklenmesi;

Haritalar olustururken kullanicinin amaci, yiksek performansh ve
yuksek kalitede kartografik sunumlar elde etmektir. ESRI'nin sundugu
Basemap haritalari bu tiir sunumlar elde etmenin en kolay yollarindan
birisidir.

1. Table of Contens menisindeki turkiye_dem ve turkiye_hill
katmanlarinin gekini kaldirip, turkiye katmaninin gekini atiniz.
2. Add Data menisiinden Add Basemap segenegine tiklayiniz.

b ||| 115214246

Add Data...

B2 add Basemap... |

BH! Add Data From ArcGIS Online. .

Acilan pencerede ESRI'nin sunmus oldugu ve haritalariniza altlik
olarak kullanabileceginiz Basemap haritalar listelenmektedir.
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Bing Maps Road Delorme
Imagery OpenStrestMap Physical
>
v
%
L o
‘-
Terrain Topographic JSA Topo Maps
[»]

3. Listeden Bing Maps Aerial althgini secip Add butonuna tiklayiniz.
4. Ankara’ya Zoom in araC|er yaklasiniz. Microsoft’un sunmus
oldugu Bing Maps haritalarini lcretsiz olarak haritanizin altinda

gorintileyebileceginizi gormektesiniz.
5. ArcMap’i kaydetmeden kapatiniz.
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Uygulama 3: Vektor Veri Tipleri (Shapefile, Coverages, Feature
Class ve CAD);

Vektor veri, noktalara (x,y) bagh olarak temsil edilen verilerdir.
Konuma ait verilerin, nokta, ¢izgi ve alan 6zellikleri x,y koordinat degerleriyle
depolanmaktadir. Nokta 6zelligi, tek bir x,y koordinat cifti ile temsil edilmekte
(Elektrik direkleri, kuyu noktalari, yangin musluklari gibi); ¢izgi 6zelligi,bir
baslangic ve bir bitis noktasi olan x,y koordinat dizisi ile temsil
edilmekte(dere, yol, elektrik hatlari gibi); alan 6zelligi ise, baslangi¢ ve bitis
noktasi ayni olan x,y koordinatlar dizisi ile temsil edilmektedir (parsel, bina,
arazi kullanimi gibi).

Vektorel veriler igin iki temel depolama yontemi vardir: Spagetti ve
Topolojik veri modelleri

Spagetti Veri Depolama Yoéntemi;

Spagetti veri depolama yonteminde, nokta, cizgi ve alan tiriindeki
vektor veriler, temsil ettikleri detayi olusturan nokta ya da noktalar kiimesi
seklinde detayl tanimlayan tek anlamli bir kod (detay kodu) ve detay tiri
(nokta, cizgi, alan) ile birlikte depolanir. Ayni ya da farkh detaylarin ¢akismasi
ya da komsu olmasi durumlarinda ortak kenar ve/veya noktalar her detay
tekrarlanarak depolanir.
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Topolojik Veri Depolama Yontemi;

Topolojik veri depolama yonteminde, detaylar arasindaki komsuluk,
yon, cakisma,baglanti gibi mekansal iliskiler tanimlanir. Ayrica komsu, kesisen
ve cakisan detaylarin ortak nokta ve kenarlari bir kez daha depolanarak,
spagetti yonteminde karsilasilan binme, bosluk, kopukluk tasma gibi gibi
geometrik hatalar elemine edilmis olur.

ESRI vektér formatlari (Coverage, Shapefile ve Feature Class)
topolojik veri modellerine birer 6rnektir.

Bu uygulamada, vektorel verilerin gorintileme o6zellikleri (Layer
Properties ve Data Frame Properties) ve harita ¢ikti islemleri
gerceklestirilecektir.

1. ArcGIS10_EGITIM/Uygulama_03 doyasinda yer alan
Uygulama_03.mxd’yi ArcMap 10’da ac¢iniz.

Table of Contents’de Ankara koyler, Turkiye il merkez, Tirkiye demir
yollari, Tirkiye nehir, Tiirkiye otoyollar, Tirkiye goller ve Turkiye il
vektorel katmanlarinin oldugunu goéreceksiniz. Ayni zamanda Bir
onceki uygulamada bahsedilen Tirkiye Hillshade (kabartma) ve
Tarkiye DEM (yukseklik modeli) raster verileri de yer almaktadir. Bu
katmanlar Gizerinde Layer Properties penceresi kullanilarak degisikler
yapilacak ve harita ¢iktiya hazirlanacaktir.

Katman Ozellikleri Penceresi;

Uygulama_03.mxd icerisinde Table of Contents’de bulunan vektor ve
raster verilere ait katman 0Ozellikleri (Layer Properties) penceresi
bulunmaktadir. Bu pencerede verinin Raster veya Vektor veri olmasina
gore degisen sekmeler gelmektedir. Asagidaki ekran kopyasinda
gorindlgi sekilde bir vektor verinin katman o6zelliklerinden General,
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Source, Selection, Display, Symbology, Fields, Definition Query, Labels,
Joins&Relates, Time*,HTML Popup secenekleri ayarlanabilir. Raster
verilerin katman o6zelliklerinde ise Selection, Label ve Definition Query
secenekleri veri yapisinin vektér veriden farkh olmasindan dolayi
bulunmamaktadir.

2. ilk olarak Table of Contents’de bulunan katmanlarin katman isimleri
degistirilecektir. Bunun icin Table of Contents’de bulunan herbir
katman lzerinde mouse’un sag tusuna tiklayarak Layer Properties
secenegine geliniz. General sekmesinde bulunan Layer Name ile
katman adini degistiriniz. Degisiklikleri asagidaki gibi yapiniz;

e Turkiye_AnkKoy Ankara Koyler

e Turkiye_ilMerkez Tirkiye il Merkezleri
e Turkiye_Demiryolu Demiryolu

e Turkiye_Nehir Nehir

e Turkiye_Otoyol Otoyol

e Turkiye_ Gol Gol

e Turkiye il il Sinirlari

e Turkiye_Dem Yikseklik Kusaklari

e  Turkiye_hill Tirkiye Kabartma
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Table Of Contents X, ‘
ool O 2 K
b addData...
g{@ Mew Group Layer
é@ Mew Basemap Layer
= Turkive_ilMerkez \\ @ Copy
* \ E
=] Turkiye_Demiryalu \ u=5
= Turkiye_Mehir \\
o \
= Turkive_Otoyol \ Turn All Layers Off
- Select All Layers
= Turkiye_Gal
O = 4
=] Turkiye_il = Colapse Al Layers
. Reference Scal 3
= turkive_dem eference Scale
SUTHT Copy Advanced Drawing Options...
High
2§ Remove Labeling 3
Law E Open Attribute Table
Joins and Relates 3 3
<@ 1 i
g turkjye_'@ Zoom To Layer 3 Convert Features to Graphics. ..
Walu E
High @ Zoom To Raster Resolution Activate
Visible Scale Range 3 -
Low |Ef‘ Properties... |
Data 3
Edit Features [~ -
| Data Frame Properties ‘
< Save AsLaver Fils... 2 B 2
&y’ Create Layer Package... | Festurs Cache || Annotation G“?“P-’:_._n r?“e."_'?..'!'!‘?'.‘.ca‘m.. Freme || Size .E”d_.P.?ﬁ'[‘.‘m "
L | General | Data Frame | Coordinate System | llumination |  Grids |
||':‘r Properties. ..
| Laver Properties '

|| | General | Source | Selection || Display || Symbology | Fields || Defintion Guery | Labels | Joins & Relates || Time || HTML iinpup;—|

3. Yiikseklik Kusaklari katmaninin katman oOzelliklerinde Display
sekmesine geliniz. Burada katmana ait gorintileme ozelliklerini
dizenleyebilirsiniz. DEM katmaninin ylkseklik kusaklarina ait
semboloji ile kabarti haritasinin birlikte gorsellik kazanmasi icin Table
of Contents’de Ustte bulunan Yikseklik Kusaklari katmaninin
Transparent kismini %50 olarak ayarlayiniz.
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Layer Properties

| General || Source || Extet ymbology || Fields | Joins & Relates |

[ Show Map Tips {uses primary display field)

[ risplay raster resolution in table of contents

[ allows interactive display for Effects toolbar

Resample during display using:

[ Nearest eigtbor ffor discre e datal) .-;'-

Qrthaorectification

Contrast: RS

Brightness: 0%

— oy

Transparency: 50| | % 1 ]{9‘;. _J =

— e o o o o o =
= Elevation adjustment
Display Quality

Coarse Mediurm Mormal

a

QK ]l Cancel ]l Apply ]

4. Display’in hemen yaninda bulunan Symbology sekmesini tiklayiniz.

Burada Yiikselik Kusaklarinin renk araligini degistiriniz. Color Ramp
secenegini tiklayarak renk tanimlamasi yapiniz (13. Sirada bulunan
renk araligi). Display Background Value ozelligine ait tiki atiniz ve
kutucuk icinde 0 yazdigindan emin olunuz, baska bir deger yaziyorsa
O(sifir) yaziniz ve ‘as’ secenegini mavi deger olarak belirleyiniz. Bu
ayarlamalar ile DEM haritasinda ylkselik degeri 0 olan
yerleri(denizler 0 kotundadir) mavi renkte gdstermektesiniz. OK'i
tiklayiniz.
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tz_iyer 'E’Iroperﬁe:s x
\"éeneml_ii Source i|l-5d:rrt_||_D|spI i_aE‘i_JUins &_ﬁeTai:s.i
Shaw: ia&zh values along a color ramp
Unique Values
Classified
Stretched &
Discrete Colar
Color Value Label
3552 | High: 5552 |
0 | Low : 0 F
G -_—
——— -\
| [#] Display Background Value: | 0| as@ 1
[ use hilshade effect I 1 Display NoData as. | 1 Mo Color ]
e e — — L S T
Type: ‘Standard Deviations |i] B EOOCOOO Bﬂ H H
e Oe: CNEECEEE anm
- _ DlllDDll“f::Cretean[
[ apply Gamma Stretch: | EEEEER
FEEENNEEEEEN
EEENNODDODEEEMN
EEECO0C0ONEENE
(NNEECCEENNNN
AENEESEEEENEEN
More Colors,.,

5. Go6l katmaninin semboliini degistirmek igin ona ait sembol Uzerinde
mouse’un sol tusuna basiniz. Karsiniza acilan Symbol Selector
penceresinden “Lake” semboliini secerek OK'e tiklayiniz.

= -
= M Turkiye_Gol Symbol Selector
O
= Bl Torkye il
O s | v @ @
N
= turkive_dem, || Search: () all Styles () Referenced Styleg
Value » g
iah : N
] High : 5552 S
] N
Low : 0 .
= turkiye_hil Gresn\ Blue Sun
Value N
High : 254 N N
Low : 0 i
Hollow Lake Rose

6. Demiryolu katmaninin semboliini de ayni sekilde altindaki sembole
tiklayarak degistiriniz. Fakat bu sefer acgillan Symbol Selector
penceresinde yukarida bulunan arama bosluguna (Type here to
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search) “Railroad” yazarak klavyenizden Enter’a tiklayiniz. Sembol
penceresinde isminde railroad bulunan tim semboller ekrana
gelecektir. Pencereyi asaglya dogru kaydirarak ESRI semboloji
kGtlphanesi altinda bulunan railroad sembolini seginiz ve OK'e
tiklayiniz.

- -
= e _Demiryolu Symbol Selector
= Tulki‘,‘Qahu' w| @ g 22 . | Current Symhal
= Tlllki‘r‘E_OtD}d\ Search: (2 all styles (O Referenced Styles
— N .
ESRI ~
= Turkiye_Gol N ml
= A
= Turkiye_il g— _— E
O N\ ;
= turkiye_dem Highwat,  Highway Ramp  Expressway Color: E]
Value N\
High : 5552 N\ Width: 4.00 =
o ~— - 3]
Low @0 A -
Expressway Major Road\  Arterial Street Edit Symbal...
Ramp \
I".Ialue _ _ O —
High : 254 :
Collector Street  Residential Railroad
Low: 0 cheet
River Boundary, Boundary,
MNational State Style References...

Nehir katmaninin da ayni sekilde sembolini tiklayarak Symbol
Selector penceresindeki “River” sembollini seciniz. Eger River
semboliini ilk actiginiz ekranda géremiyorsaniz arama kutucugundan
aratarak bulabilirsiniz.

il sinirlan katmaninin semboliinii degistirmek istiyoruz fakat bu
degisikligi Il isimlerine gére yapmak istiyoruz. Bunun igin il Sinirlan
katmani lizerinde sag tiklayarak Properties’i seciniz.

Acilan Layer Properties penceresinde Symbology sekmesini seginiz
ve Categories altinda bulunan Unique Values fonksiyonunu tiklayiniz.
Value Field olarak il sinirlari katmaninin dznitelik tablosunda bulunan
ADI degerini seginiz.
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C3
= M Turkive_iMerkez
*

= Turkiye_Demiryolu S

Layer Properties

Sourcs | Selection || Disp

Symbology | §

ul.Defiotien Qe L shple, |, Joips & aiatee | Tine,

HTML Popup |

Value
High : 254

Low:0

—+ |~ |Draw categones Using Unique values of one field
S W Turkiye_Nehir feslioes s Color R
Calegories Value Field —— (~Color Ramp = -
e Urique values (a1 [ v
= Turkiye_Otoyal Uniaue valuss, many | [SEIEETID 271]
- Mateh to symbels in 3|[-| 1L - ——
5 Bl Turkye_Gol 2 [ |VeaLesiuko bbel Count [~
S — other values> 0
= b [Taridye Multiple Attributes Shage',\ma L o
o I ANA 1
& B e em [ JADIYAMAN ADIYAMAN 1
= [AFYON 1
High 1 5552 e | —__JAKsARAY 1
- E3 5 1
Low: 0 = !
L 1
1 |
= E turkiye il % 1 ]|

[ ok

] [ cancal ] [

Apply J

Adina gore sembolojiyi kategorize etmek icin Add All Values butonuna
tiklayiniz. Boylece secilen renk araligina gore tim degerler ayri ayri

kategorize edilmis olarak ekrana gelecektir. Apply butonuna tiklayiniz.

9. il sinirlan
sekmesini

ayarlayiniz.

katmaninin Layer Properties penceresinde Display

tiklayiniz ve Transparent kismindan %50 seffaflik

“Show MapTips using the display expression” seceneginin yanindaki
kutucuga tik atiniz ve hemen Ustindeki Field fonksiyonuna ADI

degerini getiriniz. Apply butonuna tiklayiniz.
ArcGIS 10 verisonundan itibaren birden fazla 6znitelik degerine gore,
MapTips 6zelligi Expression yazilarak eklenebilmektedir.

Layer Properties

General | Source || Selectior
[¥]5cale symbols when aTeference scale is set
— e = =

ymbology | Fisids | Definion Query || Labels | Joins & Relates || Time | HTML Popup |

|l Expression...

-
Transparent: 50 (%
ooy e

Field: L

st} Map| OBJECTID_1

K| ogzecTm

viarlhks 1

I_;| o

Support HEgE

Shape_Length
Shape_Arez
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10.

11.

12,

13.

il sinirlan katmaninda Labels sekmesine tiklayiniz. Bu islem ile, il
sinirlari alan katmani (zerine Oznitelik tablosundaki degerler
yazdirilabilecektir. Bu etiketlendirme islemini yapabilmek icin Labels
sekmesinde Label features in this layer ifadesinin yanindaki kutuya
tik atiniz. Text String fonksiyonunda etiketlendirmeyi hangi 6znitelik
degerine goére yapmak istediginizi belirleyebilirsiniz. il isimlerini
katman Uzerine etiketlendirme yapmak icin Label Field olarak ADI
field’ini seginiz.

. Layer Properties '

General || Source || Selection | Display | Symbology || Fislds | Definition Gus| cins & Relates | Time | HTML Popup

Method Label &ll the festures the same way. v

All features will be labeled using the options specifisd

Text String

Label Figld: OBJECTID_1 [se] Expression...
OBJECTID_1
Text Symbal OBJECTID
IL —1
YERLESIMKO 2
AafEH !
Shape_Length Symbal....
Shape _Area
Other Options Pre-defined Label Style
Placement Properties... J l Scale Range... J [ Label Styles.. J
[ 0K I [ Cancel ] [ Apply I

Etiketin katman Gzerindeki sembol durusunu degistirmek icin Symbol
aracina tiklayiniz ve istediginiz bir Text semboliini sectikten sonra OK
butonuna tiklayiniz.

Yaptiginiz degisiklikler ekranda goérintilenmektedir. Tools arag
¢ubugunda bulunan Zoom In ve Zoom Out araclarini kullanarak
degisiklikleri inceleyiniz. Show MapTips fonksiyonu ile Labels
arasindaki farklari incelemek icin mouse il sinirlari Gizerinde bir yerde
sabit tutunuz.

Tim degisiklikler ile birlikte ¢alistiginiz projeyi File > Save As ile
C:/ArcGIS10_EGITIM/Uygulama03/Uygulama03_1.mxd olarak
kaydediniz. ArcMap’i kapatiniz.
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Joins & Relates & Symbology;
Adim 1 : Joins

1. ArcMap10’da bos bir proje sayfasi aginiz.

8  ArcMap 10

2. < AddData...

aracini tiklayarak C:/ArcGIS10_EGITIM

/Uygulama03/Turkiye.mdb personal geodatabase iginde bulunan
Turkiye_il polygon feature class’i, Turkiye_Nufus2000, Turkiye_Saglik,
Turkiye_Secim95 tablolarini klavyeden CTRL tusuna basili haldeyken

¢oklu olarak seginiz. Add butonuna tiklayarak ekleyiniz.

Add Data
G

Lookin: | (3 Turkiye.mdb o] & B B | - (&8 B

==| Ankara_Secimas IEITurkjye_Otovol
“Turkive_Ankkoy  EEIT
Surkive_Demiryoly  ESH
@Turkjve_Gol

B Turkiye_il
‘-__'lTurkj‘.-’e_lll'ﬂerkez
ETLurkjye_Nehir

= |Turkive_Mufus2000
E=| Turkive_Olum

Name: Turkiye_il; Turkive_Mufus2000; Turkiye_Saglik; Turkive_Se

Show of tyPe! | Datasets and Layers IV; [ Caricel ]

3. Grafiksel olmayan tablo verileriyle birlikte katmanlar eklendiginde
Table of Contents’deki menii secenegi “List By Drawing Order :”

dan “List By Source 73 otomatik olarak degisir. Bunun nedeni,
sembolojisini degistirebilecegimiz grafiksel verilerle beraber sadece

Oznitelik degerleri olan tablolarin da ArcMap’e eklenebilmesidir.
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Table Of Contents o x

IR =

=l =/ Layers
= L8 CrARCGIS10_EGITIMUyg
= Turkiye_il
[
B Turkiye_Mufus2000
B Turkiye_saglik
B Turkiye_sedmas

4. Tools ara¢ cubugundaki Identify i) araciyla Turkiye_il katmanindan
Eskisehir’i tiklayiniz. Identify penceresinde Turkiye_il 6znitelik
tablosunda Eskisehir'in bulundugu veritabani bilgilerini Identify
Result penceresine getirmektedir. Identify penceresinin mavi bashgi
Gzerinde mouse’a basili haldeyken ekran (zerinde bir vyere
tasltyabilirsiniz. Diger pencere arayizleri gibi Identify’da otomatik
olarak araylze yerlestirilebilir ve gerektiginde saklanabilmektedir.

S |

]

5. Tiirkiye_il katmaninin veritabaninda ADI, YERLESIMKO, IL vs. bilgiler
bulunmaktadir. Ayni sekilde Nufiis2000 tablosu lzerinde sag
tiklayarak 6znitelik tablosunu aginiz.
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Table Of Contents

= = Layers

2 L3 C:\ArcGIS10_EGITIMUyaul,

= B Turkiye_il
=

= =
B2 Turkive_Sa E LEET

B2 Turkive_Se
x

Joins and Relates 3
Remove

Data 3
Edit Features 3

Geocode Addresses...
Display Route Events. ..
Display XY Data ...

Properties...

6. 2000 yilina ait nifus tablosu asagidaki gibidir. Bu tablo igerisinde IL,
ILADI, NUFUS_2000 ve YERLESIMKOD fieldlari bulunmaktadir.
Turkiye_il katmanininda 6znitelik tablosunu aginiz. Turkiye_il tablosu

ile Nufus2000 tablolarini Join ile birlestirmek icin ortak bir field’a

ihtiyacimiz vardir.

Y Table
HEL BT RS i :
‘..mvf_luﬂa:\?i?% u-l$‘|%§§

ousctios | L |
0

721 I O S

2 I Y I |

Turkiye_il katmani 6znitelik tablosuna Turkiye_Nufus2000 tablosunu join
etmek igin kullanilacak ortak field YERLESIMKOD situnudur. Degerleri
kontrol ettigimiz zaman ayni illerin ayni yerlesimkod degerine sahip olduklari

gorulecektir.

86



7. Turkiye_il katmani Gizerinde mouse ile sag tiklayarak Layer Properties
penceresini aginiz. Joins&Relates sekmesini tiklayiniz. Joins kisminda
Add butonuna tiklayiniz.

General | Source | Selection || Display | Symbology || Fields || Defintion Guery || Labels | Joins & Relates | Time | HTML Popup

o Join Data E]
Lists the data that has been appended to this
table's/layer's attribute table,

Join lets you append additional data to this layer's attribute table so vou can,
‘add for example, symbolize the layer's features using this data.
What do you want to join to this layer?

| Join attributes from a table v-
Properties: i 1. Choose the field in this layer that the join will be based on:

YERLESIMKO [l
2. Choose the table to join to this layer, or load the table from disk:

| Turkive_Hufus2000 ﬂ

Show the attribute tables of layers in this list

3. Choose the field in the table to base the join on:

Join Options
(=) Keep all records

All records in the target table are shown in the resulting tsble.
Unmatched records will contain null values for all fields being
appended into the target table from the join table.

(O Keep only matching records

If arecord in the target table doesn't have a match in the join
table, that record is removed from the resulting target table,

\alidate Join
About Joining Data

Acilan pencerede ayarlari Ustteki gibi yapiniz ve Validate Join
butonuna tiklayiniz. ArcGIS 10 ile gelen bu 6zellik ile, Join islemini
yapmadan o6nce ortak fieldlarin eslesme durumunu, veritabanlarini
kolaylikla kontrol edebilirisiniz. Verilerin eslestiginden emin olduktan
sonra OK butonuna tiklayiniz.
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Join Validation

Validation Task
w Check for field names that start with an invalid character
¥ Check for field names that contain invalid characters
+++ Check for field names that match reserved words
#»+ Check for non-geodatabase MS Access tsbles
+++ Counting the number of matching records for the join

*# Join Validation =]

All field and datasource validation tasks were completed successfully.

The number of matching records for the join:
Join validation will check for common errors when creating a join.

- 81 of 81 records matched by joining [YERLESIMKO] from <Turkive_il> with
[YERLESIMKOD] from <Turkiye_Nufus2000>,

Matching records may not appear in table view due to join validation errors.

Cancel

Close

8. Nufus2000 tablosu Turkiye_il katmanina gegici olarak eklenmistir.

Ayni sekilde Turkiye_Secim95 ve Turkiye_Saglik tablolarini da join ile
ekleyiniz.

Joins

Lists the data that has been appended to this
table'slayer's attribute table.

Turkiye_Secim35

Turkive Saglik
Turkiye Mufus2000

Add...

Remove Al

Layer Properties ekraninda OK butonuna tiklayiniz. Identify araciyla
yeniden Eskisehir ilinin Gzerine gelip tiklayiniz. Saklanan pencere
olarak ayarladiginiz Identify penceresi ekranin saginda tekrar

actlacaktir. Identify Result penceresinde daha ¢ok kaydin eklenmis
olarak geldigini géreceksiniz.
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Q) Uinthtied - Arcéag - drcinda

Wew Bosrets fert Sekcwn  Gegrscmeng Cubear  Wndew  Pep

Adim 2 : Symbology

1. Table of Contents’de 2000 yilina ait nifus verileri 1995 yilina ait
secim verileri ve saglik verileri eklendikten sonra meni goriintisiini
tekrar List By Drawing Order olarak degistiriniz. Bunun igin Table of

Contents’de - simgesini tiklayiniz.

2. Turkiye_il katmaninda bulunan illerin hepsi su anda tek bir sembol ile
gosterilmektedir. Join ile eklenilen Niifus 2000 degerine gore tematik
harita olusturmak icin katman lizerinde sag tiklayip Layer Properties
penceresini aginiz. Symbology sekmesini seginiz.

3. Sayisal oznitelik degerlerine gore tematik harita olusturmak igin
Quantities’i tiklayiniz ve Graduated Colors 6zelligini seginiz. Value
Field olarak NUFUS_2000 6zniteligini seginiz.
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‘Layer Properties

(7 %]

| Genersl | Source | Seieation || Disp\ayl Symbology IIelds || Dfinition Query || Labels || Joins & Reiates | Tme | HTML Popup|

Show:
Feat Draw quantities using color to show values. Import
Calegories ( Figlds = == [~ Classffication
( Quamiitions == =" e FiTFIE 2080 l Matural Brezks (Jerks)
- Gradugted colors —
T b n T~~~ LT e ]
+ Proportional symbols
Dot lensity Color Ramp: |k
Charts
Muttiple Attributes Symbol | Range Label
3584 - 656903 53584 - 656503
556504 - 1443422
2541 1443473 - 2327341
007860 2327942 - 40078ED
7861 - 10018725 4007861 - 10018735

Show class ranges using feature valuss

[ ok [ cance J[ 0o |

4. il sinirlari 2000 yili niifusuna goére belirtilen renk araliginda 5 sinifta

dereceli

olarak

renklendirilmistir.

(istege gore

Classification

ozelliginden sinif sayisini arttirabilir veya azaltabilirsiniz). Range ve

Label seceneklerinde ise mouse ile tikladiginiz zaman bu deger

araliklari iginde istediginiz sekilde degisiklik yapabilirsiniz. Label

béliminde yapilacak degisiklik haritanizi ¢iktiya hazirlarken(layout)

Lejant olarak gosterilecegi igin harita ¢iktisi gorselligi agisindan

asagidaki gibi ayarlayiniz.

1nnn
Ul
BN
U

Color Ramp: | _I:I
Symbal | Range Labe
93584 - 100000 0 - 100000
1000071 - 500000 1000071 - 500000
I 500001 - 1000000 500001 - 1000000

L ENinn
Ul | - U

r|r|-| .I--nnnnnn
Ul ] - [ AUuuaUd

ENinn

-Innnnn
= SUJUUJY

(L

P Py,
5 1-1
5000001 - 12000000

5. OK’e tiklayiniz. Turkiye Nifus Dagilim haritasi olusturulmustur.
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Tabsie Of Contents

= & layers

Insert
- .. . |=| DataFrame
Insert menisiinden Data Frame segenegini

6.
tiklayiniz.  Veritabanina join edilmis sekilde veriler Turkiye_il
katmaninda bulundugundan dolayi bu katman zerinde sag tiklayarak
Copy butonunu seciniz ve yeni olusturdugunuz New Data Frame
Uzerinde sag tiklayarak Paste Layer’a tiklayiniz.
= =F Layers || é ”

Add Data...

Remave Mew Group Layer
Open Attribute Table

Mew Basemap Layer
Joins and Relates 3

Copy

Zoom To Layer

mm & O &

Paste Layer(s)

Yeni veri cercevesine kopyalanan Turkiye il katmaninda Kisi basina
diisen Hekim sayisi tematik olarak gosterilecektir. Bunun igin katman
Uzerinde sag tiklayarak Layer Properties’i ac¢iniz ve Symbology
sekmesini seginiz.
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Layer Properties [B%]

| General || Source || Sslection | Disp\a}'.l Symbalogy |_Fialds || Definition Query | Labels | Joins & Relates | Time | HTML Popup |

Show
F ‘Dlaw quantities using color to show values. Import...
Categories ’-F\el?s =1 = =\ Classffication

Quantities 1| vale HEKIM > Natural Breaks (lenks)
Gradusted colors

" et qymbels }| Nomaiization: [NUFUS_2000 [v]) | Cesses
! —_—— -

—— - ——
-~ Proportional symbals

Dot density Color Ramp:
Charts
Multiple Attributes Symbol | Range Label
0.000184033 - 0 53 0.0001840 - 0.0003793
7566 0.0003754 - 0.0006076
95 0.0006077 - 0.0008353
28 0.0008354 - 0.001389
BL1L 0.001350 - 0.002715
i [ Show class ranges using feature valuss

oK [ Cancel ][ ooy |

8. Quantites > Graduated Colors 6zelligini seginiz. Value Field olarak
HEKIM Ozniteligini, Normalization olarak da NUFUS_2000 6zniteligini
ayarlayiniz. OK’i tiklayiniz. Boylelikle Niifusa goére Hekim sayisini
gosteren ilk tematik haritanizi elde etmis olacaksiniz.

Tatie Of Cortents T ®
Eocsia
5 et
B Turwre
LFLS 3000

100001840 - 0.0003793
[ 0.0003794 - 8.500807
0,000 2008153
00008354 - 0.00L389
1 0.003380 - 0.00371%

Farkli Data Frame’ler lizerinde g¢alismak, ayni ¢ikti sayfasinda birden
fazla harita olusturmaya yardimci olur. Baska ¢alisma alani lizerinde
calismak istendigi zaman baska bir ArcMap araylzi agmak yerine
Data Frame’ler eklenerek tek ArcMap arayiizii Gizerinde birden fazla
harita gorintilemesi yapilabilir. Data Frame’ler arasi gecis Active
butonu ile saglanir. Hangi veri cercevesi Data View ekraninda
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gorintilenmek isteniyorsa o Data Frame

Activate segilir.

Gzerinde sag tiklanarak

Table Of Contents ax
88
g &3
j'\b Add Data...
= ur|
bd New Group Layer
] %}i Mew Basemap Layer
[}
= E copy
] % Paste Layer(s)
M X Remove
= = New D|
= Tur| Turn All Layers Off
Select All Layers
i
=y
| =& Collapse All Layers
ey Reference Scale r
[ [
Advanced Drawing Options...
Labeling 3
8g| Convert Features to Graphics...
Activate
(| Properties...

9. Aktif yaptiginiz Data Frame Uzerinde sag tiklayarak Properties’i

secerek Data Frame Properties penceresini aciniz. General sekmesini

seciniz ve Name kismina “Niifus” yaziniz. OK’i tiklamadan 6nce veri

cercevesi olarak hangi 6zelliklerin bulundugunu inceleyiniz. Ornegin,

Nifus veri cercevesi Decimal Degrees biriminde gorintilenmektedir.

OK'’e tiklayiniz.
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Table Of Contents X
@ {\} @ lg Data Frame Properties @
EE= | o Annctation Groups | Bdent Indicatars | Frame || Size and Posttion |
= | AddData... General Data Frame Coordinate System llumination Grds
0 g?ﬂ Mew Group Layer ifusl
o %Q Mew Basemap Layer Description:
OE copy
1=
=
®  Remove Credits:
E = New 1
Units
e Turn All Layers Off
Map:
i Select All Layers
Display: | Decimal Degrees |vj
[ -+ Tip:  See Customize > ArcMap Options > Data View tsb for
[ additional options for displaying coordinates in the status
i = | Collapse All Layers bar
R Reference Scle ' Reference scale: | <Hare> [~
Advanced Drawing Options. .. s 1
Labeling 0 Label Engine: [zsm1 standard Label Engine [
Simulate layer transparency in legends
“ag| Convert Features to Graphics...
Activate
. [ OK I [ Cancel ] [ Apply ]
||'i‘r Properties...

10. Ayni sekilde New Data Frame Uzerinde sag tiklayarak Properties’i
seginiz ve General sekmesinden Name kismina “Saghk” yaziniz. OK’i

tiklayiniz. Saghk veri cergevesi Uzerinde sag tiklayarak Activate

seciniz. Boylece Saglik veri gercevesi aktif olur ve bu veri ¢ergevesi

altinda bulunan

goruntilenir.

harita veya

haritalar

Data View ekraninda
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= .
—_“ e ‘:';) Add Data. .. Data Frame Properties

{;'5 MNew Group Layer e 25 Annatation Groups Extent Indicators Frame Size and Posttion
El o tz} e 2 Diata Frame Coordinate System lllumination Grids
3 HEW Dasemap Layer
(] —
mmo| B Cony —
- Description:
0
MO % Remove
Credits:

Turn All Layers Off

Select Al Layers Units
Map:

Display: |Decimal Degrees ~

- Collapse All Layers Tip:  See Customize > ArcMap Options > Data View tab for

additional options for displaying coordinates in the status

Reference Scale 3 s
Advanced Draning Options... Reference Seale: <Nane> "
Labeling ; Rotation: 1}

Label Engine: ESRI Standard Label Engine v

s ConvertFeatures to Graphics. .. [] simulate layer transparency in legends

Activate

||'iAr Properties... [ OK H Cancel ][ Apply ]

11

Insert > Data Frame secerek “New Data Frame 2” adinda yeni bir veri
cercevesi ekleyiniz. Yukaridaki Nifus ve Saglik veri cercevelerinden
herhangi birinde bulunan Turkiye_il katmani New Data Frame 2’ye
kopyalayip vyapistiriniz. (ipucu: Bu islem Saglik veri cercevesini
olusturmak icin yapilmisti.)

12. Kopyalanan Turkiye_il katmani lzerinde sag tiklayarak Propeties’i

seciniz. Acilan Layer Properties penceresinde Symbology sekmesinde
Charts > Pie kismina tiklayiniz. Field Selection kisminda Turkiye il
katmani o6znitelik fieldlari goriintlilenmektedir. Burada sececeginiz
partileri “>” simgesini tiklayarak sagindaki kutucuga taslyiniz. Béylece
secilen partilerin oy dagilimlari Pasta Dilimi semboliiyle ekranda
gorlntulenecektir.
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Layer Properties =}
} General || Source || Selection || Display [l Symbology WFelds | Definition Query ” Labels “ Joins & Relates H Time || HTML Popup |
Shaw:

Feat I[)law pie chart for each feature. Import.
Categories Field Selection
Quantities YERLESIMKD |:l — ak Symbol | Field
Charts SECSAYI I -
Cr ™ KULDY BANAP
\ ) GECOY — JoYp 1
i YOF 3 DsP
Stacked MP i' CHP 1
Multiple Atributes | | IF K — | —
HADER o) liss) | PP
£ | L>J [
Background: Color Scheme: . |i| ' |v
Prevent chart overlap
=i=i=
[ Properties. ] I Exclusion... l I Size ] '
pp——
[ ok J[ cace ][ oy |

13. Ayni ekranda Size butonuna tiklayiniz. Tim pasta dilimi sembolleri
ayni boyutta (32pt) gorintiilenmektedir. Fakat segmen sayisina gore

bu sembollerin de buyilklGgini degistirmek icin Vary Size using a
field olarak SECSAY field’ini seginiz. OK’i tiklayiniz.

Pie Chart Size

Wanation Type
O Fixed size

@ Vary size using a field:

(O Vary size using the sum of the figld valuss

nomalized by; | none

Symbal

L |

Min Value

Appearance
Compensation (Flanneny)

Max Value

[Properties...] [ Exclusion ]

] [ Cancel ]
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14. Layer Properties ekraninda OK'i tiklayiniz. Bu veri ¢ergevesinin adini

“Secim” olarak degistiriniz. (ipucu: Niifus ve Saglik veri cergevelerinin

adlarini degistirmek igin yapilmisti.)

15. Insert > Data Frame secerek “New Data Frame 3” adinda yeni bir veri

¢ergevesi olusturunuz. Turkiye_il katmanini tekrar bu veri ¢ercevesine

kopyalayip yapistiriniz. Yapistirdiginiz  Turkiye_il

Properties penceresini agcarak Symbology sekmesini tiklayiniz.

katmanin Layer

16. Quantities > Graduated symbols kismini seginiz. Nifusa goére degisen

semboller ile tematik gosterim igin bu secim yapilmistir. Value Field
olarak NUFUS_2000 6zniteligini seciniz. OK'i tiklayiniz.

Layer Properties
| General | Source | Selestion | Disolay | Symboloay | Fielcs | Definition Query | Labels | Joins & Felates | Time | HTNL Fopup
Show =
Féal. "| Draw quantities using symbol size to show relative values.
Categories Figlds Classffication
Quantities Value |fiTiFE 2600 | Natural Breaks {Jenks)
Ggu calgs r T
Tmpﬁlmrars‘,‘rmo!:
Dot density Symbol Size from: |4 to: |18
Charts x Template
Multiple Attributes Symbol | Range Label =
Background
oK ] [ cancel ] [__ Apply

I

17. New Data Frame 3 olan veri gergevesinin adini “Nifus2” olarak

degistiriniz.
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.-)-; 6L - 10018738

Table of Contents’de 4 farkl veri gercevesi ve 4 farkh harita
olusturulmustur. Bu haritalar bir sonraki uygulamada ¢iktiya(Layosut)
hazirlanacaktir.

18. File > Save As tiklayarak projeyi C:/ArcGIS10_EGITIM/
Uygulama04/Layout.mxd olarak kaydediniz. ArcMap’i kapatiniz.
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Uygulama 4 : Haritalarin Kartografik Uretimi, Cikti(Layout);

Bu uygulamada, bir dnceki uygulamada 4 farkli veri cergevesinde hazirlamis
oldugunuz haritalardan, Cografi Bilgi Sistemlerinin genel islevleri arasinda
bulunan g¢iktiya hazirlama fonksiyonu uygulamasi yapilacaktir. Data View
ekraninda hazirlanan haritalarin, tanimlanan semboloji ve etiket bilgileriyle
birlikte 6lcek degerlerine gore c¢iktiya hazirlanmasi ve kagit haritalar seklinde
cikti olarak kullanilmasi islemine Layout denilmektedir. ArcGIS’de bu islem
icin Layout View ekrani kullaniimaktadir.

1. Baslat > Tiim programlar > ArcGIS > ArcMap 10 tiklayiniz ve bir
dnceki uygulamada hazirladiginiz Layout.mxd projesini aciniz. (ipucu:
C:/ArcGIS10_EGITIM/Uygulama04/Layout.mxd kaydedilmisti.)

2. Llayout.mxd 4 farkli veri c¢ergevesinde olusturulmus haritalar
icermektedir. Sembolojilerini degistirdigimiz bu haritalari Data View
ekraninda  veri ¢ergevelerini  aktif ederek teker teker
gorintileyebilmekteyiz. Ciktiya hazirlamak igin kullanacagimiz ekran
olan Layout View ekranina gegmek icin meniilerden View > Layout
View secenegine tiklayiniz. Ya da kisayol olarak ArcMap arayiiziiniin
altindaki Data View ve Layout View ekranlari arasinda gegisi saglayan

simgelerden Layout View aracina tiklayiniz.

IIII | I E .I' .'.I | |

Data View E g||_la'.|_-|:||_|‘|: '('TEL'

Q Layout View

3. Acilan sayfada, olusturulan tim veri cergeveleri icinde bulunan
haritalar ekranda Ust Uste gelirler. Haritalarin, ¢iktiya hazirlamak
istedigimiz sekilde sayfa boyutu icine sigdirilmasi gerekmektedir.
Bunun icin 6nce sayfa ve printer ayarlari yapiimalidir. File > Page and
Print Setup’i seciniz. Agillan pencerede Use Printer Page Settings
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secenegine ait tiki

kaldiriniz ve hangi sayfa boyutunda ¢ikti

hazirlanilmasi isteniyorsa ona ait ayarlamari yapiniz. Orientation
secenegini Landscape yaparak sayfanin yatay durmasini saglayiniz.

OK'’e tiklayiniz.

-

New... Cirl+M
Open... Ctrl+0
Save Ctrl+5
Save As...

Save A Copy...
Add Data 3

Sign In...

ArcGIS Online. ..

Page and Print Setup

&

Page and Print Setup. .. |

& & B0 BB

s

Print Preview. ..

Print. ..

Create Map Package...

Export Map...

Map Document Properties...

1 C:\ArcGIS 10_EGITIM., .. \Layout.mxd
2 D:\CBS_teknik'proje_ipek.mxd

3 C:\ArcGIS10_, .. \Wygulama_03.mxd

4 C:\ARCGIS_E...\Uygulama_03.mxd

Exit Alt+F4

Printer Setup

Name: | & Microsoft ¥PS Document Writer 'v: Properties...

Status: Ready
Type: Micrasoft XPS Document Writer
\Where: XPSPort:
Comments:
Paper
Size: A4 v[ l:l Printer Paper
Source: | Automatically Select ‘Vf i} Printer Margins
Orientation: O Portrait (%) Landscape l:l Haptace oo taraut)
Map El ts
————————— R
ﬂap Page Size \ '{',
2 = W 2
I D Use Printer Paper Settings I w“?.
Page - .
! dard I - e
Standard Sizes: a4 v x
I = : Al =
1 Width: 29.7 | Centimeters | I
1 Height: 21 |centimeters [s] 1 5
1 Orientation: (O Portrait (%) Landscape 1

N el

Data Driven Pages...

it uScaﬁMaLEleEHVDporhona\lv to changes in Page Size

4. Hangi veri ¢cergevesine ait harita lizerinde islem yapilmak isteniyorsa,

o cerceveyi (Lejant, olgek, baslik ekleme vs) Select Elements K ile
Uzerinde bir kez tiklayarak secili duruma getiriniz. Secili olan veri

cercevesi hangisi ise Table of Contents’de koyu renkli olacak sekilde
aktif olur. Nufus, Secim, Saglhk ve Nufus2 haritalarini sayfa icerisine

yerlestiriniz.
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_c ! LU D R Sy ——
5. Layout View’da secili olan veri cercevesi Table of Contents’de Koyu

harflerle belirtilen Segim’dir. Ciktiya eklenecek olan harita objeleri
(Kuzey Oku, Lejant, Olgek vb.) hangi veri cercevesindeki haritaya
eklenecekse sekildeki gibi secili olmalidir. Sekilde Secim veri ¢ergevesi
aktif durumdadir ve bu veri cercevesine ait ¢ikti objeleri eklenecektir.
Cikti islemi icin kullanilacak objeler (Kuzey Oku, Lejant, Olgek vb.)
Insert mendisinden eklenir. Bu menl c¢ikti objelerini eklemeyi
sagladigindan dolayl sadece Layout View ekraninda aktif olarak
kullanilmaktadir.

Insert > Title secginiz. Bu islem ¢iktiya hazirlanacak haritaya bashk
eklemeyi saglar.

Insert > North Arrow seciniz. Acgilan pencerede Kuzey oklarinin
bulundugu sembol kiitiphanesi gelir.Kullanmak istediginiz kuzey
okunu seciniz ve sonra veri cercevesi (zerinde uygun bir yere
yerlestiriniz. istege gore kuzey oku grafigi lizerinde Select Elements

K ile cift tiklayarak agi, yon gibi degisiklikler yapabilirsiniz.
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Horth Arrow Selector

A A

\

ESRI Noth

m

TSP

<

4] Yorth Arrow Properties E
: N L ow | Frame | Sae and Postion
[ Scdeto R e hoth Aow Stye...| | | [Chamcter Symbol._
Propetes..
[ =
T ==~ ||

Insert > Scale Bar segenegine tiklayiniz. Segili olan veri gergevenizin

Layout View ekraninda gorintilenen olgegine gore cizgisel
olusturacak sembolojiler ekrana gelmektedir.

Olcek
istediginiz cizgisel 6lcek

semboliinii seginiz. Olgegin birimi veri ¢ercevesinin birimi olarak gelecektir;

degistirmek icin Select Element k ile cift tiklayiniz ve Divisions Units
kismindan Kilometre olarak degistiriniz.

Scale Bar Selector

] Alternating Scale Bar Properties E]]

B

R N
Stepped Scals Line

Attemating Scale Bar 1

Atemating Scale Bar 2

100

o = 100 200 Mikes i
Scale Line 1

]
Scale Line 2

¢ = 00 200 Niles
Scale Line 3

Preview Scale and Units | Numbers and Marks || Format | Frame || Size and Position

Scale

Number of divigions: 2
Number of subdivisions: 2 [

[ show one division before zera

When resizing...

Adjust division value

Units

e e
st e I 1

SLERPOSTEN; = mm m—
o
Label: | Kilometers
Gap: L,"?\J:{C%

Cancel
ok | [ Concel | [ ooy
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Lejant eklemek icin Insert > Legend secenegine tiklayiniz. Acilan
pencerede lejant olarak hangi katmanlarin goérintilenmesini istediginizi
seciniz. Asagidaki sekildeki gibi ayarlamalar yapiniz ve Finish’i tiklayiniz.

Legend Wizard Logend Wizard _w.
- - - - —— -
i i P === == N
o Legend tams 1 I} Aglara
Turkiye_j —I Turicye_§ 5 \
'TJ ------ I I
1 - L —— 1
: I
= 1w . I
= I i @ | 1
St the mumber of cokrme i yourlegend. @ |2 1 4 53 3 py I
: I
) ;
= Sy 7/
(eee ) [[oae e ot || W
Legend Wizard ]
Legend Frame
Border
E
"% Agiklama
Sl Turkiye_il :IAMAP
M| secsayl [ Jove
Drop Shadow D DsP
=]
il o CJuwe
<Back J[__Met> ] [ cancel

Olusan lejant Uzerinde grafiksel bazli obje degisiklikleri yapmak icin lejant
Uzerinde sag tiklayarak Convert to Graphics fonksiyonunu seginiz. Daha
sonra Ungroup secenegiyle degisiklikler yapilabilmektedir.

7. Her bir veri cercevesi icin bu dizenlemeleri teker teker ayarlayiniz.
Haritalara temel ¢ikti objelerini tanimlayiniz.
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=YY |

Tirkiye Haritalar

19.97 4.16 Centimeters

Insert > Dynamic Text > Coordinate System secenegine yiklayiniz. Bu
islem veri cercevelerinin tanimlanan koordinat sistemini bilgi olarak
¢ikti sayfasina ekler. Uygulamada bulunan 4 veri gergevesinin de
koordinat sistemleri ayni oldugundan bir tane tanimlanmasi yeterli
olacaktir.

Insert > Dynamic Text > Author secenegine tiklayiniz. Bu islem ile
haritayir  hazirlayan  kisi veya kurumlari otomatik olarak
ekleyebilirsiniz.

Insert > Dynamic Text > Current Date secenegi ile de haritanin
hazirlandigi tarihi sayfaya ekleyiniz.
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AHaos i [ Gresmii] | o

; 3 i s 10 neasee... Curent Tme

Qll s & o = Loed. . ——— NJ Tiurkiye Haritalar

fill Morth Ao, At E
i & Sem B Scae ...

': | Scae Text.

- = 2l pevre..,

- il Object.
s =

o =

s 8

L2 =]

b =]

<] B

9. Haritanin ¢iktiya hazirligi tamamlandiktan sonra farkli formatlarda
kaydetmek icin File > Export Map secenegine tiklayiniz Layout.jpeg
dosyasi olarak Masalistiiniize kaydediniz. Olusturdugunuz projeyi
kaydederek kapatiniz.
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Uygulama 5 : Semboloji Kiitiiphanesi (Style);

ArcGIS Teknolojisi (ArcView,ArcEditor ve Arcinfo igin) kullanicilarina genis bir
semboloji kitlphanesi sunmaktadir.Semboloji kitliphanesi ArcGIS igerisinde
Style olarak adlandirilir. ArcMap arayiiziinde nokta, cizgi, tarama, renk, 6lcek
cubugu, kuzey oku, cerceveler, yazi tipleri gibi Ozellikler ve bu 6zellikleri
iceren c¢ok sayida farkli semboloji bir kltlphane icerisinde depolanir ve
ArcGIS teknolojisi sayesinde program icerisinde kullanimi saglanir .

Yeni bir semboloji kiitiiphanesi tanimlandiktan sonra ArcMap arayiziinde yer
alan araglar yardimi ile semboller olusturulur.Semboloji kiitiphanesi yardimi
ile yeni sembollerin olusturulmasi,sembollere verilen isimlerle, herhangi bir
katmanin veritabaninda yer alan belli 6znitelikleri eslestirilerek ,istenilen
Oznitelige gbre semboloji atanmasi islemi otomatik olarak gerceklestirilmis

olur.
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1. ArcGIS10_Egitim/Uygulama_05 dosyasinda yer alan
Uygulama_05.mxd’yi ArcMap arayizinde aginiz.

€ ArcMap 10

2. Menu Bar’dan Customize>Style Manager fonksiyonuna geciniz

Style Manager Penceresinden, sistemde halihazirda yer alan kitiphaneleri
gorebilir veya daha o©nceden kullanicilar tarafindan c¢esitli amaglarla
olusturulmus olan kiatiphaneler yardimiyla yeni bir kitliphane dosyasi
olusturabilirsiniz.Calistiginiz kurum ya da kurulusun kendine ait logo,sembol
veya tasarimlarini bu sekilde ArcGIS semboloji kitliiphanesine ekleyebilir ve
amaglar dogrultusunda kullanabilirsiniz.

- o
Style Manager @
-3 C:\Documents and Seftings'gtoreye| | Name Categary Tags I Close
- ESRlstyie = Highway Defauit GG
(&9 Reference Systems — Highway Ramp Diefault red;carographic
& Maplex Labels = Expressway Defat  mubimyeryelow | =
Shadows = i S 3
e Paiches Expressway Ramp  Default multilayeryelow
] Lins Paiches == Major Road Default black cartographic
&) Labels — Arterial Street Default black cartographic L
B3 Representation Markers — Collector Street Default black cartographic
Notth Arows — Residertial Sireet Defaul  black cartographic
Seals Bars —+ Railroad Default muttlayer:black
5 Legend ttems — River Default blue:cartographic
B Scale Texts &% Boundary. National Default mutilayer.gray
B3 Color Ramps == Boundary, State Default muttilayer:gray
] Borders = Boundary, County  Default multiiayergray
Backgrounds —- Boundary, City Default black:caographic
Colore — Boundary, Miitary ... Default black cartographic
& “tEdD"I“mD” Settings — Boundary. Neighb... Default black cartographic
Ff” S}mbo\s —- Boundary, Towns... Default red.cartographic
Line Symbals = Freeway Default multilayerned
Marksr Symbals S s
T Freeway Ramp Diefault muttilayerred
— s o= Fresway, Under O Defaut - i—
[E5 Representation Rules
] Hatches B Freeway, Proposed  Default mutilayerred
= Stacked Multi Ro.. Default muttilayerblue
— Stacked Muli Ro. Default mutilayerblue
(2 | [zl ] I |
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Style Manager

-3 C:\Documerts and Settings'atorsye | Name Category t:
= 5 ESRlstie J- ESRI Natth 1 Disfaut
; g ;:fe@”f:b?:‘em A ESI Nacth 2 Difaut
= Sh:dows A ESAINoith 3 Defautt =
4
- [E5] Area Patches '? :gg: :ort: i g:au:
-85 Line Patches Ill o = e
B Labels A ESAl North; Defaut —
-5 Representation Markers AP ESAI Notth 7 Defaut
- = N e 4 ESRI North 8 Defaut
B Scale Bars # ESRINoth 3 Defautt
Bl Legend kems } ESRINerth 10 Default
- [B Scale Texts } ESRINath 1 Defautt
- Color Ramps '“!"ESFH Morth 12 Default
[ Borders ~§~ ESRI Noith 12 Default
{8 Backgrounds & ESRI Notth 14 Defautt
-l Colors & E3RI North 15 Default
B8 Vectonization Settings - ESRI North 15 Defautt
-4 Fil Symbols HESRINoth 17 Defaut
-4 Line Symbols #ESRINoth 18 Defaut
: ’T”";r;’ 5‘;"“3”'5 HESRINoth 19 Defaut
=
- Ll @+ ESA North 20 Defaut
- Reprasentation Fules =
£ Hatches A\ ESRI North 21 Defautt
} ESRINotth 22 Defaut
} ESRINoith 22 Default
2 | []|| I ESRINoth24  Defaut ¥

Bu uygulamada, dncelikle Jeoloji.style dosyasinin Formasyon katmaninin veri

tabanindaki Agiklama field’ina gére otomatik olarak eslesmesi saglanacak,

daha sonra
gosterilecektir.

kullanicilarin

kendi

sembollerini

Customize | Windows _ticlp
Toolbars -1kl E TR A N P R

nasil

olusturacaklari

Extensions...

Add-In Manager...

Customize Mode. ..

Style Manager...

ArcMap Options. ..
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3. Style Manager Penceresinden Styles butonuna basiniz. Agilan Style

References penceresindeki Add Style to List secenegine tiklayiniz ve
daha 6nceden hazirlanan Uygulama_05/Style klasériinde yer alan

Jeoloji.style dosyasini seginiz ve OK butonuna tiklayiniz.

=

Style References E]

igtoreyen |
130 Basic [l
[]30 EBillboards

130 Buildings

130 Industrial

[130 Residential

[130 Street Fumiture

[130 Trees

130 Vehicles

[ 4rciGI5_Explarer

[ &cScene Basic

[ Business

122 Military Operations

[1C2 UEI Air Track

122 UEI Ground Track Equipmert

2 UEI Ground Track Installations ) |
[1C2 UEI Ground Track Units v]

[ Set as Default List... |

]
l\[ Add Stleto List.. | [ Creste New Style... |

[ QK I [ Cancel ]

4. Add Style to List isleminden sonra Style Manager penceresinde yer

alan Jeoloji.style kitiiphanesindeki Fill, Line ve Marker Symbol’leri

inceleyelim.
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§tyle Mﬁnagér

=] B3 C:\Documents and Settings gtoreye
#-{& ESRlstyle )
= [ C\ARCGIS10_EGITIM\Uygulama_

-] Reference Systems
[ Maplex Labels
‘.[F3 Shadows
‘-3 Area Patches

Mame
[ Reference Systems
[ Maple Labels
T shadows
[ Area Patches
ELine Patches

‘-] Line Patches ElLabels
[ Labels ET Representation M.
-7 Representation Markers @th Amows
B North Amows gSc:aIe Bars
[ Scale Bars [Legend tems
3 Legend ttems [ 5eale Texts
(3 Seale Texts i Color Ramps
-5 Color Ramps [ Borders
(7 Borders [ Backgrounds
-~ Backgrounds FColore
(£ Colors B Vectorization Setti..
= %;’_ﬁ&sf'j"'f_batiﬂseﬂ”gs EIFil Symbols
: ol e B Line Symbol
-3 Tne Tymbols R
£ [ Marker Symbols
i[5 Markcer Symbols =
£ Tt Symbol Tt Symbols
: e [ Representation R
i--F5] Represertation Rules = 3
[ Hatches I Hatches
(%l Im | [
5. Style Manager'daki Jeoloji.style kiitiphanesindeki Fill

Symbol

klasériini mouse ile seginiz.Sembollerin yer aldig alanda mouse’un

sag tusuna basarak New>Fill Symbol 6zelligini seginiz.

Style Manager

=]

& B ESRI style

®-E3 C\Documents and Settings'gtoreye l:‘ E
=63 CAARCGIS10_EGITIM\Uysulama_{ | apionan Mt Aywdiems
:--[5] Reference Systems Yelpazesi.y... anays. mig.
-] Maplex Labels
-5 Shadows E
[ Area Patches
+.-[] Line Patches Aynimamig EBazalt Bazalt, spilit
‘- Labels Kuvatemer
i--F7] Representation Markers
i3] North Amows ﬁ E
-] Scale Bas Karasal Fanntili FKannilil
£ rasal nntililar nrtililar ve
g ;Ziin'dl'e'i;:s lanntillar karbonatlar
:--E3 Color Ramps
i--E3 Borders D
[ Backgrounds Neritike Pelgjilc Piroklastilc
i--E3 Colors kiregtay kiregtag
i Vectorization Settings
- B3 Fill Symbols E
:-3 Line Symhols New
+--[E5 Marker Symbols Pircklastik sdfgvb
1. Text Symbole kayalar
:--F] Reprasentation Rulss
.- Hatches
i | [i\
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Ekranda agilan Symbol Property Editor penceresi size Jeoloji.style
kiitiphanesinde yeni bir tarama sembolojisi olusturmak icin imkan
tanirken ayni zamanda yine buradan, bilgisayar igerisindeki resim tipi
bitmap olan bir dosyayi Jeoloji.style kiitliphanesine eklemeyi de
saglamaktadir. Bilgisayarinizdan bir sembol eklemek icin yapmaniz
gereken; Type’i Picture Fill Symbol olarak ayarlayip,bilgisayar
icerisinden (C:\ArcGIS10_Egitim\Uygulama_05\Style\sembol.bmp)
ilgili resim dosyasini segmektir. Daha sonra Symbol Property
Editor'de resmin Uzerinde istenilen degisiklikler yapilabilir.
Bilgisayarinizdan bitmap resim dosyasini secip Open butonuna
basiniz ve daha sonra OK’e tiklayiniz.

Symbol Property Editor

Preview Properties

Type: | Picture Fill Symbol ™ Unite: | Points |

Picturs Fill | il Properties

Picture. ] CHARCGIS10_EGITIM\Uygulama_0545tyle sembol.bmp

Angle 0 =

Scale X 1003 Background Color:

1 Seale: |100(% Transparert Color [:]

6 @) o = -

Olusan semboliin adini Bazalt olarak ayarlayiniz. Bszt

Uygulamanin basinda ArcMap araylziinde, Style Kiitliphanesinden
yararlanarak otomatik olarak sembollerin eslestirilebileceginden
bahsetmistik. Bu islemin gercgeklesebilmesi icin Style dosyasindaki
sembollerin isimleri ile katmanin ilgili 6znitelik sttlniinda yazan
ifadeler birebir ayni olmahdir.
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8. Simdi de ESRl.style kitiiphanesinde tanimlanmis bir ¢izgi sembolii
olan Railroad’u secip mouse’'un sag tusuna basarak Copy
fonksiyonuyla kopyalayiniz. Style Manager'da Jeoloji Style
kGtlphanesine gecerek Line Symbol icerisine Paste fonksiyonu ile
yapistiriniz. Semboliin adini Demir Yolu olarak (rename) yeniden
adlandiriniz.

Style Manager
-5 C\Documents and Ssttings'gto[a| S
=8 ESRLstyle — — — == =

5] Reference Systems WiwE  Rgwayt  Eed |
Ramp =

[0 Maplex Labele
[ Shadows
[ Area Paiches
5 Line Patches
[ Labels =|| EBpmsoway  Major Road  Atenal Siret
[E3] Represantation Markers Ramp
1 Mot Arows
[ Seale Bars —
[ Legend tems
Colector  Resdertial  [REIG
g Eai ?ﬂ‘; Shreet Sireet
] Borders
[ Backgrounds =
5 Colers River Boundary,  Bound)
g Vectorization Settings Netioral Sratd
FLSTS —

(B —J | — . _

1 Marker Symbols

eon == Copy Cl+C

B3 Text Symbols Boundary, Boundary, Cty  Boundary:
[E3 Representation Rules Courty Miltary 1...
[ Hetches

=5 C\ARCGIS10_EGITIM\Uygular, e — —_—
F= Refarmnns Sustams o

| Bounday,  Bounday,  Freeway [»

Style Manager

[ Representation Rules [ [
3 Hatches
CGIS10_EGITIM Uygular

—_— g—

1. Derece Yol 2. Derece Yol Demir Yolu

Hew »

5 Representation Markers
[ Noth Arows
[ Scale Bas o T

£ Legend tems
cale Tes

[ Vectorization Sattings
3 Fill Symbols

Line Symbols

3] Marker Symbols

£ Text Symbole

5 Representation Rules
{5 Hatches

9. Close butonuna tiklayarak Style Manager penceresini kapatiniz.

10. Jeolojik Formasyonlar katmanina ait Layer Properties mendsiinde
Symbology sekmesine tiklayiniz.Bu sekmede; Value Field ACIKLAMA
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olacak sekilde Match to Symbols in Style kismindan Jeoloji.style
dosyasini secip Match Symbols tusuna basip OK'i tiklayiniz.

“Lnyer Properties '

| General | Sourcs. EI.SeIedion_ | .Displﬂ Symbalogy !Fields || Definition Query Ei_LabeIs || Joins & Relates || Time || HTML Popup |
Show: '
e iDlaw categories by matching field values to symbols in a style. | Import..

Features
Categories Walue Field
i Unique values |AC||{|_.'L_M,1_ |\d
i Unique values, many
. Match to symbols in & Match to symbals in Style
Quantities |C:"-ARCGIS1 0_EGITIM\Lhrgulama_05"5tde"Jeoloji.style |:l Browse...
Charts
Multiple Attributes Symbol | Value Label Count | |»
[ |«sll other values: <all other values > i]
<Heading> ACIKLAMA 57 =
I:'Alﬂv}'on Yelpazesi, yamag m Auvyon Yelpazesi, yamagm 8 1 1+
|| BT Andeat Andezt 14 o
o | [2 o o I |Aymimamis Kuvatemer Aynimamis Kuvatemer g i E
.—'lynlmamlq\ gnays, migmatit, n Aynimamig gnays, migmatit, n 2
L JlEazatt Bazat 1
EBazah. spilit Bazalt, spilt 3 |v!
[ Match Symbols ] [ Add Values... Remave Remove All ] [ Advapced ']

[ ok J[ cance ][ epy |

Bu islem ile Jeoloji.style dosyasinda olusturulmus olan semboller
Formasyon katmaninin agiklamalari ile esleserek olmasi gereken
sembolojiyi kazanmis oldu.
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11. Ayni islemleri Table Of Contents’deki Yollar Katmani icin yapalm.
Yollar Katmanina ait Layer Properties’den Symbology sekmesine
geciniz.Categories altinda yer alan Match to symbols in a Style
fonksiyonunu ayarlayiniz. Value Field’a, Aciklama, Match to symbols
in Style’a, Jeoloji.style kiitiphanesini ayarlayiniz. Sonra da OK tusuna
basarak islemi sonlandiriniz. Bdylece Style dosyasindaki semboller,
katmanin Aciklama satinundaki isimlerle eslestirilerek otomatik
olarak atanmis olacaktir.
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i_dy'er Properties

Fields .|| Definition Guery || Labels || Joins & Relates || Time .|| HTML Popup |

: Unique values, marry
Match to symbals in 3

Match to symbols in Style

| General | Sourc election || Displa:
Show:
Feat iD!aw cati ching field values to symbels in a style. | Import...
Calegories Value Field
- Unique valugs |Agik|ama |ﬂ

Quartities |C: \ARCGISTI_EGITIMUygulama_05"Style'Jealaji.style ‘VI Browse..
Charts
Multiple Attributes Symbol | Value Label Count
<all other values> <all other values» 0
<Heading> Acikiama 104
1. Derece Yol 1. Derece Yol 59
(& I e 2. Derece Yol 2. Derece Yol 3
z —+—+—Demir Yolu Diemir Yalu 14

[Matc:h Smbols] [ Add Values... Remove

Remawve Al ][ Advanced ~

oK

] [ Cancel ] [

Apply

12. Tabaka Dogrultu Katmanina ait Layer Properties menisiinde

Symbology sekmesine gegciniz.
fonksiyonunu ayarlayiniz.

Dogrultu semboliini se¢iniz ve OK butonuna tiklayiniz.

| General || Source || Selection | Displ

Symbology |eids || Definiion Query | Labels | Joins & Relates | Tme || HTML Popup)|

Show:

|
[Draw ciffeEmPESTET the same symbol. mpart

Features

Single symbol
Categories
Quantities
Charts.
Muiltiple Attributes

Symbol

Feaures altinda Single Symbol
Symbol Selector penceresinden Tabaka

]

Symbol Selector

Legend

[Type here to sea [v] @ @ B8~
Search: () All Styles

Label appearing next to the sy () Referenced Styles

C:\ARCGIS10_EGITIM\Uygulama_05\5tyle\Jeolo[#

Additional description appearing

= t |

Dogrultu Atmli Egim At Fay Marker Symbl
Fay

Tabaka
Degruia

Current Symbol

o
Size: 17.01 [
Angle:  [0.00 (2]

[£3]
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13. Advanced butonundan Rotation fonksiyonunu seciniz ve Rotation
Field’i Dogrultu olarak ayarlayiniz.Agik olan her iki pencerede de OK

butonuna tiklayiniz.

3]

Layer Properties
_G_‘g_nev?l\ S_ou_n;:e sx_alg_;tiqn _Digpl ields | Dej_i_ljﬂion_C_J_ue_r_}' Lab_gls_ Jo_\ns_& Rx_elat_es T_im_e | H'!'!'v1L F_‘Dpup_
| Show: -
Feat Draw all features using the same symbol.
Single symbol
ymbal
Categories Symbol
Quantities W
Charts ' JREE S B——
Multiple Attributes PR | e e S ')
Size, |
Legend Symbaol Levels..,
Rotate @

Rotate Points by Angle in this field:

DOGRULTU

v @

Rotation Style:

0]
a0
27
80

(%) Geographic

Randaom

A
i}
130
270

() Arithmetic

[ OK l [ Cancel ]

14. Bu islem ile tabaka dogrultu sembolleri veri tabaninda bulunan agl

degerlerine gore dondir

Ulmdis olacaktir.

15. Projeyi kaydediniz ve ArcMap’den gikiniz.

Uygulama 6: Cografi Verile

rin Sorgulanmasi;

Select Features, Select By Attribute, Select By Location, Select

By Graphics;
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Cografi Bilgi Sistemlerinde grafik ve grafik olmayan verilerin birbirleri ile
bitinlesik olarak sorgulanmasi miimkindir. Boylece grafik verilerden so6zel
verilere, sozel verilerden grafik (konumsal) verilere hizli erisim imkaniniz olur.

Onceki uygulamalarimizda Grafik verilerin veritabanina goéz atmak
istedigimizde Tools Toolbar’dan identify aracini kullanmistik. Benzer sekilde
veri tabani bilgilerinden Grafik veriye hizli erisimi Main Menu Bar’da yer alan
Find fonksiyonu ile gerceklestirmistik. Diger bir deyisle Find fonksiyonu text
veriden grafik veriye ulasmamizi saglamisti.

Bu béliimde ArcMap araylziinde programin bize grafik segmek icin sagladigi
araglarin (Select by rectangle, polygon, lasso, circle, line) kullanilmasi,
Gorintlilenen Grafik verilerin veri tabanindaki 6znitelikleri (attributes)
Gzerinden mantiksal sorgulamalar yaparak Grafik veriye ulasmasi (Select By
Attributes) ve farkhh cografi verilerin birbirleriyle mekansal iliskilerinin
sorgulanmasi (Select By Location) gibi  konular (izerinde duracak ve
uygulamalar yapacagiz.

1. ArcGIS10_Egitim klasoriinde yer alan Uygulama_06.mxd dosyasini

ArcMap ortaminda aginiz.

2. Tirkiye Maden Yataklari Data Frame’inde yer alan ILLER katmanini

Identify @ aracliyla inceleyiniz.
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Eie

Edt Vew Boskmaris Duert Selwton Gewrmcessny Custemze Windses  Heb
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C Sy o O = L L
dethed | featue

8 Find araci sayesinde Oznitelik bilgilerinden (Attributes) herhangi
birini bildiginiz bir grafik veriye ulasabilirsiniz. Ornegin: Corum ilini
bulmak istiyorsunuz...

Veritabanindaki metinsel(text) ifadelerden ekrandaki grafik veriye

ulagsmanizi saglayan & Find araci Uzerine tiklayiniz. Features
sekmesinde Find kutucuguna Corum ifadesini yazip Find butonuna
tiklayiniz. Arama sonuglar icerisinde Corum vyazan vyere gift
tikladiginizda ekrandaki goriinti otomatik olarak Corum {izerine
gidecek ve flash goriintii ile yerini belirtecektir.
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B Find
ocations :.Linear.Referenciljg._' -

Find: | corum

vl

Search:
® all fields
O In field:

In: | <Visible layers >

Find features that are similar to or contain the search string

:_! New Search

Cancel

Right-click a row to show context menu.

| Walue

CORUM

Layer Field
ILLER AD

One object found

4. Sonug lizerinde mouse’un sag tusuna basip Select secenegine
bastiginizda ise Corum ili secilmis olacaktir.

Walue

CORUM

One object found

Layer Field
“g- Flash
@‘l Zoom To
é\?ﬂ] PanTo
|;|!| Create Bookmark
@ 1dentify...

r[@ Select 1

_—— e o = == -
Unselect

F}l Add to My Places

F:l Manage My Places. ..

I%® add as Stop to Find Route

J§* Add as Barrier to Find Route

-~

ArcGIS 10’da gelistirilen Tools Toolbar'daki Select Features By secenegi size
farkh sekillerde grafik segim imkanlari sunmaktadir.

Select by Rectangle: Olusturdugunuz diktortgenle grafik veri

se¢cmenizi saglar.

Select by Polygon : Olusturdugunuz alani dikkate alarak grafik veriyi
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segmeniz
Select by

i saglar.
Lasso

: Olusturdugunuz kement sekline gore grafik

veriyi se¢menizi saglar.

Select by

Circle

: Olusturdugunuz cember sekline gore grafik

veriyi secmenizi saglar.

Select by
segcmeniz

Bu secenekleri

Line
i saglar.

: Olusturdugunuz cizgi sekline gore grafik veriyi

#

Select by Rectangle

Select by Polygon

K

28 £ £ | B 4

Select by Lasso
Select by Circle

Select by Line

kullanirken

secim yapacagimiz

katmani Selectable

Layer(segilebilir katman) yapmamiz daha uygun olacaktir. Sadece bir grafik

veri secmek icin Select by Rectangle,Lasso veya Circle seceneklerinden birini

secip grafik veri tGzerinde mouse ile tiklamaniz yeterli olacaktir.Bu aracglar size

daha hizli se¢cim imkani saglamak amaciyla tasarlanmistir.

5. Katman secilebilirligini ayarlamak icin Table of Contents’de List By

Selection [E] sekmesine tiklayiniz.
6. Listede ILLER katmaninda Click to toggle selectable butonuna
tiklayarak iller katmaninin segilemez olmasini saglayiniz.

Table Of Contents

L:'UJ

=l Selectable (no features select... RE
(& 1LER M&E0 pM
________ ~
o Ulkeler i M) =~
Click to toggle selectable L5
=] Mot Selectable = J-=
< MADEM B M0 L

I x

Table Of Contents nx
% 8 S[E)
: =| Selectable {no features select... RO
|& MADEN K &0
| & Ulkeler M0 b
=] Mot Selectable
~ ‘:'\@'_ILIER_ T mEo )

] EU
Click to toggle selectablep
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7. Katmani tekrar segcilebilir olarak ayarlamak icin Not Selectable
kisminda tekrar Click to toggle selectable butonuna tiklayiniz.

Bu asamaya kadar ekran Uzerinde se¢im araglarini inceledik.  Simdiki
uygulamamizda Tirkiye Maden Yataklari Data Frame’i (zerinden bazi
sorgulamalar yapacagiz.Haritadaki iller maden ¢ikan noktalarini sayisina gore
actk renkten koyu renge dogru sembolize edilmistir.Amacimiz, sinirlari
icerisinde maden ¢ikan noktalarin sayisi belirli olan illerden, belirtilen sayida
noktaya sahip olanlar igerisinden metalik maden igerenlerin sayisini
bulmaktir.

Soru: Maden_Cikan_Nokta sayisi 8'den fazla olan illerden, il sinirlar
icerisinde Metalik Maden bulunduranlarin sayisi kagtir?

8. Main Menu Bar’da Selection menisiinden Select By Attributes
segenegini seginiz.
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Selection | Geoprocessing  Customize
- — -
) Seee By Atiktes .
{Bgy select By Location. ..

_— -

+
s

Interactive Selection Method  »

Selection Options...

9. Acllan pencerede Layer kismini ILLER katmani, Method'u Create a
new selection olacak sekilde ayarlayiniz. Usteki pencerede katmana
ait field isimleri listelenmektedir. Listeden Maden_Cikan_Nokta
secenegine c¢ift tiklayarak bu field isminin alttaki komut satirina
gelmesini saglayiniz.

10. Alt pencereye “> 8” yaziniz. Komut satirindaki ifadenin sekildeki gibi
oldugundan emin olduktan sonra OK butonuna tiklayiniz.

Select By Attributes
= = = = = e = = = = = = = = 4
JLaver: 1€ 1LLER =
[ Only show selectable layers in this list |
\I'\"Ietlod:_ J_Createanew selection Iz A
[Shaps_Length] [a?
[Shape_Area]
[End_Hmd]
[Erj_Hmd] =
e led) — — o
f [Maden_Cikan_Molta] -

on

SELECT ZFROM ILL ERWHERE:

[Maden_Cikan_Nokta] =8 )
- — . e —

Clear ][ Werify ][ Help ][ Load... ][ Save... ]

Lok J[ oy J[ Cose |
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Bu islem ile 8 noktadan fazla noktada madencilik faaliyetleri yuratulen iller

secilmis olacaktir.

11. Bu iller igerisindeki Madenleri bulmak icin Selection menisiinden
Select by Location secenegine tiklayiniz.

Selection | Geoprocessing  Customize

By select By Attributes. ..

=]
|
H
|
L -,
4

Interactive Selection Method

Selection Options...

12. Agilan pencerede Source layer’i ILLER, Spatial selection method’u
‘Target Layer(s) features intersect the Source layer feature’, Target
layer(s)’1 ise MADEN olarak ayarlayiniz. OK butonuna tikladiktan
sonra segili olan ILLER katmani igerisine giren butin MADEN’leri
bulacaktir. Metalik Madenleri bulmak igin sorgulamaya devam
ediyoruz.
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Select By Location

Select features from one or more target layers based on their location in
relation to the features in the source layer.
Selection method:
select features from v
fc):
Targi\ayﬂs;._
mapen |
= O
O Ukeler

[Jonly show selectable layers in this list
= = ===
Source layer:

[ nier =1 !
Use selected features {17 features selected) 1
—— e mm mm mm mm mm mm Em Em o = o= e

Spatial selection method:

Target layer(s) features intersect the Source layer feature "

[ apply a search distance

o) ) o

13. Main Menu Bar’da Selection menisiinden tekrar Select By Attributes
secenegini seciniz.

14. Layer kismini MADEN, Method'u select from current selection
olarak ayarlayiniz. Ustteki listeden TUR ismine cift tiklayarak
asagidaki komut satirina gelmesini saglayiniz. Tir fieldi icerisindeki
kayitlari listelemek icin Get Unique Values butonuna tiklayiniz. Daha
sonra listeden Metalik Madenleri secip cift tiklayiniz. Komut satirina
geldigine emin olduktan sonra OK butonuna tiklayiniz.
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SelectByAwbutes ___ ____ [2)Ed
| Layer: j manen
[C] Only show selectable layers in this list

\Met_hcd:_ iSeIeCI from cument selection

JEl_le

[OBJECTID]
[TUR]
[KAPASITE]
[ALTTUR]
[KOD]

- R demmaddgler o
2 - Metalik Madenler
T Ml

Get Unique Values | Go Te: l:l

SELECT.- FROM MADEN WHERE:

[TuRi=2 1
Cm =

Clear ][ Verify ][ Help ][ Load... ][ Save.. ]

[ ok J[ ey | [ Clse |

Table Of Contents’de List By Selection & sekmesini kontrol
ettigimizde Sonug olarak ILLER katmanindan 17 il igerisinde, MADEN
katmanindan 99 tane segili Metalik Maden oldugunu goreceksiniz.

-

=] Selected

<& MADEN H [ %
& ILLER B M 17
=] Selectable (no features selected)
& Ulkeler HME0
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15.

Simdi yeni bir uygulama yapmak lizere Ankara Data Frame'ini aktif
hale getirelim.

Pl Edt  vew Sookeads et Seecten  Cesoroteiiey Custoewre  Windtwd  Hel
TR N RNl T FAnaRenisalisecle sl ool ool izl s BTETETF
...... T
h [EETEYTR i
Wl & 5 Turicye Macen atsien
T & 2w
I B s
-3 5 B Uk
il = ) |
" # B ol O
"'_ B ey
| 5y I
.l Y
'Y 2 sy

G
5 i
D e L
8
Lo
[
|

=e

Soru: Alper Sokak’in 500 m etki bandinda bulunan binalardan taban alani 500
m?den buyiik olanlari bulunuz.

16.

17.

Bu soruyu ¢ozmek icin oOncelikle Alper Sokak’in  bulunmasi
gerekmektedir. Selection menisiinden Select By Attributes
secenegine tiklayiniz.

Layer kismini Yol_Orta katmani, Method’'u: Create a new selection
olarak ayarlayniz. AD fieldi Uzerinde gift tiklayarak komut satirina
gelmesini sagladiktan sonra AD fieldt igerisindeki kayitlari
gorintilemek icin Get Unique Values butonuna tiklayiniz. Komut
Satirinda “AD” = ‘Alper Sokak’ yazdigina emin olduktan sonra OK
butonuna tiklayiniz.
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ILayer: [ vol_orta

[] Only show selectable layers in this list
]
‘Mﬁhﬂd |Creata anew selection
—
=y pac]
"OBJECTID"
"OBJECTID_1" =
"SERIT
“AD”
ANAARTEL

i

5. Cadde’

A Mithat Efendi Sokak’
‘Abdullah Cevdst Sokak’

“Abidindaver Sokak'
"Ahmet Rasim Sokak’

~
L
(o] [Bprdokek, .
Get Urique Values |GoTo: ||
"AE',;E:% WHERE:

e = - -

Clear I[ Verify ][ Help ][ Load ][ Save ]

[ L ][ Apply ][ Close ]

18. Alper Sokak’in 50 m etki bandindaki binalari bulmak i¢in Selection
Menisiinden Select by Location secenegine tiklayiniz.
19. Ayarlar sekildeki gibi yaptiktan sonra OK butonuna tiklayiniz.
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Select By Location .

Select features from one or mare target layers based on their location in
relation to the features in the source layer.

Selection method:
|select features from M

Target layer(s):
Y -

g

O Parseller

O Imar

[ anly show selectable layers in this list

Source layer:
EICEYED o o

:F ¥ Yol_Orta |

Use selected features {1 features selected)

Spatial selection method:

|Targe1 layer(s) features are within & distance of the Source laver feature M

—_—— ==

’ Apply a search distance
1

|
» i

N e e =

Lo oo ) e

20. Bu asamada Alper Sokak’in 50 m etki bandinda kalan biitiin binalar
secilmis olacaktir. Bu binalarin icerisinden taban alani 500 m*den
biylk olanlari bulabilmek igin tekrar Select By Attributes secenegini
tiklayiniz.

21. Select By Attributes penceresinde ayarlari sekildeki gibi yapiniz.
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i-‘n = ?

Layer: 1 Binalar =]
[ Only show selectable layers in this list

Method: Select from cumert selection
"BINA_ADI" A
"Shape_Leng" .
"Shape_frea”
"Bagimsiz_B" =
"Mahalle"
"Sokak_Adi" L

Get Unigue Values | Go To:

[ Clear ][ Werify ][ Help ][ Load... ][Save... ]

oK ][ Apply ][ Close ]

Sonug olarak Yol_Orta katmanindan 1, Binalar katmanindan (Kapi_No:37) 1
grafik veri secilmis olacaktir.

Table Of Contents 1 x
% 8 (8]
[=] Selected

&% Yol _Orta BMEL

B Alper Sokak
& Binalar M1

@ 37
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Simdi yapacagimiz érneklerde ArcGIS’de Rapor hazirlama ve grafik olusturma

fonksiyonlari Gzerinde duracagiz.

Rapor Olusturma:

Bu 6rnekte ArcGlS’in rapor hazirlama 6zelligine 6rnek verecegiz.

Ankara Data Frame’inde Sokak Adlarini ve onlara ait uzunluklari gésteren bir

rapor hazirlayacagiz.Rapor hazirlama 6zelligi ArcGIS'de size rapor hazirlama

sihirbazinin sagladigl imkanlarla ¢ok kolay ve c¢ok kisa sire igerisinde

gerceklestirilebilmektedir.

22. Main Menur Bar'dan View>Reports>Create Report seceneklerini

sirasl ile seginiz

Data View

Yiewe l Bookmarks  Insert Selection

Geoprocessing Customize

)| Layout View

Graphs k|

| Reports ] |

Create Report..,

Scroll Bars
Status Bar

[OE Rulers
N G

P Data Frame Properties...
| Refresh F5
Il Pause Drawing Fa

S| Pause Labeling

Load Report...
Run Report...

23. Acilan pencereden “AD” ve “Shape_Length (uzunluk)” Field’larini

secip sag yoni gosteren oka tiklayiniz.
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Repart Wizard

\which fields do you want on your report?

Layer/Table: Report View Contents Field:

[ YoLore M| ]

Luwailable Fields: = =peport Fields:
FID
QBJECTID [I]

OBJECTID_1 ‘
JSERIT. — o o o o o o

AD
TAMRARTEC — T T T T T T T [»)

Tl . e e e m = = — = 4]

Shape_Leng “

-

-

[ Dataset Options.. ]

rReport Wizard “

Wwhich fields do you want on your report?

LayerTable:

Report View Contents Field:
& Yol_Orta i 1]

Available Fields: Repart Figlds,
FID kA 1 +
OBJECTID 1| 5hape_Leng

OBJECTID_1 1N
SERIT
ANAARTEL
TIP

Dataset Options. .. ]

e | [(Hew ] oo ]

24. Sirasi ile Next > Next dedikten sonra gelen pencerede Raporda

Gostermek istedigimiz Fieldlarin adini yani AD ve Shape_Length
fieldlarini asagidaki gibi seginiz.

131



Report Wizard x|
\which fields do you want sorted on your report?
You can sort fields in ascending or descending order.
AN Fislds Sort

AD [v Ascending [ 2

; wﬁtﬁ& || » || Ascending w
T
3
3 &y
[ Summary Options... ]
[ Cancel | [ <Back |[ Mest> | [ Finish |

25. Tekrar Next butonuna basarak pencerenin sag lst kosesinden
raporun yatay (horizontal) veya dikey (Portrait) olma durumunu

ayarlayiniz.Bu ornek icin Portrait secenegini seginiz.

| X]

R e

How would you like to layout your report?
Layout Orientation
(%) Stepped (5 Portrait

- O Outline O Landscape

Adjust the field width so all fields fiton a

e __________________________________.% page.
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26. Tekrar Next butonuna basiniz ve Havelock style’i secip Next

butonuna basiniz ve Rapor igin baslik belirleyiniz.Bu 6rnek icin basliga

Sokak isimleri ve Uzunluklan yaziniz.

Report Wizard 3%

-

Wwhat title do you want for your report?

E..Sokak isimleri ve Uzunluklan|

That's all the information the wizard needs to create your report.
Do you want to preview the report or modify the report’s design?

{#) Preview the report.
) Modify the report’s design.

B T

27. Raporu goruntilemek icin Finish butonuna tiklayiniz ve raporu

gorintileyiniz.

[ et Viewor ok Himter e Uit T — (B %)
few | |0 Bh | [ |20 [0 [ 2 |Gh on 08 [w]| 64 D 12 S
| e i
|| — - 1 3 5 & - - [
-II ameusss
Sokak Isimleri ve Uzunluklarm
: AD
i
0.Cadde
5.Cadde
5.Cadde T 3%
5.Cadde 10001278
AMithst Efend 3520006
Bokak
Aldbrhat Efens 48130251
Sakak
AMithat Efens EL416282
Eckak
Adbirhat Efens 1208158108
Sakak
Abdullak Covder 100360028
Bakak
Abdullah Covder 111151582
a Sakak -
< r
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Grafik Olusturma:

Bu 6rnekte ArcGlS’in grafik hazirlama 6zelligine 6rnek verecegiz.
Maden Yataklari Data Frame’inde il isimlerini ve o illerdeki maden ¢ikan
nokta sayisini gosteren bir grafik hazirlayacagiz. Grafik hazirlama o6zelligi

rapor hazirlamada oldugu gibi ArcGlS’de sihirbazin sagladigi imkanlarla ¢ok

kolay ve ¢ok kisa slire icerisinde gergeklestirilebilmektedir.

28. Turkiye Maden YAtaklari Data Frame’ini aktif hale getiriniz.

29. View > Graphs> Create Graph segenegine tiklayiniz.
30. Agilan Graph Wizard penceresinde

asagidaki ekran kopyasinda

oldugu gibi Layer/Table kismina ILLER katmanini X Label Field’a AD

sitiin ismini secili hale getiriniz ve Next butonuna tiklayiniz.
il Create Graph Wizard
Graph type:
3[[|_|_ Wertical Bar |vl Graph of ILLER
‘ 0 8INGOL
Layer(Table: Bl 11 MANSA
[ = - Bl OSTANEUL
o [ REFAL
Value field: [Maden_cikan_nokta E} B 13 KavSERI
e L 10SHMANIVE
X field (optional): <None > | Value  [w Ly OKLUs
I _Bl_lj - W 7 TR&BZON
% label field: | = L 1BURDUR
: = L OTUNCEL
Vertical axis: |Left ] <! W 15 KONYA
— £ W 21 5AS
Horizontal axis: | Bottom v] OI [ 1TEKIRDAG
e 5 1 OSANLIURFA
[¥] Add to legend [[]show labels (marks) = W S ERZINCAN
3
P T 3 1
Color: [ Match with Layer [ = i = Sl
o sty [Recterge [x] - Jeiey
; : T L 1DazcE
Wultple bar type: | side [ : BB 3 GUMSHANE
Bar size (%): 70 (5 []show border i = ?I:Iglz:ég-
] I 2 GAZIANTEP
NIGDE USAK RIZE ORDU TOKAT SRMAK ICEL | 4 DENZLI
. 0SAMSUN

Vertical Bar

Add -

Load Template +

31. Penceredeki Title kismina Maden Cikan Nokta Grafigi yaziniz,Graph in

3D view secenegini isaretliyerek grafigi 3 boyutlu goriiniime kavusturunuz

ve

Finish

butonuna

basarak

islemi

sonlandiriniz.
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il Create Graph Wizard

B[]

(%) show all features/records on graph
Highlight currently selected features jrecords
(O show only selected featuresfrecords on the graph
Gerieral graph properties
Title: Maden Cikan Nokta Grafigi

Footer:

Graph in 3D view

Graph legend
Title:

Position: ‘R,qm

[v]

Axis properties

Left  |Right || Bottom [ Top |

[ Maden_cikan_Nolta

Title:
Visible

Logarithmic

Maden_Cikan_Mokta

Maden Cikan Nokta Grafigi

i 0
BINGOL SIVAS NIGDE USAK RIZE ORDU

i’
TolaT

SIRNAK ICEL

0 BINGOL
11 MANISA
8 ISTANBUL
18 ZMIR
18 KAYSERI
1 OSMANNME
0 KLIS
7 TRABZON
1 BURDUR
0 TUNCELI
18 KONY A
21 SIWAS
1 TEKIRDAG
0 SANLIURFA
9 ERZINCAN
6 ERZURUM
6BMLIS
2 ADVANAN
SANASYA
1 DuZCE
3 GUMUSHANE
2 NIGDE
T YOZGAT
2 GAZIANTEP
4 DENEZLI
0 SAMSUN

r—

Finish

] [ Cancel

32. Grafiginiz ekranda asagidaki sekilde goziikecektir.

:ﬁaden Cikan Nokta Grafigi

Maden Cikan Mokta Grafigi

=
h

haden_Cikan_Mokta

0 d " -
BINGOL KILIS ERZNCAN DENIELI USAK

{ '
RIZE MUS SIRT

AD

a1
ISPARTA

K.IMARAS

| d
AGRI KKTC

0 BINGOL
11 MANISA
9 ISTANBUL
18 EZMIR
18 KAYSERI
1 OSMANNE
0 KILIS
7 TRABZON
1 BURDUR
0 TUNCELI
18 KONYA
21 SMAS
1 TEKIRDAG
0 SANLIURFA
5 ERZINCAN
& ERZURUM
6 BITLIS
2 ADIYAMAN
S AMASYA
1 DGZCE
3 GUMOSHANE
& NIGDE
TYWOZGAT

33. Uygulama_06.mxd’yi kaydedip ArcMap’den ¢ikiniz.
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Uygulama 7 : Raster Haritalarin Cografi Olarak
Koordinatlandirilmasi (Georeferencing);

Taranmis raster verilerin gercek diinya ylizeyi (izerindeki koordinatlarina tam

oturmas! icin vyapilan isleme cografi koordinatlandirma(georeferencing)

denilmektedir. Bu islemi yaparken raster Uzerindeki koordinatlari bilinen

noktalarin arayilizde eslesmesi saglanir. islem sonunda koordinati eslesecek

noktanin se¢cim hassasiyeti, paftanin tarayicidaki tarama hassasiyetine kadar

bircok etkene gore RMS(karekok) hatasi belirlenir. Bu hata belli bir standard

sapma degerinin icinde kabul edilebilir ama bu degerin lzerindeyse islemin

tekrari gerekmektedir.

1. C:/ArcGIS10_EGITIM/Uygulama07/Uygulama_07.mxd’yi
cift tiklayarak ArcMap 10’da aciniz.

%  ArcMap 10

2. Customize > Toolbars > Georefencing tiklayiniz. Raster verilerin

koordinatlandirilmasi

kullaniimaktadir.

icin Georeferencing arag cubugu

Customize | Windows Help
Toolbars 3

Extensions...

Add-In Manager...

Customize Mode...
Style Manager..,

ArcMap Options...

3D Analyst
Advanced Editing
Animation

ArcScan

COGO

Data Driven Pages
Data Frame Tools
Distributed Geodatabase
Draw

Edit Vertices

Editor

Effects

Feature Cache
Feature Construction
GP3

Geocoding
Geodatabase History

Geometric Network Editing

Georeferending || Layer: | 224224 3¢ tif A Q - .\f @

Fit To Display
Flip or Rotate »

Transformation 3

Auts Adiust

Georeferencing
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3. Table of Contents’de tek bir raster veri bulundugundan dolay! Layer

6.

secenegi otomatik olarak f22d22d3c.tif dosyasini secili olarak
getirmistir. Fakat birden fazla raster bulunursa hangi raster lizerinde
georeferencing islemi yapilmasi isteniyosa ilk olarak Layer'dan o
raster’in secilmesi gerekmektedir.

Georeferencing menisinin altindaki Auto Adjust’in tikini kaldiriniz.

f22d22d3c.tif rasterinin sol Ust késesine dogru Zoom In araciyla )
yakinlasiniz. Raster lGzerinde bu kdseye ait koordinatlar yazmaktadir.
Georeferencing ara¢ cubugunda bulunan Add Control Points l?‘
aracini secerek sol kdse noktasinda asagidaki goriintiide oldugu gibi
mouse’un sol tusuna bir kere tiklayiniz. Gergek koordinat degerlerini
girebilmek icin mouse’un sag tusuna bir kere tiklayarak Input X and Y
secenegini tiklayiniz. Agilan pencereye pafta lGzerinden okudugunuz X
ve Y koordinatlarini asagidaki gibi yaziniz.

Georeferencing v | Layer: |f22d22d3c f | G 'E

; Cancel Point !
Enter Coordinates
X | 42165296
¥ | 4541754.38
[ Ok l [ Cancel ]

ilk noktaya ait degeri girdikten sonra ikici kdse olarak paftanin sag st
kdsesine yakinlasiniz. Georeferencing arag¢ ¢cubugundaki Add Control
Points araciyla sag Ust koseye mouse’un sol tusuna bir kere ve
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ardindan sag tusuna bir kere tiklayarak asagidaki X ve Y koordinat
degerlerini yaziniz. OK'i tiklayiniz.

InputXandY ...
. M

K 422178.28 |

¥ 454175373 |

[ o« | [ cencel |

7. Ayniyontemlerle paftanin sag alt kdse ve sol alt kose koordinat
degerlerini asagidaki gibi tanimlayiniz.

m

X: | 422170.94 |

¥ | 454106461 |

[ ok | [ cancel |

Sag Alt Kose m

X: | 421645.06 |

Y: | 4541070.25 |

| ok | | cencel |

Sol Alt Kése
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8. Tum noktalara ait koordinat degerlerini yazdiktan sonra

Georeferencing ara¢ cubugundaki View Link Table aracini ]
tiklayiniz. Agilan Link Table penceresinden yanls yazilan X ve Y
koordinatlarini Xmap ve Ymap seceneklerinden dizeltebilirsiniz.
Daha sonra pencerenin sol altinda bulunan Auto Adjust’in tikini
atiniz. OK’i tiklayiniz.

Link Table
: . ] e —
Link ¥ Source Y Source | ¥ Map Y Map Residual ¥
1 0.452031 29.625934 421652,400000  4541754,330000 1 231717
2 21,222727 28.612460 422178,290000 4541758.730000 | 2.31471
3 21,134500 2381533 | 422170.940000  4541064.510000 I 2.31354
4 0.403338 2.426943 \ 421645.000000  4541070.250000 2.31599
i1 IES
. — )
Transformation: ist Order Polynomial {Affine) | |
! I
Total RMS Error: Z.31535
e S S e e e e e e a2
T T e From o

9. Raster veri girilen gercek koordinat degerlerine tasindigl igin
ekrandaki goéruntiiden kaybolmustur. Full Extent @ butonuna
tiklayarak rasteri ekrana getiriniz. Mouse’unuzu hareket ettirdiginiz
sag alt ekranda goriintilenen koordinat degerlerinin degistigini
goreceksiniz.

Yapilan degisikliklerin farkli bir raster veri olarak kaydedilmesi
gerekmektedir.

10. Bunun icin Georeferencing ara¢ cubugunda Georeferencing >

Rectify’i tiklayiniz. Ayarlari asagidaki gibi yaparak Save butonuna
basarak islemi tamamlayiniz.
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Georeferendng || Layer: [22d22d%
| Update Georeferencing

| Recify... |

Flip or Rotate 3

Transformation 3

Auto Adjust

Update Display

Delete Control Points

Rezet Transformation

e e

ot >
eDsi s — :
Resample Type: |Nearest Meighbor (for discrete data) I
Output Lacation: | €:\ArcGIS10_EGITM\Jygulama_07 | @ :
Mame: REC_F22d22d3c1.6F | Format: :

b Gompresson Type:

Compression Quality
et LN

Rektifiye edilen raster veriye projeksiyon sistemi tanimlanmahdir. ArcMap

araylzi icerisinde saklanabilir pencere olarak gelen ArcCatalog ile verilere

projeksiyon sistemi tanimlanabilmektedir.

Il

Fie B3t Ve fRockmaks  lmert Seecton  Geoomceseng  Citeee  Windoet  nep

RPN SR

i Seorstermeong s | 1T

-

i e o — — — — — ———

- — oy,

= i e - arci810_BSITMUppuanas 67
& Il e
& Frzzze Fetmso
W Faaiadie e st
£y |

L =EE R ]

22976 2044 Doomal Degress.

11. Catalog penceresini agmak icin Standard ara¢ cubugu (izerinde

Catalog Window 51 simgesini tiklayiniz.
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12. Catalog penceresinde REC_f22d22d3c.tif dosyasi

Gzerinde sag

tiklayarak Properties’i seciniz. Acilan Raster Dataset Properties

penceresinde Spatial Reference secenegi herhangi bir projeksiyon

sistemi heniiz tanimli olmadigindan dolayr <Undefined> olarak gelir.

Yanindaki “Edit” secenegine tiklayiniz.

Catslog
E-2 4N aE| g | B
Location: |§# REC_f22d22d3c1.6f

= Eﬁ Home - ArcGIS 10_EGITIMYJygulama_07
B B f22d22d3c.tf
[ED Fazd22d3c_Pafta.shp
= B f2adeadic_rec.tf

# [ ReC ‘
Q] uyg Y coov
% 3 Folder cq % | Delete
£ ﬁToo\boxe Rename
X @ Databas
5 @Databas A4 Create Layer...
X @ GIS Serv Load

Export
Build Pyramids...

Calculate Statistics. ..

|=]| Item Description...

SEfl Publish to ArcGIS Server. ..

|m‘ Properties...

Raster Dataset Properties

General
| Property
Pyramids
Compression
B Extent
Top
Left
Right
Bottom
= Spatial Reference

Linear Unit
Angular Unit
= Statistics
EH Band_1

Build Parameters
Min
Manc
Mean

| Std dev.
Classes

alue #)
level: 3, resampling: Nearest Neighbor Build...

Naone

4541798.52811
421631.524081
4221344856706
4541004, 16586
<Undefined>

~====

Edt. | |

- - - - -

Options +

skipped calumns: 1, rows: 1, ignored value(s): 3
0

255
167.65618054258
33.629605438111
o

13. Acilan Spatial Reference Properties penceresinde ayni yere ait daha

onceden koordinat sistemi

sistemi eklemek i¢in Import’u seginiz.
C:/ArcGIS10_EGITIM/Uygulama_08/F22d22d3c_Pafta.shp katmanini
secerek Add butonuna tiklayiniz.

tanimlanan bir

katmanin koordinat
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XY Coordinate System

Name: Unknown

Details:

Browse for Dataset :

Logcin: | Uygulama_07 v & W@

-

T T T
REC_ faad22d301. 6

Name; F22422d3c_Pafta.shp fkd

Show of type! | Ganoraphic datssets v] [ el |

e As Save the coordinate system to 3
file.

14. Spatial Reference Properties penceresinde OK'i tiklayiniz. Raster
Dataset Properties penceresine koordinat ve projeksiyon sistemleri
bilgileri gelmektedir.

Spatial Reference Properties

XY Coordinate System |

MName; ED_1950_UTM_Zone_35N
Details:
Projection: Transverse_Mercator F

False_Easting: 500000,000000
False_Morthing: 0.000000
Central_Meridian: 30,000000
Scale_Factor: 1.000000
Latitude_Of_Origin: 0.000000
Linear Unit: Meter {1.000000)

Geographic Coordinate System: GCS_European_1950
Angular Unit: Degree (0,017453292519943295)
Prime Meridian: Greenwich {0.000000000000000000)
Datum: D_European_1950
Spheroid: International_1924 M

Select a predefined coordinate system,

Import a coordinate system and X/, Z and M
domains from an existing geodataset (e.q.,

feature dataset, feature dass, raster).

Create a new coordinate system.

Edit the properties of the currently selected
coordinate system,

Sets the coordinate system to Unknown,

Save the coordinate system to &
file.

[ OK. ][ Cancel ][ Apply
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Raster Dataset Properties
General |
Property Value |ﬁ|
Pyramids level: 3, resampling: MNearest Meighbor _Byl|_d___|
Compression Mone
B Extent
Top 4541798.52811
Left 421631.924081
Right 422184,436706
Bottom 4541004, 16586
I=I Spatial Reference ED_1950_UITM_Zone_35M [ = |
Linear Unit Meter {1,000000)
Angular Unit Degree (0,017453292519943295)
False_Easting 500000 =
False_Morthing 1]
Central_Meridian 30
Scale_Factar 3
Latitude_Of_Origin 0 |
Datum D_European_1950
Bl Statistics __ Options |
[E Band_1 !V|
B ild Deramatare clinmad ralimmne: 1 eruwe: 1 immerad wsbisfels 15
ok [ Cencel | [ mopy |

15. Raster Properties ekraninda OK’i tiklayiniz. REC_f22d22d3c.tif raster’i
cografi olarak koordinatlandiriimis olarak kullanilabilir. ArcMap’i
kaydetmeden kapatiniz.
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Uygulama 8 : ArcCatalog’da Veritabani Tasarimi;

ArcCatalog, ESRI'nin vektor ve raster verilerinin tasarlanip yonetildigi arayiz
uygulamasidir. ArcGIS Desktop yazilimi icerisinde gelen bu arayliz ArcGIS
10’dan itibaren ArcMap araylzi icerisinde ayri bir pencere olarak da
gelmektedir. ArcCatalog ile sunlari yapabilirsiniz;

e ArcGIS veri formatlarinin olusturulmasi (Geodatabase Feature Class,
Raster Dataset ve Shapefile)

e Veri tabani tasarimi olarak Field’larin olusturulmasi ve 6zelliklerinin
belirlenmesi

o Verilerin kopyalanip yapistiriimasi, import, export vb sekilde
yonetilmesi

e Veri tabani 6zellikleri olan Subtypes, Domain, Relationship, Topology,
Network Dataset, Geometric Network vb. fonksiyonlarin
tanimlanmasi

e ArcMap ve ArcToolbox araylzlerine verilerin siriklenip birakilmasi
ve yonetilmesi

e Verilere ait tanimlayici bilgilerin Item Description olarak belirlenmesi

e liskisel Veri Tabani Yénetim Sistemlerine(IVTYS) dogrudan baglanti
kurulmasi

e ArcCatalog arayiiziinde verilerin Preview fonksiyonu ile dnizlenmesi

e Windows Gezginine benzer sekilde verilerin gorintiilenmesi,
siralanmasi ve yonetilmesi

ArcCatalog’da ESRI Vektor Verilerinin Olusturulmasi

Shape File; ESRI'nin ArcView 3x Desktop GIS yazilimindan itibaren Urettigi
grafik ve sozel veri depolayan vektor veri formatidir. Shapefile dosyalari
Nokta(Point), Cizgi(Line) ve Alan(Polygon) veri tipleri olarak depolanir. Her
katmanda bu grafik veri tiplerinden sadece bir tanesi tutulur. Katmanlari veri
tabaninda .shp, .dbf ve .shx uzantilariyla tutar. *shp; katmana ait grafik
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verilerinin tutuldugu dosya, *dbf; grafik veriye ait Oznitelik bilgilerinin
tutuldugu dosya, *shx; grafik veri ile sozel veri arasindaki iliskiyi saglayan
index dosyasidir.

Geodatabase Feature Class; Nokta, Cizgi ve Alan veri tipleri olarak
tanimlanan grafik ozellikler, File veya Personal Geodatabase, ArcSDE
Geodatabase igerisinde depolanir. Personal Geodatabase Ms Access veri
tabaninda, ArcSDE Geodatabase ise iliskisel Veri Tabani Yénetim
Sistemi(IVTYS) olarak adlandirilan Oracle, Informix, SQL Server, IBM DB2...
veri tabanlarinda depolanarak yonetimi saglanabilen ESRI vektor veri
formatidir. Shapefile formatina goére yeni bir formattir. Nokta, Cizgi ve Alana
ait grafik veri ve buna bagh 6znitelik verileri cografi veritabaninda tutulur.

1. Basglat > Tiim Programlar > ArcGIS’i seciniz. ArcCatalog 10 ayri bir
araylz olarak goriinmektedir. Fakat bu uygulamamizda ArcMap
araylziindeki Catalog penceresinde tim ArcCatalog islemlerine ait
fonksiyonlari arastiracagiz. ArcMap 10’u aginiz.

2. Gelen ekranda asagidaki gibi bos bir sayfa agilmasi secenegini secerek
OK'i tiklayiniz.

145



Q ArcMap - Getting Started

Open existing map or make new map using & template

(= Existing Maps My Templates
Recent
Browse for more. ..
(= New Maps

My Templates

= Templates
[Z-Standard Page Sizes

Architectural Pag|
IS0 (A) Page Siz
I-lmrﬂ: Amaﬁ(an i Bkt
& Traditional Layouts
Industry
usa
World
Browse for more...

|<i im | [i&] i
€:\Documents and SettingsYjozdemir\Application Data\ESRI\Desktop10.0}ArcMap TemplatesNormal,mxt
CDefallt gfodatabase Tor the mapr. T T T \ihatis this?

1 \ C:\Documents and SettingsYjozdemir My Documents\ArcGIs \Default.gdb 1

[0 not show this dislog in the future.

Acilacak olan Blank Map haritasi i¢in varsayilan bir geodatabase mevcuttur.
ArcGIS Desktop kurulduktan sonra Default.gdb cografi veri tabani otomatik
olarak olusturulmakta ve katmanlarin kaydi sirasinda varsayilan olarak bu
geodatabase kullaniimaktadir.

Default.gdb’ye Catalog penceresindeki (st menlden kisayol olarak
ulasilabilir. Bos harita Uzerinde kullanicinin bos bir geodatabase acmasina
gerek kalmadan kendisi varsayillan olarak bu geodatabase igerisinde
katmanlari olusturabilmektedir.

Catalog B x
=1 =
¢ & W@ g | %

ion: - v
T @Go To Default Geodatabase L—[_]

= ﬁ Home - My Documents\ArcGIS
E3 Addins
£ Packages
L3 pefault.adb
@ Toalbox, thx
E3 Folder Connections
@ Toolboxes
{3 Database Servers
5l Database Connections
53 GIs Servers
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3. ArcCatalog m penceresini aginiz. Bir dnceki uygulamada rektifiye
ettigimiz raster lizerinde veritabani olusturmak icin;
Folder Connections klasoriinlin altinda
C:/ArcGIS10_EGITIM/Uygulama_07/REC_f22d22d3c.tif dosyasini
Table of Contents’e siriikleyip birakiniz.

Catalog q
@ro el @ Eo ol 4"
Location: | REC_F22d2243c1.4F o

=] @ Home - ArciGIS 10_EGITIMYJygulsma_07
B r22d22d3c.6f /
(&) F22d22d3c_Pafta.shp /
B8 f22d22d3c_rec.tif y
[ Rec_fead2adicnif
Uygulama_07.mxd /
= 3 Folder Connections ]
=
= E3 Cr\ArcGIS10_EGITIM
5 Uygulama_01 /
E3 uygulama_nz I
5 uygulama_o3 /
E5 Uygulama_o4
E5 Uygulama_05 /
B3 uyoulama_os I
= £ uygulama_o7 /

B f22d22d3c 4F

(B F22d22d3c_Paftz.chp /
R C R |
[E2] REC_f22d22d3c 1. tif )
- guﬁ_ﬂaﬁj?mx? -

4. Default.gdb izerinde mouse’un sag tusuna tiklayarak New > Feature
Dataset’i tiklayiniz. Feature Dataset; ayni projeksiyon sisteminde
olusturulacak birden fazla feature class icin kullanishidir. Name
kismina f22d22 yaziniz. Next’i tiklayiniz. Koordinat sistemi ayarlarini
asagidaki gibi Import ederek aliniz. Diger ekranlarda da Next’i
tiklayiniz. Finish'i seciniz.
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E3 addins

L
& Tooly (3 Cony
B [EH Folder g =
B £ C\ar %
By

Refresh
Bu
Eu
[P Feature Dataset... | New 4
[ Feature Class... Import r
- Table... Export »
% Relationship Class... Compress File Geodatabase. ..
I 88 Raster Catalog... Uncompress File Geodatabase. ..
| @ Raster Dataset... l:_|] Compact Database
| % Mossic Dataset.. G5 Publish to ArcGIS Server...

3

L

Distributed Geodatabase 3
Toalbox Item Description. ..

Address Locator...

3 [m

Properties. ..

Composite Address Locator, ..
- — - Qe

w

Choose the coordinate system that will be used for X coordinates in this data.

Geographic coordinate systems use latitude and longitude coordinates on & spherical madel
of the earth's surface, Projected coordinate systems use a mathematical conversion to
transform latitude and longitude coordinates to a two-dimensional linear system.

MName:

s —
[#-[F Geographic Coordinate Systems I ’
=

[ Projected Coordinate Systems
@ <Unknown> MNew 7

‘Browse for Coordinate System .
Look in: |E Uygulama_07 “’I & 3 &

2 F33 2303 Pafta.sho)
22d22d3c_rec. tif
EC_f22d22d3c1.tf

Name: F22d22d3c_Pafta.shp Add

Show of tYPE! | Geographic datasets |V] [ Cancel ]

5. Olusturdugunuz f22d22 feature dataset’i icerisinde bu pafta lizerinde
sayisallastiracagimiz katmanlari olusturmak igin sag tiklayiniz New >
Feature Class secenegine tiklayiniz. Yeni olusturacagimiz Imar Cephe
¢izgi katmani igin ayarlar asagidaki gibi yapiniz. Imar Cephe
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katmaninin ¢izgi olmasini istedigimiz icin Type se¢enegi Line Feature
olarak ayarlanmistir. Next'i tiklayiniz.

# Catalog n
-2 2@ |E (&%
Location: 'ﬁ f22d422

Bl (& Home - My Documents\ArcGlS
B3 addins

= LG Default.gdb New Feature Class
[=1] F2od20 e g
& Toolbox @ Copy Name: Imar_Caphe 1
& E3 Folder Conn o ™ o e ——————— -
B eI Cwe] | e ___ Lo
B3 uya oe \
B uye AT Type of features stored in s festurs ciass
yal ==
B Uyay & Refresh Line Features ~]
B3 uyg :
& g S U e g
||J Feature Class. ., | New »
% Relationship Class. .. Import »
) Export 3
5] Compress File Geodatabase...
> Geomstry Properties
Hl Topology... T e S [ Coordinates include M values. Used o store route data
Parcel Fabric... [ Coordinates include Z values. Used to stors 30 data
) Geometric Netwark... Add Global IDs...
[E= i S TR
£ 0\ces, ‘Ej Item Description...
& Toobaoxes f| Properties...
) (77 natan

6. Default.gdb lzerinde veri depolama secenekleri “Use configuration
keyword” oOzelliginden istege gore degistirilebilir. Hicbir degisiklik
yapmadan Next'i tiklayiniz.

7. Grafik veriye ait sozel bilgiler icin bu kisimda 6znitelik field baglklari
olusturulacaktir. Imar_cephe feature class’ina veri girisi yapilirken
hangi Ozniteliklerin veri tabanina eklenmesi isteniyorsa basliklari bu
secenekte eklenir. Bu katmana ait field tanimlamasini asagidaki gibi
yapiniz.
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T . kv |

Specify the database storage corfiguration.
- Corfiguration Keyword
(&) Default
This option uses the default storage parameters for the new
tableAfeature class.
(O Use configuration keyward
This option allows you to specify a configuration keyword which

references the database storage parameters for the new
table/feature class

About Corfiguration Keywords

Field Name Data Type
OBJECTID Object ID
SHAPE Geomet
Cephe_Tipi

8. Finish’i tiklayiniz. Catalog penceresinde Default.gdb > f22d22 feature

dataset > Imar_Cephe ¢izgi feature class’ini olusturmus olduk. Heniiz

olusturulan Imar_cephe Table of Contents’ de dogrudan eklenmis

olarak gelmektedir.

Bacleosis olr|oBlealnlosos

Fle Edt Wew Gockmarks Insert Gelecton Geoprocessng  Cussomae  Windows el
HRT=Y " TGN ] ""JQ-.’I;“ [ae]
{ Georetwancng - Lavers S Rz 1

= B mEc_fradgniesf

e
. Hgh - 255

Low: 80

-V!'[uﬁ EI

-

& [ Home - Al 10 DGITMUyguans 07

e LRl - a%
Lesaton: |[=] brar _Ceore

=YL T —
= g

# B o_aaurz garms
# [ wrcgs
# B0 arcntdio_EotToe
# [ aenos EOITIM
# 2 cTen
S [ Documents g Settngs
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9. f22d22 feature dataset Uzerinde tekrar sag tiklayarak New > Feature
Class’i seciniz. Ayni islemler Imar_Alan katmani icin de yapilacaktir.
Ayarlamalari asagidaki gibi yaparak Imar_Alan alan katmanini
olusturunuz.

New Feature Class ﬁ

(—— = ——————

Name Imar_Alan '

= m m ——— ==Y

el e e e
G Type \
I Type of featurss stored in this featurs class: I
1 | Polygon Features v‘ 1

N o e o oo o o e e e e e

Geometry Propertiss
[[] Coordinates include M values. Used to store routs data
[ Coordinates include Z values. Used to stare 3D data.

T

New Feature Class ﬁ

Field Name | Data Type
[oBJECTID | object D
[ |share Geometry
;irazi_KuIIanlm [Text
: On_tahcs' |Double
[|van_bance |Double

10. Direkler(Point) ve Binalar(Polygon) katmanlarini asagidaki sekillerde
olusturunuz.
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New Feature Class
Field Name | Data Type |,4\5
[OBJECTID | Object D =]
|_|SHAPE Geometry
| |Tipi Text
|| Gucu Text
Direkler katmani igin
New Feature Class
Field Name | Data Type [[]
loBJECTID | object ID
| | SHAPE Geometry
| ] Text
| filcs Text
| | mahalle Text
| jAdi Text
| | Mo Short Integer
| | Kat_sayisi Short Integer

Binalar katmani ic¢in

11. En son olusturulan katmanin 6znitelik field basliklarindan SHAPE'i
yanindaki gri kiglk kutucuga tiklayarak seciniz. Secili olan Field
Name’e ait Ozellikler pencerenin altinda goriintiilenecektir. Shape

field'1 olusturan geometri O6zellikleri

gorintilenmektedir.

Field Properties kisminda

| Field Name

| Data Type |
QBJECTID Object ID
(S [Geomety |
| | tipi

Text

Field Properties

Aliaz SHARE
Allow NULL values res
Geometry Type Point
Grid 1 0

Grid 2 0

Grid 3 0

Bu islemler ile veri tabani tasarimi

sonra pafta sayisallastirilacaktir.

gerceklestirilmistir.Bu asamadan
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Uygulama 9 : Veri Girisi ve Giincelleme

Olusturulan veri tabanina veri girisi yapma islemine sayisallastirma
denilmektedir. Sayisallastirma islemi ESRI vektor veri tipleri olan Shapfile ve
Geodatabase Feature Classlara ait gerekli glincellemelerin yapilarak veri
tabanina s6zel bilgilerinin de eklenmesini icermektedir.

ArcGIS 10 versionundan itibaren glincelleme islemi igin kullanilacak Editing
araglari gugclendirilerek gelistirilmistir. Arttk CAD kabiliyetinde g¢izimler ¢ok
daha rahat bir sekilde yapilmaktadir.

1. Bir oOnceki uygulamada Default.gdb icerisine olusturdugunuz

katmanlar ve Rektifiye ettigimiz althik raster
verinin(REC_f22d22d3c.tif) halen ArcMap’te bulundugundan emin
olunuz.

2. Standard ara¢ gubugunda bulunan Editor ara¢ ¢ubugunu agmayi

saglayan Editor Toolbar aracini tiklayiniz. Vektor veriler tzerinde
glincelleme yapmamiza olanak saglayan Editor ara¢ ¢ubugu ekrana
gelecektir.

3. Katmanlar lzerinde veri girisi yapilmasi islemini baslatmak icin Editor
> Start Editing’i tiklayiniz. Ekrana Create Features penceresi
gelecektir. Bu pencere ile veri girisi yapilacak katmani segerek ekran
Uzerinden sayisallastirma yapilmaktadir.
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et Lo Ll N et 0 LA

1 5*| Start Editing [
- - —— -
I

4
'

K,

Snapping 3
Mare Editing Tools 13
Editing Windows 3
Options...

4. Create Features penceresindeki Imar_Alan polygon katmanini
seciniz. Imar_Alan katmani secildikten sonra asagida Construction
Tools seceneginde Polygon’u seginiz.

T - <Search> |z (@Y 36U
_ Binalar
DBinaIar
Direkler
- BCGI‘I struction Tools
& Dirgkler
—_—_——m -
1 imar_alan 1| || 163 polroon
1 | [] Rectangle
Im 1 O Circle
\Imar Cephe — - - - - < El
mar_Cephe Ellipse
—Imar_Cephe 2, Freehand
I0%| Auto Complete Polygon
=]
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Data View ekraninda pafta Gzerinde imar alani olarak
sayisallastirilacak kenar kisimlara mouse ile tiklanarak cizim yapilir.
Feature olustururken tiklanilan her noktaya vyesil renkli atilan
noktalara Vertex adi verilmektedir. Vertexler ile ¢izimi istenilen
sekilde degistirebilirsiniz. Bunun i¢in ¢izim sirasinda Feature
Construction ara¢ ¢ubugu ekrana gelmektedir. Cizimi sonlandirmak
icin klavyenizden F2 tusuna basiniz.
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6. Benzer sekilde Imar Alan gizimine devam ediniz.

- oA {19

7. Cizimi yaparken Editor ara¢ ¢ubugu lizerinde bulunan Attributes

aracini D tiklayiniz. Acgilan Attributes penceresi saklanabilir olarak
ekrana gelmektedir. Oznitelik degerleri ekranda secili olan feature
icin doldurulur. imar alan olan vyerleri sayisallastirmayi ve &znitelik
bilgilerini doldurmayi stirdiriniz.

Attributes B x

EHINER

=] ‘Q’ Imar_Alan
L@ Agk Alan

B

OBJECTID &

= el — i A = - — \
‘fan_bahce <Null = 1
TEHAPE Length &7 =
SHAPE_Area 12035, 324064

¢ -

8. Create Feature saklanabilir penceresini cagiriniz. Binalar katmani
seciniz ve pafta Uzerindeki binalari sayisallagtirarak veri girisi
yapmaya baslayiniz.
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Tév <Search> = (@) 30

5

g,
EI'IHEI‘ _____ 8_

! g EConstructiun Tools

[ inal=r 1 |
Direkler i |Q Polygon

w
o Direkler g [] rectangle

=
Imar_Alan ﬁ o Circle

3 )
[imar_alan g (> Ellipse

= Freehand
Imar_Cephe B_ %

Auto Complete Polygon

— Imar_Cephe @ I P ¥a

(o]

@

)

T

g

g

B

=

'U_'

[¥][1]

9. Pafta Uzerinde bina sayisallastirmaya baslayiniz. Cizim yaparken
acllan Feature Construction penceresindeki yardimci ¢izim
elemanlari kullanilacaktir. Asagidaki gibi binaya yakinlasiniz ve ¢izim
yapmaya baslayiniz, Constrain Perpendicular aracini secerek dik
cizmek istediginiz cizgiyi seginiz. Ayni ¢izgiye devaminda paralel
¢izmek icin Constrain Parallel aracini secerek ¢iziniz.
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Constrain Parallel

Cizimi bu araclarla strdiriniz ve F2ye basarak(yada mouse’a ¢ift tiklayarak)
¢izimi sonlandiriniz.

10. Create Feature saklanabilir penceresini tekrar ¢agiriniz. Imar_Cephe
katmani seginiz. Construction Tools seceneginde cizgi feature gizimi
yapmayi saglayan araglarin geldigi gértlmektedir. Line’ seginiz.
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T

=
=
Binalar =
g
[ ginalar )
Direkler [%‘
ki o
o W
¢ Direkler : Cunstructiun Tools
=
Imar_Alan = |/' Line
=
[ ]imar_Alan o O Rectangle
i o Cirde
Imar_Cephe E (" Ellipse
o EEm mmm mem e e e e e e e e e
1 Freehand
—EEa . 4
e e e o e o o e o o o = o (9]
@
o
(1]
=
(1]
=
E
(7]
]
z

Pafta Uzerinde sayisallastirmak istediginiz imar cephesine yakinlasiniz ve ¢izim
yaparak Oznitelikleri doldurunuz. Cizimi tamamladiktan vertexleri
goruntilemek ve gizimde degisiklik yapmak igin ¢ift tiklayabilirsiniz. Vertexler
gorintilenirken Edit Vertices ara¢ cubugu ekrana gelir. Vertex Uzerindeki
degisikleri buradan yapabilirsiniz.

Attributes B X
B > Imar_Cephe
LR

Y

OBIECTID 1
1

SHAPE Length
N — -

—_—— i — |
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11. Yapilan glincelleme islemlerini kaydetmek i¢in Editor aragcubugunda
Editor > Save Editing segenegini tiklayiniz. Giincelleme islemini
sonlandirmak icin Editor > Stop Editing aracina tiklayiniz. Boylece
veri tabanini olusturdugumuz katmanlara veri girisi yapilmistir. Daha
sonra bu verilere ekleme ya da dlizenleme yapilmak istenildiginde
Start Editing se¢cenegini secerek ara¢ cubugunu aktif hale getirmemiz
gerekmektedir.

Editar =) | » | » Editor = | » | *

"7 | Stop Editing

"7 Stop Editing
|F“ Save Edits | G Ssave Edits

12. ArcMap’te calisilan projeye daha sonra ayni semboloji ile devam
etmek isteniliyorsa MXD olarak kaydedilmesi gerekir.
File > Save As seciniz. Projeyi C:/ArcGIS10_EGITIM/Uygulama_09
klaséri icerisine F22D22.mxd olarak kaydediniz ve ArcMap’i
kapatiniz.
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Uygulama 10 : Veri Giincelleme ve Sayisallastirma Kabiliyetleri;

Bu uygulamada, veri glincelleme islemi sirasinda sayisallagtirma islemini
saglayan bazi ileri dlizey araclar gosterilecektir.

1. Baslat > Tim Programlar > ArcGIS > ArcMap 10 secerek
C:/ArcGIS10_EGITIM/Uygulama_10 klasériinde bulunan
Uygulama_10.mxd dosyasini aginiz.

8  ArcMap 10

2. Editor ara¢ cubugunu ¢agiriniz ve Editor > Start Editing’i seciniz.
Binalar katmanindaki cizilmis bazi featurelari olmasi gereken
koordinatlara tasimak i¢in Editor aragcubugu lzerindeki Edit Tool

.

aracini  segerek feature Uzerinde tiklayiniz. Mavi renkte

secili hale gelen feature’t mouse ile tutup harita lzerindeki
koordinatlarina tasiyiniz.
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3. Farkli yonde dondirilmis featurelarin Rotate aracini = =
kullanarak dogru agiyr almasini saglayiniz.

4. Create Features saklanabilir penceresinden Binalar katmanini
secerek sayisallasmamis iki adet binayi ekran tzerinden mouse ile
tiklayarak sayisallastiriniz.  Sayisallastirma islemini yaparken
Constrain Parallel ve Constrain Perpendicular araclarini
kullanarak ¢izim yapiniz ve F2’ye basarak ¢izimi sonlandiriniz.
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[Parseller

@Ml Constrain Parallel

e

Cizdigimiz binalarin bulundugu yere ait parselin araziden alinan
koordinat ve olcim degerleri bulunmaktadir. Bu degerler ile
Parsel sayisallastirma yapilacaktir.

5. Create Features penceresinde Parseller katmanini seginiz ve Data
View ekraninda mouse ile sag tiklayarak “Absolute X,Y”
secenegine tiklayiniz (Klavye kisayolu F6’dir). ilk noktanin X ve Y
koordinatlarini asagidaki gibi yaziniz. Enter’a basiniz.

Z Create Features rx
EE' <Search> 7 (@) &

Binalar

Fginalar

Parseller

[Jparseller

437263.300

4416873, 280
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6. Harita Uzerinde girilen koordinatlara vertex atilmis olarak
gelmektedir. Bu vertex’e gore agi ve mesafe degeri girilerek ¢izim
yapilacaktir. Bunun icin mouse ile sag tiklayarak Direction/Lenght
secenegine tiklayiniz (Klavye kisayolu Ctrl+G’dir). Asagidaki
degerleri yazarak Enter’a basiniz.

Absolute X, ... Fa . 0
Direction/Lengt
Delta ¥, ¥... Ctrl+D / =
— 255 11§
Direction/Length... Cirl+3

Parallel Cirl+P

7. Parsele ait lglinci noktaya ait koordinat degeri bilinmektedir.
Klavyeden F6’ya basarak asagidaki degerleri yaziniz ve Enter’a
basiniz.

Absolute X, ¥ =
o 437245.146 d |
v 4415767, 144

8. Parsele ait dérdiinci nokta belli bir egimle cizilecektir. Bunun igin
mouse ile sag tiklayarak Tangent Curve segenegine tiklayiniz ve
asagidaki degerleri ayarlayiniz. Enter’a basiniz.

Tangent Curve =]
Parallel Ctrl+P -
y Arc Length | | 110
Perpendicular Ctrl+E !
Segment Deflection... F7 Radius v 240
Replace Sketch O Left () Right
Tangent Curve...

9. Dordiincli noktaya gore belli bir a¢ci ve mesafe degerine gore
besinci son nokta belirlenecektir. Klavyeden Ctrl+G’yi tiklayarak
asagidaki degerleri giriniz. Enter’a basiniz.
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10. Cizimi bitirmek icin F2’ye basiniz.

11. Parsel c¢iziminde degisiklik yapmak icin Vertexler Uzerinde
degisiklikler yapilir. Degisiklik yapmak icin katman lzerinde sag
tiklayarak Edit Vertices secip Sketch Properties penceresini
acgabilirsiniz.

=K ¥
[1 o 487263300 4416873.280
[0t 487371707 4415844,935
[1 2z 487352548 4416785.969
[ 3 487245.14 4416767, 144
[ 4 487233.53% 4416762.199

% Paste

X Delete

@ 1dentiy...
Zoom To Selected Features

g’ﬂ Pan To Selected Features

[d| Clear selected Features

Edit Vertices

El| attributes

12. Olusturdugumuz parsel katmaninin 6znitelik bilgilerini doldurmak
icin Attributes Table’i aginiz ve ParselRef field’ina 1 yaziniz.
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=2 ‘@ Parseller
@ 194
= L
paste OBJECTID_1 194 =~
OBJECTID <Mull>
Delete Delete ParselRef 1
Identify... UretimSekl <MNull>
ADANG <mull>
Zoom To Selected Features PARSELNO <Mull>
Pan To Selected Features AREA <Ml
Clear Selected Features PERIVETER <>
PARSEL _ <Mull>
Edit Vertices PARSEL_ID <Mull=
Attributes WERI_TIP <Mull> i
DURUM <Mull= 3
MAHKOY <Mull>

13. Cizerek olusturdugumuz parselin izerinde bulunan 9 adet binayi

Edit Tool k ile seciniz. Secili olan tim binalar ayni parsel
referans degerine sahip olduklarindan dolayi ParselRef Oznitelik
degeri ayni olacaktir. Oznitelik tablosunda ayni degeri toplu
sekilde yazdirmak igin Binalar katmani Uzerinde sag tiklayarak
Open Attributes Table’'i seciniz. Agilan Table penceresinde
sadece segili olanlari gostermek icin pencerenin en altinda
bulunan Show Selected Records segenegini seginiz.

fir S8t vew  Socews  eet Seecten  Gosoraceieng  Csomoe  Windees e
Y . 1190 A EERED =,
af; e
By | ! &
4 £
(]
= =
HH i
3 |
- &
. -a-';. 230m Ta Laver :
L - =
x Vater Sanis Range
e Syt v
° -
= e e
- Bt Featres
g U ot Fastres 8 e
L3
gt Duta
=
al
L3 1 *
"o e M JE[_‘[.MJJEW;
= CJ
Open aTEne taiee S Tv nper AT “r’l-'f'lh.l
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14. Binalar 6znitelik tablosunda ParselRef Field’ini bulunuz ve bashk
Uzerinde sag tiklayarak Field Calculator'u seginiz. Sadece segili
olan objeler icin islem vyapacak olan Field Calculator
penceresinde 1 yaziniz ve OK'i tiklayiniz.

Table
ERAE=RAL R B R S
Binalar
Shape_Length | Shape_Area | Pare—tees T oine |
| 63.330193|  213.526869 = SortAscending
| 63.186607 213.872602 = | Sort Descending
52.345074 227 559834
| 62.34807 222659834 | <Null= Advanced Sorting...
n 63.394899 2144584081
n 63.742733 215.920196 summarize. ..
n 63.035291 214150136 T Statistics...
n 63.127585 213.053962 (o
| 62.707839 211.481818 L Field Calculator... J,
n 64.052585 226575464 | <Null> Calculate Geometry...
i Field Calculator
Parser
(VB Seript O python
Fields: Type: Functions:
LRI [ @orber
g R
Bagimsiz_B Opate
Mahalle
Sokak_Adi
Shape_Length
Shape_Area
ParselRef
BinaRef
ijsh = > ParselRef §
o Cadeblod)
[D=em HOEEO0E i
] 1 1
N — = !
1
1
1
1
1
[ clear ] [ oz, ] [save.. ] [ b ] 1

Editing islemi sirasinda gorintliyl oynattigimiz zaman altlik olarak kullanilan
raster veya diger katmanlarin tekrar ekranda acilma hizi veri boyutuna gore
yavas olarak gelebilmektedir. Bu islemi hizlandirmak igin ArcGIS 10
verisonundan itibaren Basemap Layer’lar olusturulabilmektedir.
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15. Layers veri gercevesi Ulzerinde sag tiklayarak New Basemap
Layer’i seciniz. Table of Contents’e gelen New Basemap Layer’a
Ankara.img althk raster veriyi stirlkleyip birakiniz.

Table Of Contents 7 x B Table Of Cantents 1 x
-l & -l = Layers
E [d,'? Add Data... = O Yol_Orta
&E-j,é New Group Layer -
= &|§L§i Mew Basemap Layer | = Binalar
£
- Parseller
1
- -
= ankara.img RGE
RGE Mr=d: Laver_i
M red: Layer_1 [ Green: Layer_2
I Green: Layer_2 MELs: Layer_3
M Elus: Layer_3 INew Basemap Layer

16. Yol_Orta ¢izgi katmanini aginiz. Gorintilenebilirligi aktif olarak

gelen katman Create Features penceresinde de gorintilenebilir
olarak gelmektedir. Yol_orta katmanini Cizgi cizim seklini sececek
sekilde tiklayiniz. Asagidaki gibi yol katmani gizilecek olan kisma
yakinlasiniz. Kesisim noktasina yakinlastiginiz zaman otomatik
yakalama(snap) yapmaktadir. Kesisim noktasini tiklayiniz ve yolu

Gorintliniin  ekrana sigmadigl yerde
althik
ayarladigindan dolayr hizli
Snapping islemlerini 6zellestirmek icin Customize > Toolbars >
Snapping arac cubugunu cagirabilirsiniz.

asagidaki gibi ciziniz.

raster veri Basemap olarak

bir sekilde ekrana gelmektedir.

ilerletme yaparken
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17. Gincelleme islemi tamamlandiktan sonra Editor ara¢ cubugu
Uzerinde Editor > Save Edits’i ve ardindan Editor > Stop Editing’i
seciniz. Projeyi kaydederek ArcMap’i kapatiniz.
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Uygulama 11 : Diger giincelleme araglari;

Cografi Bilgi Sistemlerinin pargasi olarak gincelleme isleminde yapilacak
islemleri kolaylastiracak farkh fonksiyonlar mevcuttur. Editing araglari olarak
adlandirilan bu fonksiyonlar ile vektor veri olusturmada kolayliklar
saglanmaktadir.

1. Baslat > Tim Programlar > ArcGIS > ArcMap 10’u aginiz. Uygulama
verisetleri icinde bulunan C:/ArcGIS10_EGITIM /Uygulama_11
/Uygulama_11.mxd’yi aciniz. Acgilan haritada Parsel, Refuj, Elektrik
Direkleri, Elektrik Hatti katmanlari Table of Contents menusine
gelecektir.

2. Editor ara¢ gubugu bir 6nceki uygulamada araylize eklendigi igin

ekrana gelmistir. Eger gelmediyse Editor ara¢c c¢ubugunu 4
tiklayarak c¢agiriniz. Editor > Start Editing’i secerek glincelleme
islemleri icin Editing ara¢ cubuklarini aktif hale getiriniz. Acilan Create

Features penceresinin sag Ust kosesindeki Auto Hide aracmln
tiklayarak pencereyi saklayiniz.

Editor ~jf = * i

| ## Start Editing

3. Refujlerin olusturdugu yolun ortasindan elektrik hatti gegmektedir.
Refuj’e paralel olacak sekilde Elektrik Hatti feature’t kopyalamak igin
once Refuj katmanindaki hangi feature’a paralel olusturmak

s seciniz. Editor arag

isteniyorsa, onu Edit Tool araciyla
c¢ubugunda Editor > Copy Parallel secenegini seciniz. Acillan Copy
Parallel penceresinde asagidaki ayarlamalari yapiniz. OK’i tiklayiniz.
Bu ayarlar ile secili refuj feature’inin 4m ok yoniine gore sag tarafina

elektrik hatti feature’i kopyalanacaktir.
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B

"7 Stop Editing

Save Edits
Mave...

split...

|...E Construct Points. ..

| Editor v)l e P, |7|.|"'!

[__Template.. | [ refu

|vix Copy Paralll...

Create a new feature for each selected line

/|Remove selfintersecting laops

4. Olusturulan elektrik hatti feature’ini Edit Tool araciyla
Elektrik hatti

-

Uzerine 10 metre araliklarla elektrik direkleri

seginiz.

yerlestirilecektir. Bunun icin Editor > Construct Points secenegini
seciniz ve asagidaki sekilde ayarlamalar yaparak OK'i tiklayiniz.

Editor =fl| & | Pa | 7 27 4
e
®/# Stop Editing

Save Edits

Mawe, .,

Split...
l |+%  Construct Points. ..
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[ Templte.. || ¥ Eiekmikoirea

Line Length: | 133.176

~ Construction Options

() Number of Paints

(%) Distance 10
- = m— = = = - -
by Weasire g ininininke

[Jcreate additional points at start and end

~ Orientation
(3) From Start paint of Line

(") From End poeint of Line

Table Of Contents ax

ERERTR-N= ‘

= £ Layers
[ER R Elektrik Direkleri

¥

= Refuj

& [ Elekirik Hath
= [ Parsel
|

5. Birden fazla feature’ birlestirerek tek bir feature haline getirmek igin
Merge araci kullanilmaktadir. Asagidaki gibi birden fazla parsel’i Edit
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Tool * ile seciniz. Editor ara¢ c¢ubugunda Editor > Merge
fonksiyonunu seciniz. Agilan pencerede birlestirme sonucunda hangi
feature’in 6znitelik tablosundaki bilgiler alinmasi istenildigini secerek
OK'i tiklayiniz.

editor <[ » [P | 7 7
74l Start Editing

®/# Stop Editing

Save Edits

Move...

6. Create Feature penceresinden Refuj cizgi katmanini seginiz. Editor
ara¢ cubugunda bulunan Trace aracini seginiz ve parsellerin sol
tarafinda mouse ile tiklayarak refujun agilacagi gilizergahta sadece
mouse’u hareket ettiriniz ve bittigi tarafin disarisinda mouse ile ¢ift
tiklayarak ¢izimi sonlandiriniz.
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el GemE i Es0r cBlieunzos0s

7. Cizilen Refuj etrafindaki parselleri belli bir mesafede kesmek icin Clip

fonksiyonu kullanilmaktadir. Editor ara¢ cubugunda Clip aracini
seciniz ve asagidaki degerleri yazarak OK’i tiklayiniz.

Start Editing
Stop Editing
Save Edits
Mave...
split...
Construct Points...
Copy Paralel...
Merge...

Buffer...

Union...
Clip...

—

w I Buffer Distance: I_—I- i OK i

] Snapping v < |
e ——— Wi e == = = =
More Editing Tools 3 ping Teafes
Editing Windows N () Preserve the area that intersects

] mensi (%) Discard the area that intersects

R ——

8. Editor arag¢ ¢ubugundan Save Edits ve Stop Editing ile kaydederek
glincellemeyi sonlandiriniz. Projeyi ayrica mxd olarak kaydederek
ArcMap'i kapatiniz.
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Uygulama 12 : Veri Donuisiim Fonksiyonlari;

DWG,DXF ve DGN gibi ¢ok kullanilan CAD formatlari ArcGIS teknolojisi
GrlGnleri  ArcView,ArcEditor ve Arcinfo vyazihmlarn ile direk olarak
goruntilenebilmektedir.

CAD veri formatinda depolanan vektér veri yapisini farklh yontemler
kullanarak ArcGIS vektor veri formatlarina c¢evirmek miimkindir.CAD
formatlarinin, ESRI Shape file ve Feature Class donlisiim islemleri ArcMap ve
ArcToolBox araylzlerinde bulunan fonksiyonlar sayesinde daha pratik ve
esnek bir sekilde yapilabilmektedir.

Ozellik tipleri Line,Point,Polygon ve Annotation olan bir ¢izim dosyasinda
depolanan CAD veri formatlarinin, cografi detaylari ise CAD formatlarinda
(DWG ve DGN) Layer ve/veya Level'larda siniflandirilarak sayisallastirma
islemleri gercgeklestirilir.CAD verileri ArcGIS teknolojisinde asagidaki sekilde
temsil edilmektedir.

= 5 Uygulama 11
= &g 1022.dgn
iEl Arnotation
(B MultiPatch

(%] Point

= Folyoon

(=] Polyline

Mame Type

:E Annotation CAD Annotation Feature Class
[#]MultiPatch CAD MultiPatch Feature Class
[ Paint CAD Point Feature Class
[2]] Polygon CAD Polygon Feature Class
= Palyline CAD Polyline Feature Class
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ArcMap 10 araylzinu aginiz.

8  ArcMap 10

ArcGIS10_Egitim/Uygulama_12 dosyasinda yer alan
Uygulama_12.mxd’yi aginiz. (Bu uygulama igin 1022.dgn verisinin
Polyline, Polygon ve Point katmanlari Add Data butonu ile ArcMap
ortamina eklenip mxd olarak kaydedilmistir.)

3. Table of Contents’de bulunan 1022.dgn Point ve 1022.dgn Polyline
katmanlarinin  visible  gekini kaldirarak  goérinmez  hale
getiriniz.1022.dgn Polygon lizerinde mouse ile sag tiklayip Katman
Ozellikleri (properties) penceresini seginiz.

[
Table Of Contents 1 x g H £ 84
- - = = Layers
M £ @ 3] = O 1022.dgn Point
=l = Layers il = D’lﬂzz‘dgn Polyine
= .1022.dgn Pairit & .@ .
X Remove

= 1022.dgn Polyline

=] 1022.dgn Polygon
[

g Open Attribute Table

Joins and Relates 3

{J.‘/ Zoom To Layer

Visible Scale Range »

Use Symbaol Levels

Selection 3
Label Features

Convert CAD Feature Layer...
Convert CAD Feature Dataset...
4] Convert Labels to Annotation, .
S| Convert Features to Graphics...
Data 4
<> saveas Layer File...
;-',) Create Layer Package...

[“f Properties...
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4. Acillan pencerede

Drawing

Layers sekmesinde,tim katman

ozelliklerini Disable All butonuna basarak kapatiniz.

Layer Properties

| Genesl | Souce | Selection | Display | Symbology | Fields | DefiniionGuery | Labels
Drawing Laysrs ; Joins & Relates Transformations HTML Popup

Choose which drawing layers will be visible:

Layer MName Calor Line Style lA Enable Al

o o ® sod dp=====
1 ® Solid (7 Disablz Al I

2 ® Solid T

4 ® Solid

5 ® Solid

7 ® Selid Apply to Dataset

g ® Solid

9 ® Solid

10 ® Solid

1 & Solid P

12 Y Solid e

[« ] m | [2]

(0] ][ Cancel

5. Daha sonra Layer 25 katmaninin c¢ekini atarak Enable durumuna

getiriniz. OK butonuna tikladiginizda Polygon o6zellik tipini tasiyan
Layer 25 katmaninda gizilen binalari harita sayfasinda gorecesiniz.

177



Layer Properties m
| Genesl | Soue | Selsion | Displsy | Symboboy | Fields | DefiitionGusy | Lsbels |
Drawing Layers Joins & Relates 1 T \ I HTHIL Popup | @0 N g@ P o
$. G e,
Chosse which draving layers wil be visible: SN Q;%QO !
: G
Layer Name Color | Line Style [a] [ Emblea s 0@9
Oz ® G .52, Q@Q@Q
Oz ®  od %0 g ag o%
S Dﬁqﬁ%&gﬂ
G e  Gud = (Mo = = = = %CIP magmﬂ:l:j
Eg e el Tt i E‘ géfj =y )
7 e o = | perre— o]
D= s bl glf ifay
0= [ g8 '
O ®  Sod e HE B
O ®  od o= = Bpe e
0= ° Solid 0T g EF’
Oxn () Solid o@%@ & il
k] &  Soid ]
< m - | @ & O@%o

oK | [ canca ][

Apply

J

6. Table of Contents’de yer alan 1022.dgn Polygon katmani Uzerinde
mouse’un sag tusuna basiniz. Data > Export Data fonksiyonunu

seginiz.

'Of(lmtems
[5G 8|

5 & Layers
= [ 1022.dgn Paint
-

= [ 1022.dgn Palyline

= [ [1022.dgn

=] Bl

Copy

Remove

Open Attribute Table

Joins and Relates

Zoom To Layer

Visible Scale Range

Usze Symbal Levels

Selection

Label Features

Convert CAD Feature Layer...
Convert CAD Feature Dataset...

rt Labels to Anno

Convert Features to Graphics. ..

Data

T :| Repair

290

Save As Layer File...

Create Layer Package...

&

Export Data...

Properties...

Export to CAD...

Make Permanent

View Item Description. ..

Review/R
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Export Data islemi ile 1022.dgn Polygon katmaninda bulunan tim
objeleri katmanin sahip oldugu koordinat sistemini koruyarak
Shapefile veya Feature Class’a ¢cevirmek mimkindir.

—
7. Browse @] aracina tiklayarak bilgisayarinizda dosyanin
kaydedilmesini istediginiz yeri belirleyiniz.

Export Data E]

Export: | All features B

Use the same coordinate system as:
() this layer's source data
(O the data frame

Saving Data
Loak in: B Uy = 5 =3 [
Output feature dass: L = i e B D &
Co\destek ogm'\Export_Outputshp V& Parsel_Kose_Excel.xis

MName: hina.shp Save
Save astype: | shapefie | Cancel

File and Personal Geodatabase feature dasses

hapefile
SDE feature dasses % s 4

Olusturulmasi distinilen bina katmani bliyik 6lgekli harita uygulamalarinda
alansal vektor (Feature Type:Polygon) tipine sahip olmalidir.CAD ortaminda
cizilen objeler igin ise yukarida anlatilan islemler sonucunda alansal vektor
tipi elde edilebilir.CAD ortamindaki alan ifade etmesi istenen objeler Close
Polygon olarak cizilir.Cografi Bilgi Sistemleri icerisinde alan olarak
tanimlanmasi  istenilen CAD verileri ¢ogu zaman polygon olarak
tanimlanamaz.Bu veriler CAD ortaminda genelde Polyline olarak dretilir.Bu
verilerin Polyline olarak tasarlanmis yapisini Export islemi ile Line vektorel
tipine cevrilir.Bu islem sonucunda verilerde ¢izim hatasi var ise hatalar
dizeltmek ve c¢izgi Ozelligini daha sonra alan o0zelligine donustirmek
gerekecektir.Bu bolimde dontisiim islemleri uygulamal olarak islenecektir.
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8. Table of Contents’de yer alan ve daha 6nce visible ¢ekini kaldirdigimiz
1022.dgn Point ve 1022.dgn Polygon katmanlarinin geklerini tekrar
aktif hale getiriniz.1022.dgn Polyline katmani Gizerinde mouse ile sag
tusa tiklayip Properties secenegini seginiz.

Table Of Contents X

[Haos o

=

ayers
=] 1022.dgn Point

>
» &

= 1022.dgn Polyad X
- =

Copy

Remove

Open Attribute Table

Joins and Relates 3

Zoom To Layer

o

Visible Scale Rangs 3
Use Symbol Levels

Selection 3
Label Features

Convert CAD Feature Layer...

Convert CAD Feature Dataset...

"% Convert Features to Graphics. ..

Data r
( 2| Save As Layer File...
_, # Create Layer Package...

||"_*~|‘ Properties... |

9. Layer properties penceresindeki Drawing Layers sekmesini
sec¢iniz.Tum katman 0zelliklerini Disable All butonuna tiklayarak
kapatiniz.Daha sonra Layer 61 katmaninin c¢ekini atarak Enable
duruma getiriniz.
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Layer Properties

Genersl Source Se\sc_‘l\un Dlsp_la_y
Drawing Layers f Joins & Relates

Choose which drawing layers will be visible

o
2
]

Layer Name

| O 52

a3

oy St i s

] o o o e

&

od
1
eoclepocsccccee

S}'mb__ulugj,' FIEME Definition. Qt_.IE_W que\s
Transfomations HTML Popup

Line Style [] | Enable Al

Solid

Solid Disable All

Solid |

Solid

Solid

Sl - |

Solid b |

o= —— |

Solid

OK ] [ Cancel

[ oty |

10. Table of Contents’de bulunan 1022.dgn Polyline katmani Uzerinde

mouse’un sag tusuna tiklayarak Data>Export Data fonksiyonunu

seginiz.
11. Export Data fonksiyonu ile 1022

.dgn Polyline katmaninda bulunan

tim objeleri,mevcut projeksiyon sistemine gore Shape File veya

Feature Class olarak olarak doénistirmek mimkin olacaktir.Export

—
Data penceresindeki Browse [L"_’i'] aracina tiklayiniz.

Export Data

B

Export: | All features

Use the same coordinate system as:
(®) this layer's source data
() the data frame

Output feature dass:

C:\destel\ogm"\Export_Output shp

QK ] [ Cancel
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12. 61’inci Layer’da yer alan Polyline objelerini, Uygulama_11 dosyasi
altina BinalarLine Shapefile olarak kaydediniz.
Bu asamada c¢izgi Ozelliginde gelen yeni BinalarLine katmanini

13.

fonksiyonlar

Search

Standard arag¢ cubugundaki Search aracina tiklayarak Search
penceresini aginiz.

14. Acilan Search penceresinde Tool secenegini seginiz.

15. Arama kutucuguna Feature To Polygon yazip Enter’a tiklayiniz.

Search

@ - u Local Search

Anuap | a

aLL Maps Datz  Tools

System Toolboxes

B 30 fnalyst Tools

@ Analysis Tocls

@ Cartography Tools

B Conversion Taals

@ Data Management Tools

&) Editing Tools

Geocoding Tools

Linear Referencing Tools
Multidimensicn Tools

Metworle Analyst Tools
Parcel Fabric Tools

000000000

@ Tracking Analyst Tools

Find My Custom Toolboxes...

Geostatistical Analyst Tools

Goeea ﬂ

Loueag ﬂ

poligona cevirmemiz gerekmektedir. Bu islem icin ArcToolBox’daki
Feature To Polygon fonksiyonu kullanilacaktir.
ArcToolbox’daki

kolaylikla aratilabilmektedir.

ArcGIS 10’dan
penceresinden
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Search R o
= @ = [ ‘Lccal Search [v]

ALL Maps Cztz  Tools

|feature to pol Q

J feature to polygon {data management) |

16. Listeden Feature To Polygon fonksiyonuna tiklaylp Feature To
Polygon penceresinin agilmasini saglayiniz.

17. Ayarlan sekildeki gibi yaptiktan sonra OK butonuna tiklayiniz. Cizgi
katmanindaki binalarinizin alan katmanina donlstigina goéreceksiniz.

., Feature To Polygon E]@

o]

Input Features
| 2

< »binalarline

=
x|
1
4

3

Output Feature Class
C:\Documents and Settings'\gtoreyen, ISLEMMy Documents\ArcGIS\Default.gdb'\binalarline_FeatureTo E;-
XY Tolerance {opticnal)

Bl &

0.5 | Meters
Preserve attnbutes (optional)

| ahel Features fnntinnall |V

[ QK ] [ Cancel ] [Enwronments... ] [ Show Help = > ]

18. 1022.dgn Point katmaninda yer alan noktasal verilerin birbirinden
ayirtedici Ozelligi Text Field’inda yer alan 6znitelik degerleridir. Text
Field't AGAC olarak tanimh olan objeleri Select By Attributes
fonksiyonu ile seginiz.
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Select By Attributes

Layer: |= 1022.dgn Point ﬂ
[ Only show selectable layers in this list

Method: Create a new selection V
"LyrLineVt" ~H
"RefName" R |
"LTSeale"

"Angle”

"ScaleX” |
“SoaleY” 4
ERF s )

NS Sz

D) X L

E] EIEIJI’\I‘-I v

E Go To:

Clear ][ WVerify H Help ][ Load... ][ Save... ]

Lok J[ ey J[ o ]

19. Segcili olan objeleri aga¢ katmani olarak export etmek i¢in Table of
Contents’de Point lizerinde sag tiklayarak Export > Export Data
secenegine tiklayiniz. Daha sonra Agac adi altinda veriyi Shapefile
olarak kaydediniz.

20. ArcMap’i kapatiniz.

Noktasal Ol¢iim Degerlerinin Goriintiilenmesi;

GPS,TotalStation gibi dlciim cihazlari ile elde edilen koordinat bilgileri,sayisal
olarak sistemde Dbase, Excel, ASCIl Text File gibi farkli formatlarda
depolanabilirler. ArcGIS ortaminda, bu formatlardaki verilerin ESRI vektor
formatlarina dontisimi mimkiindr.

Bu boliimdeki uygulamada X,Y koordinat degerlerinin bulundugu Dbase ve
Excel dosyalarinin, ESRI Shape File formatina donlsimi islemleri ArcMap
araylziinde gerceklestirilecektir.
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Add XY Data Fonksiyonu;

Dbase formatinda yer alan koordinat bilgilerinden, Shapefile formatinda

doénisim

gerceklestirilmektedir.

1. ArcMapl0 araytziinde bos bir harita sayfasi aciniz.

%  ArcMap 10

2. File > Add Data > Add XY Data secenegine tiklayiniz.

islemleri ArcMap araylziinde Add XY Data Fonksiyonu

File | Edit View Bookmarks Insert Selection Geoprocessing Customize  Windo
| mew... it By o | |@|
E'. Open... Cirl+0 'I ¢ Sna =}
& save crl+5
Save As...
Save A Copy...
[ AddData v adcoats...
==l Sigr E Add Basemap...
BHI arcals oniine... BH| Add Data From ArcGIs Online...
Page and Print Setup... |;"'¢ Add XY Data...
@ Print Preview.., Geocoding »
i Print... #7| AddRoute Events. ..
..ﬂ_l Create Map Package. .. ear| Add Query Layer...

ile

3. Acgllan pencerede “Choose a table from the map or browse for

another table” kismindaki Browse E]aracma tiklayip Uygulama_12
dosyasi igerisindeki Parsel_Kose_Dbase.dbf dosyasini seginiz ve Add

butonuna tiklayiniz.
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Look in: |[ﬁ Uygulama_12 EV] 4 3

- EY Bl e GI
MName Type
[&11022.dgn CAD Feature Dataset
ParseI_Kose_Dbase. dbf dBASE Table
Parzel_Kose_Excel xls Excel File
MName: [ | Add
Show of type: | patasets and Layers |v! [ Cancel ]

4. Add XY Data penceresinde X Field ve Y Field'da asagidaki sitiin
isimlerini se¢ip OK butonuna tiklayiniz.

Add XY Data x|

& table containing X and ¥ coordinate data can be added to the
map as a layer

Choose a table from the map or browse for another table:

Parsel_Kose_Dbase __'_i

B Specify the fields for the X, ¥ and Z coordinates: _

2z |Y)

¥ Field: |><COOR |» I

¥ Field: |TCOOR [ae] 1

e — . -
Z Field: | <hlone > |

5. Yaptiginiz bu islem sonucunda Parsel_Kose Dbase.dbf dosyasinda yer
alan X ve Y koordinat degerleri temsilen ArcMap harita sayfasinda
Parsel_Kose_Dbase_Events formatinda gériintiilenecektir.
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Table OF Contents B X
G 3 & | _
= = Layers |
= ¢ iParsel_Kose Dbase Events |

®

6. Bu dosyalar Export Data yontemi ile Shapefile veya Feature Class
olarak kaydedilebilmektedir. Bunun icin Parsel_Kose_Dbase_Events
katmani lizerinde mouse’un sag tusuna tiklayarak Data>Export Data
fonksiyonunu seginiz ve Uygulama_12 dosyasinin icine,Parsel_Dbase
Shape File’1 olarak kaydediniz.

Capy

Remove

x|

| Open Attribute Table

Joins and Relates 3

J/ Zoom To Layer &

Visible Scale Range »

Use Symbol Levels

Selection 3

Label Features

Edit Features 3

‘ag| Convert Features to Graphics...

Convert Symbology to Representation...

Data P [l 4 Repair Data Source..

Save As Layer File... <& ExportData...

7. ArcMap’ten gikiniz.
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Uygulama 13: Zaman Bilgisi ile animasyon olusturma;

ArcGIS 10 vektor ve raster verilerde zaman bilgisini desteklemektedir. Bu
uygulamada, vektor veriler (zerinde Osmanl Devleti’'nin Ylkselme,
Duraklama ve Gerileme Devirlerindeki toprak biyuklikleri animasyon haline
getirilecektir.

1. ArcGIS10_EGITIM/Uygulama_13klasériinde yer alan
Uygulama_13.mxd’yi ArcMap’te aginiz.

®  ArcMap 10

Table of Contents’de Osmanli, Ulkeler vektorel katmanlarinin ve ESRI Terrain
Basemap’inin oldugunu goreceksiniz.

2. Osmanli katmaninda sag tiklayiniz ve Open Attribute Table
secenegine tiklayiniz.

= = Layers

""""" @ Copy

= Uke 4 Remove

— @] BaclE] _Open Attribute Table |

1 O Joins and Relates b

Oznitelik tablosunda, yil field’i fetih yillarini géstermektedir. tarih field’: ise
animasyonda kullaniimak tzere agilmistir.

3. Oznitelik tablosunu kapatiniz.

4. Osmanli  katmaninin  kutusunun  ¢ekini  atarak  katmanin
gorintilenmesini saglayiniz.
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5.

6.

7.

9.

Osmanli katmaninda tekrar sag tiklayarak Properties
tiklayiniz.

3! @ Copy
= Ulkeler | %J Remove
E Open Attribute Table

= Basems| )
# [ Ref Joins and Relates »
* Terl G4 Zoom To Layer

Visible Scale Range 3

Use Symbol Levels

Selection 3

Label Features

Edit Features 3

4| Convert Features to Graphics...

Convert Symbology to Representation...

Data 3

<4 Save As Layer File...
94| Create Layer Package...

|m‘ Properties... |

Layer Properties penceresinde Time sekmesine tiklayiniz.

secenegine

Time sekmesinde Enable time on this layer kutusunun g¢ekini atiniz.

Layer Time kismindan Each feature has a single field secenegini

seginiz.

Time field kismindan “tarih” field'ini seginiz.

10. Time Step Interval kismini sekilde oldugu gibi 1 Day olarak ayarlayiniz

ve OK butonuna tiklayarak katman Ozellikleri penceresini kapatiniz.
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“Layer Properties @

| General || Source || Selection || Display || Symbology | Fields || Definition Query | Labels || Joins & Related ML Popup |

Enable time on this layer

Time properties

Layer Time: lEach feature has a single time field [il
Time Field: !tarlh |v_| Sample: 1/1/2008
Selected field is not indexed. Index the fields for better performance.
i : |
Field Format: | <Date/Time> |il
Time Step Interval: | 1] || pays iﬂ

Layer Time Extent: 1/1/2008 12:00:00 AM  To: 1/11/2008 12:00:00 AM Calculate

[Jpata changes frequently so calculate time extent automatically.

Advanced settings

Time Zone: |n0ne
Time Offset; :-D.DD [ ‘Years |VI

[ pisplay data cumulatively

oK | [ cameel ] [ Apply

11. Tools Toolbar'daki Open Time Slider Window aracina tiklayiniz.
12. Time Slider penceresindeki Enable Time on Map butonuna tiklayiniz.

13. Time Slider Window penceresinden Play butonuna tiklayiniz ve
animasyonu baslatiniz.

[ T —— p— =

 Tima Slider v |j|

Sl ElE=1l 1/11/2008 12:00:00 AM | =
i4 | 3 P[> |
44 1;"1;’2008 12:00:00 AM 1;"11;’2008 12:00:00 AM %
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@ thprdama 12 eed - krebap - Arelafn
Fie Bt Ven Soceels  Inet Seelien  Gewrodesieg  Cuatoese  Wedoes bl

0
E

el ]

—

14. Daha sonra bu animasyonu .avi formatinda video olarak kaydetmek
icin Export to Video aracina tiklayiniz.

BEE 171172008 12:00:00 AM | =+
-
| 2 i)
<< 112003 12:00:00 AM 1/11/2008 12:00:00 AM ks

15. Export Animation penceresinden videoyu kaydedeceginiz yeri seginiz
ve isim veriniz.

16. Export butonuna tiklayiniz.

191



Export animation

My Recent
Documents

F -

Lg

Desktop

My Documents

Iy Computer

.

My Netwark

Save in: |@ Desktop

j2<
¥ 08>
|Dr~'1y Documents
'j My Computer
WMy Network Places
[Shenvi_form
(=P
(Dkatt
[S)kitaplar
Slogo
(C)5artname
(staier
(=) WindowsXP_nc
File name: Iosmanll [Vj [ Export ]
Save as type: AV ("avi) |vl [ Cancel ]

17. Acilan Video Compression penceresinde OK butonuna tiklayiniz.

Bu asamada videonuz bilgisayariniza kaydedilecektir.
videonun %100°U olusturulana kadar bekleyiniz.

izleyebilirsiniz.

Video Compression

Compression Qualty: 30

(<] ] (2]

Key Frame Every |20 frames

Compressor: QK
| Microsoft Video 1 v

Ekranin altinda
Daha sonra videoyu
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Uygulama 14: ArcMap’te Map Package olusturulmasi;

Bu uygulamada, arcgis.com’a lye olarak haritalarin web Uzerinden paylasimi

gosterilecektir. Bunun igin tiim kullanicilar arcgis.com adresinde kendileri igin

birer hesap olusturacak daha sonra islem grubuna iye olacaklardir. Bu

asamadan sonra hazirladiklari tiim harita ve katmanlari internet (zerinden

kolaylikla paylasabileceklerdir.

1. ArcGIS10_EGITIM

3.

ArcMap'’te aginiz.

klasoriinde yer alan

% ArcMap 10

2. Haritanin sembolojisini dilediginiz gibi ayarlayiniz.

Uygulama_14.mxd’yi

File menisinin altindan Create Map Package secenegine tiklayiniz.

Edit View Bookmarks Insert Seled

MNew, .. Ctrl+M
Open... Ctrl+0

Save Ctrl+5
Save As..,

Save A Copy...

Add Data 3

Sign In...
ArcEIS Online. ..

Page and Print Setup...
Print Preview...

Print...

B & B[ B RS

Create Map Package...

Export Map...

4. Acilan pencerede Save package to file secenegini sectikten sonra

Browse aracina tiklayiniz.
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a/ Create Map Package

(O Upload package to my ArcGIS Online account

Uygulama_13

(3) Save package to file

Ci'\Documents and Settings'gtoreyen, ISLEM\Desktop\londra.r

[linclude ArcSDE geodatabase data

e T r—

5. Harita paketini C:\ ArcGIS10_EGITIM\Uygulama_14 dosyasinin
icerisine isim vererek kaydediniz.

6. Validate butonuna tiklayiniz.

7. Daha sonra Share butonuna tiklayiniz.

8. Acilan pencerede Yes butonuna basiniz.

Save Map Document

?/ This map document has changed and needs to be saved before creating the map package. Would you like to save the document and create the map
g

package now?

9. Harita paketinizin basarili bir sekilde olusturuldugunu gosteren
mesaj kutusunda OK butonuna tiklayiniz.

o

Succeeded

successfully created map package.

C:\Documents and Settings'\gtoreyen. ISLEM\DesktopYondra. mpk
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ArcGlS.com’a Uyelik;

10. Kullandiginiz Web Browser’da adres ¢ubuguna www.arcgis.com
yaziniz.

| A

€ | ¢|/%rm
I cotrme ks [ Froeriotmsl [ wedome psieiines [ vindoma e B iedows [ o ljem ket g QD ESRLThe 028 S0t [=f ]
] B sovione | ingiece - | Gevrimests ityor musunu? | Gevt | [ Haye Seceneder = ¥
Resource Cenker  Show: Webi Content nly» .\:kwl Sign In I =

° ArcGIS GALLERY MAP GROUPS MY CONTENT Find maps, applications and

A CG I S Online

and Apps for

View Groups Start ArcGIS Explorer Online -,
o wpim s | s miia sy | (Y OSIT

urlees e mans

11. www.arcgis.com sayfasi acildiktan sonra sag Ust kdsedeki Sign In

butonuna tiklayiniz.

12. Agilan sayfada sag taraftaki Don’t have an ESRI Global Account?
Basligl altindaki Create an account segenegine tiklayiniz.

Not A Member?

To become a member of ArcGIS Online, simply register your ESRI
Global Account.

Register my ESRI Global Account

=
[=1]

on't
res

ve an ESR

account

=
oo

(Iilnhal Account?
1

,_r
I |
1F
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13. Agilan sayfada Uye olmaniz icin gerekli olan bilgileri doldurmaniz
gerekmektedir. Bilgileri eksiksiz olarak doldurduktan sonra Create
My ESRI Global Account butonuna basiniz.

" @ ArcGIS

Create A New ESRI Global Account

Complete the form below to create an ESRI Global Account.
The bold fields are required.

User name islemegitim

User names zre 1 to 24 characters in length,
Password | Paszwords are 4 to 14 characters in length. Uss
Istters and numbers only for both fislds,
Confirm Password s

Address Beysukent
City / Town Ankara

Country / Region | Turkey hd

State or Province | Ankara ~| | Changing the country will refrash the page.

ZIP / Postal code 06800
The following question an anzwer will help valicats your idantity in the avant you forget
wour password,

Identity Question | What city were you bom in? ]

Answer |ankara
nkara

h |
rCreate My ESRI Global Account | Cancel

14. Asagidaki sayfa acildiktan sonra kayit yaparken veriginiz mail
hesabinizi aginiz. ESRI’'nin géndermis oldugu maildeki linke tiklayarak
hesabinizi aktif hale getiriniz.

" @ ArcGIS

E-Mail Address Confirmation

We require that you confirm your e-mail address before we can activate your account.

In a moment, you will receive an e-mail confirmation request sent to
‘gtoreyven@islem.com.tr’.

Please follow the instructions in the e-mail request to complete your registration.

If you entered your e-mail address incorrectly, you may update vour e-mail address.

15. Linke tikladiktan sonra agilan sayfada sifreyi giriniz ve Finish
butonuna basarak kayit islemini sonlandiriniz.
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(@ arcais

Completing Confirmation

If vou wish to login to your new account now, please enter your password again.
Leave the password held blank if you 3o not wish to log in at this bme.

Chek Finish to complete your registraton. Thank Youl

Password

Finish

16. Daha sonra agilan ekranda olusturmus oldugunuz hesap bilgilerini
giriniz ve Register butonuna tiklayiniz.

............... SHUWL EYEU LUlLEIL Uiy s Ep e g

{ e ArcGIS GALLERY MAP GROUPS MY CONTENT Find maps, applications and nmre.uQ‘

Register your ESRI Global Account

Enter your ESRI Global Account information.

Username: islem
Password: [*****
Forgot your password?

&=
=

Don't have an ESRI Global Account?
Create an account

17. ArcGIS.com kullanim kosullarini kabul etmek icin acilan pencerede |
Accept butonuna basiniz.
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ESRI ArcGIS Online b4

ArcGIS Online Terms Of Use

~
USE OF SERVICES IN ANY MANNER, INCLUDING MERELY {é
BROWSING OR ACCESSING THIS ESRI WEB SITE,
ICONSTITUTES YOUR ACCEPTANCE AND AGREEMENT TO
[THESE TERMS OF USE. PLEASE READ THESE TERMS OF USE
[THOROUGHLY AND MAKE SURE YOU UNDERSTAND THEM
BEFORE ACCEPTING THEM.

IF YOU DO NOT ACCEPT THESE TERMS OF USE OR DO NOT
WISH TO BE BOUND BY THEM, CEASE ACCESS AND USE OF
[THIS WEE SITE AND SERVICES IMMEDIATELY. ESRI WILL
IOMLY PERMIT YOU TO ACCESS AND USE OF THE ESRI WEB
ISITES UPON ACCEPTANCE OF THESE TERMS OF USE.

1. ACCEPTANCE OF TERMS OF USE

1.1 Acceptance. By accessing this ESRI Web site, you agree

ko be bound by this ESRI Web Site and Service Terms of Use
("Terms of Use") between you and Environmental Systems
Research Institute, Inc. ("ESRI"), located at 380 New York [i]

[ I Accept l [ 1 Do Mot Accept l

Dilerseniz  kullanici  hesabinizdaki  bilgileri doldurabilir ve resminizi
ekleyebilirsiniz.

ArcGlS.com’da islem Grubu’na Uyelik;

Bu egitim sonucunda, tiim katihmcilarin ArcGlS.com’da bulunan islem
Grubu’na Uye olmalari ve ilerde dilerlerse haritalarini grup Uzerinden
paylagsmalari amaglanmaktadir. Bu nedenle, bu uygulamada katilimcilarin

gruba nasil Gye olacaklari anlatilacaktir.

18. Yukaridaki ara¢ cubugundan Groups segenegine tiklayiniz.

[ e ArcGIS GALLERY MAP m MY CONTENT Search for groups... 0.‘

19. Search For kismina islem yazip Enter’a basiniz.
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( e ArcGIS GALLERY

Search All Content

Search for Maps
My Groups Search far Apps

Search for Tools
fﬁ Create a Group

Search for Groups

20. Acilan listeden islem Grubunu seginiz.

21. Daha sonra gruba katilmak icin Join This Group butonuna tiklayiniz.

| +j Join This Group |

22. Ekranda agilan pencerede Submit Request secenegine tiklayiniz.

Your request for membership will be sent to the group
administrator for review.

You can check the status of your membership by viewing
yvour notifications.

Submit Requestl [ Cancel l

Bu asamadan sonra islem Grup Yéneticisi Giyeliklerinizi kabul edecektir.

Olusturulan Harita Paketinin web’e eklenmesi;

23. Yukaridaki arag gubugundan My Content secenegine tiklayiniz.

{ ° ArcGIS GALLERY

GROUPS MY CONTENT ‘ Find maps, applications and more...Qﬂ

24. Aclilan sayfada haritanizi web’e eklemek i¢in Add Item butonuna
tiklayiniz.

2 Add Item [ || Create Map l ‘;_, Share | ‘ XK Delete | ‘j Move Ta ™
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25. Daha sonra acilan pencerede Dosya Se¢ butonuna tiklayarak
uygulamanin basinda kaydettiginiz harita paketini seginiz.

Add an item from your computer or reference an item on the Web.
The item is:  |A File on my Computer B
File: londra.mpk

Supported items

Title: londra

Tags: kolera, londra_
Choose from your tags

| Add Item Cancel |

26. Tags kismina, haritanizi bir baskasi aratirken isine yarayacak olan
anahtar kelimeleri yaziniz ve Add Item butonuna basiniz.

27. Sayfaniza eklemis oldugunuz haritanizi islem Grubu Uyeleriyle
paylasmak icin Share butonuna tiklayiniz.

28. Share penceresinde islem kutusunun c¢ekini atiniz ve OK butonuna
tiklayiniz.

ledit]
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Share your item(s) with:
["] Everyone (public)
Members of these groups:

islem

These settings will replace yvour current settings.

Boylece kendi olusturdugunuz haritanizi web tzerinden diger grup Uyeleriyle
paylasmis oldunuz. Artik diger grup (Uyelerinin ekledikleri haritalari
inceleyebilirsiniz.
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Uygulama 15 : Goriintiui Analizi

ArcGIS 10 ‘da yeni bir pencere olan Image Analysis penceresi kullanicilara ;

gorintl ve raster verilerin analiz edilmesi ve islenmesi konusunda o6zel

araglar sunmaktadir. Image Analysis penceresi temel olarak dort bolimden

olusmaktadir.

— - - -
- - —
Image Analysis- —
4 -7
& Clip_can_trr Limg A
D@'Clip_can_t'nr.img -
[ < can_tmr.img
<] B
(=]
Display =
N J v
I o
L 3 g
¥ ] 1.00
[Jora _———
[ Background
Stretch: Std-dev [l
Rezample: Mearest V
& B |50 :
Processing =
@ a-
L |
Sharpen v ¥

— Katman Listesi

Segenekler
Ozel ayarlarin yapildigi bélimdir.

: Goruntl islemleme ile ilgili

Aktif olan ¢alisma
alanindaki mozaik veri setleri, imaj servisler
ve WCS katmanlari dahil tiim raster veriler
burada listelenir.

Goriuntii Ayarlar : Verilerin goriinimi ile
ilgili degisikliklerin yapildigi bélimdur. Bu
bolimde raster verilere, kontrastlik,
parlaklik, transparanlik
tanimlanabilmekte, gamma yontemi
uygulanabilmekte ve dinamik aralik
ayarlamasi (DRA) yapilabilmektedir. iki
rater verinin karsilastirilmasini saglayan
iki 6zel ara¢ da icermektedir.

Raster Verilerin islenmesi : Bu boliimde
kullanicilar yaygin olarak kullanilan;. raster
kesme, maskeleme, ortorektifikasyon,
mozaikleme gibi raster isleme tekniklerini
birer buton ile kolaylikla
gerceklestirebilmektedirler.
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Bu uygulamada Kanada’ya ait bir Landsat uydu gorintiisi tGzerinde kesme
islemi gerceklestirilecektir.

1. ArcGIS10_EGITIM /Uygulama_15 klasoriinde yer alan
Uygulama_15.mxd’yi ArcMap’te aginiz.

®  ArcMap 10

Table of Contents’de can_tmr.img uydu gorintiisi ve alan shapefile katmani
gorintilenmektedir.

_14.mxd - - Arcinfo

Fle Edit Vew Bookmarks Insert Selecton Geoprocessing Customize Windows Help

NeaallaBxlacld:|

N T = |

a alan

| © @ s

: RGE

. MlRed: Layer_1
- [ Green: Layer_2
< Wse: Layer 3
-
e

5|

L3
@

£
=
o
"
]

o}
xv
o

2. Windows Meniisiinden Image Analysis Window secenegine
tiklayarak Image Analysis penceresini aginiz.
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File Edit View Bookmarks Insert Selection Geoprocessing Customize
AEI=Y" FETR N = A NS T2
o | M| e Al I e

Windows | Help

4 &1 il

Qverview Ejg | k7 -]
Magnifier

Viewer

Table Of Contents

Catalog

SR Gl AR - -y

[ Image Analysis |

— o m m mm we ome omm owd

3. Editor Menisiinden Start Editing secenegini secerek glincellemeyi

baslatiniz.

4. Edit Tool ile alan katmaninda ¢izilmis olan detay lzerinde gift

tiklayarak kése noktalarinin agilmasini saglayiniz. E
5. Daha sonra sag alt taraftaki iki kose noktasini segerek kesilecek olan

alani biraz daraltiniz.

ArcGIS 10’dan itibaren kdse noktalari coklu olarak secilebilmektedir.
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6. Kesmek istediginiz alan secili iken Image Analysis penceresindeki
can_tmr.img katmanini seciniz. Bu islem sonucunda Processing
boliimiindeki bazi fonksiyonlarin aktif hale geldigini goreceksiniz.

7. Processing bolimiindeki Clip butonuna tiklayiniz. @

Image Analysis penceresinde ve Table of Contents mendsiinde
Clip_cam_tmr.img adinda gegcici bir katman olusacaktir. Table of
Contents’deki diger katmanlarin geklerini kaldirarak kesilen alani
goruntileyiniz.

|© Uygulama_14.mxd - Archap - Arcinfo =
Fie Edt Vew BSoctmarks Insert Selecton Geoprocessng Customze Windows Help
NS88LE 0810 0ld) [ l=he el alF IR
N P T N e |
~ image arsiyss rTxig
]
E D e s H
[0 @ ean_tv.img E
5 ©
: os g
jun
= Display B
3 » 1 o @
- 3 o] |E
E B I ]
x ' 2 w
Q [Cora
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8. Kesilen alani kaydetmek icin Processing béliimiindeki Export &
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~Extent - Spatial Reference
() Data Frame {Current)
() Raster Dataset (Qriginal) Opata Frame (Current)
| Selected Graphics {Clipping) Clip Inside @ i = et (G el
-~ Output Raster
[lUse Renderer [(square: Cell Size (cx, cy): @ | 1 || 1 |
+|Force RGE Raster Size {columns, rows): ) | 540 || 400 |
| Use Colormap NoData as: |
Mame | Property |
Bands ]
Pixel Depth 8 Bit
Uncompressed Size 1.496 MB
Extent (left, top, right, bottom) ( -0.5000, -398,5000, 632,5000, 0,5000 )
Spatial Reference Unknown

Location:

Name:

Compression Type:

| c:\ARCEGIS 10_EGITIM

I can_tmr1.tif Format: TIFF

Compression Qua 2
NONE (1-100): Em,[
ESRIBIL
ESRIESQ

9. ArcMap’ika

GIF

GRID

P2
IPG
PNG

patiniz.
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Kaynaklar

o Kiipgii, S., 2004 ArcGIS 9 Uygulama Dokiimani. Ankara

e ESRI ArcGIS 10 Help

o ESRI ArcGIS Desktop Resource Center

e http://resources.arcgis.com/content/arcgisdesktop/10.0/
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